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Preface 
Most often, when we travel to unknown places, we try to know something 
about our destination before we begin. Then, once we are there, we try to learn 
enough of the language, customs, and landmarks to get around comfortably, 
enjoy our stay and make it productive. 

In many ways, when you move from one computer system to another, you 
embark on a journey to an unknown place. This book is mainly intended as a 
guidebook to moving from the PC to the Macintosh. Macintosh users moving 
in the opposite direction might find the information in this book useful, too; 
however, we present all information from the PC user's perspective. 

The Macintosh system is touted as being user-friendly. However, it may not be 
enough for you that it's easy to use. You're on foreign soil here, and you might 
want to find out how the customs in this new place compare with those on 
familiar ground. You're used to doing things a certain way and making certain 
assumptions about your computer system. On the Macintosh, however, these 
assumptions may not always remain valid. 

When you start to work with the Mac, you'll be given new tools to perform 
actions that have no parallel in DOS. You'll want to learn how to make the 
most effective use of these new tools. Even though the Macintosh deserves its 
reputation for being user-friendly, it doesn't mean everything you'll want to 
know is obvious. 
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Preface· 

Some people have described the Macintosh as a closed system and the PC as an 
open system. They also refer to DOS as left brain oriented and the Mac as right 
brain oriented. Others call OOS linear and text-based as opposed to the Mac's 
graphical and process-oriented system. In any case, these distinctions will 
become more clear as you read along. 

Each chapter covers a separate subject, and some chapters appeal only to 
specific readers, while other chapters are fairly universal. 

Chapter One provides a brief history of personal computers, specifics about the 
different Macintosh models available, and a general discussion about the 
different operating philosophies that characterize the PC and the Mac. This 
chapter sets the stage for subsequent discussions in the remainder of the book. 

Chapter Two begins a three-part introduction to the Macintosh graphical 
interface. It is the graphical interface that distinguishes the Mac from the PC­
from the user's point of view. Chapter Two includes a complete discussion of 
the various aspects of the graphical interface, including mouse techniques, 
menus and dialog boxes, and many other techniques. There are frequent hints 
for streamlining your approach to the Mac. 

While Chapter Two discusses specific operating system features of the PC and 
the . Mac, Chapter Three begins to define the components of the Macintosh 
Desktop. This chapter provides the basic tools necessary to interact with the 
Macintosh and presents a detailed look at the Finder (the closest equivalent to 
DOS on the Mac), and the Finder menus (the closest equivalent to the sum of 
DOS commands available on the Mac). 

Chapter Four completes the three-part series on the graphical interface by 
introducing the Macintosh operating system files and tools. Some of these files 
are unique to the Macintosh while others have parallels in the DOS world. In 
particular, you'll want to look at the discussions of two very important system 
tools-the Chooser and the Control Panel. 

H you're used to word processors, databases, and spreadsheets on a PC, what 
can you expect to see on a Mac? Chapter Five explains the kinds of things you 
could do on a Mac. We take another look at the graphical interface and how it 
affects the kinds of software developed on the Mac, and some of the differences 
between PC applications and their Macintosh counterparts. 

Chapter Six introduces the PC and the Macintosh from the hardware point of 
view. This chapter discusses the architecture of the' two machines, including 
their CPUs, bus and 1/0 systems, and peripherals. Those interested in learning 
about the various ports and peripheral options should review this chapter. 
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Chapter Seven is about networking and connectivity. We identify several 
programs that can be useful in bridging the gaps between these two operating 
environments. These programs range from DOS coprocessors on the Mac to 
various types of networks, direct links, telecommunications solutions, and 
other connections between two worlds. We also introduce the networking 
standards used in the Macintosh world and additional methods for connecting 
the Macintosh with other computer environments. 

Chapter Eight is about going beyond this book. It talks about the future of the 
Macintosh as well as what you can do to expand your horizons as you become 
more familiar with the Mac environment. 

Appendix A is a functional reference that walks through the Macintosh equiva­
lent of DOS commands. This appendix is an excellent way to come to grips 
with the operating differences between the Macintosh and the PC. We highly 
recommend that you review this information. DOS users will find using this 
appendix one of the fastest ways to become familiar with the Mac. 

For information on connections, or ports, refer to Appendix B. In this section, 
back panel configurations of the Macintosh show connecting devices for each 
port. 

Appendix C is a listing of companies, suppliers, and dealers for the various 
products discussed throughout this book, including sources for other Macin­
tosh items. 

As stated earlier, this book is aimed primarily at crossover users from the PC to 
the Mac. We assume that you're at least familiar with DOS machines. However, 
we don't necessarily limit our approach to only one group. If you are among 
the following, this book should offer a valuable source of information. 

• A PC user beginning to explore the Macintosh. 

• A PC user who needs to accomplish specific tasks on a Macintosh will 
benefit most from Chapters Two through Five, as well as Appendix A. 

• A PC user who wants to learn about networking with the Macintosh 
will want to pay special attention to Chapter Seven. 

• A Mac user who wants to know more about the PC can benefit from 
DOS discussions throughout the book, particularly in Chapters Two 
through Four. These chapters draw parallels between Mac techniq~es 
and their DOS equivalents. Also, Appendix A provides useful parallels 
between DOS and the Mac interface. 
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• A new Macintosh user who hasn't worked with a PC before. Chapters 
Two through Four are perhaps all you need to get a very good start in 
the Macintosh environment. 

In any case, we hope the information and presentation of this book helps you 
achieve more comfort and familiarity with both the PC and the Macintosh. 

We have done our best to introduce technical terms gradually and define terms 
as we go along. However, bearing in mind that many readers may skip around 
and not take the "linear'' approach to this book, we have provided a compre­
hensive glossary of terms for your convenience. If a word or phrase·seems un­
familiar, check the glossary. 
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Taking the Other Road 
Two roads diverged in a yellow wood, 

And sorry I could not travel both 
And be one traveler ... 

-Robert Frost "The Road Not Taken" 

Once the poet made a decision, chose a path and then wondered about the 
other. He never went back. Of course, for Robert Frost, the road he took was 
the one that was "less traveled by, and that has made all the difference." It was 
right for him. It may be that you will find some new opportunity or satisfaction 
in the road not taken. You, unlike Frost, have before you the opportunity to go 
back to the fork in the road, and choose the other road. As you travel down the 
other fork, the one you didn' t take before, you embark on a journey to a new 
world. You don't need a spaceship, or even an airplane, bus, or car to get there. 
A good, comfortable chair would be nice, though. 

The new road leads to a border where you may linger a moment. Behind you 
are all the familiar customs and cultural comforts you know so well. Ahead is 
the unknown-unknown language, unknown customs, unknown territory. 
Also ahead is the possibility of an adventure, offering more knowledge and 
new opportunity, so you stand ready to cross the line. 

It might sound as if you're at the border of two countries, but you're not. In­
stead, you're at the border of two operating systems-two very dissimilar 
computers. You are about to replace the familiar techniques of one with the 
very different methods of another. 

It may seem intimidating to some. You've heard it's easy, and yet it seems 
foreign and unwieldy somehow. Macintosh enthusiasts will tell you there's 
nothing to it. They speak a language full of Macintosh buzzwords like double­
click, shift-click, Clipboard, marquee, drag, file types, icons, resources, and on 
and on. If some of this sounds like another language, perhaps it is. It could be 
called Mac-inese, but you' ll soon discover that it is, in fact, quite easy to learn. 
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Chapter One 

In this book, we'll introduce the Macintosh computer from the mM personal 
computer perspective. As you move from the world of DOS, the disk operating 
system, to the Macintosh, in the simplest sense, you are moving from a world 
of keyboard commands to a world of pictures and mice. For some it is a foray 
into enemy territory, while others may view this journey as something like a 
visit to Disneyland. 

NOTE: Macintoshes, as well as mM (and compatible) computers are all, techni­
cally, "personal computers." However, this book will use the terms PC and 
personal computer to refer to DOS machines. 

Each chapter of this book should bring you closer to a full understanding of the 
Macintosh-its hardware, its operating systems, its techniques, and its 
software. 

There are several philosophical, physical, and procedural differences between 
the PC and the Macintosh. In this chapter, we'll identify some of those 
differences, and in subsequent chapters, we'll elaborate on those differences. 

Not everything is contrast between the PC and the Macintosh, however. You'll 
also learn to identify the similarities, even when they are disguised by different 
procedures or methods. 

Before you begin to explore the Macintosh, you might like to know a little 
about the events that led up to the development of this remarkable machine. In 
fact, history often provides clues to understanding a new environment or 
language. The following section presents a brief history of personal computers 
intended to provide some perspective on the position the Macintosh occupies 
in the development of personal computing. 

Following the historical discussion is a brief description of the physical 
differences between the two machines, and finally, a discussion of the 
philosophical and procedural distinctions between them. 

So, before beginning your journey down the road not taken, through the new 
land of Macintosh, you may want to take a look at what led up to the present. 

Journey now into the land of yesteryear, when the tube was king and chips were made 
only from potatoes or corn ... 
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Taking the Other Road 

A BRIEF HISTORY 
The personal computer industry is relatively young, and the past ten years 
have brought about diverse developments. Over the years, computer 
manufacturers have taken many directions--some successful, some not-and 
along the way, we have observed the incredible growth of the personal com­
puter. Not only has the personal computer become more and more 
commonplace in our homes and businesses, but the advances in technology 
have been staggering. Consider that a computer which fits neatly on your 
desktop today, only 10 or 15 years ago would have filled a room, but offered 
much less! 

Disagreements abound in the computing world about the dawning of the per­
sonal computing age, but most people agree that the introduction of the IBM 
PC propelled personal computers into businesses around the world, setting in 
motion the personal computer boom. However, personal computers existed 
years before the ffiM PC sounded its first beep. 

Early personal computers were machines aimed primarily at hobbyists. They 
operated from a simple command line (much like today's PC) and featured all­
text displays. The TRS-80 from Tandy Corporation and the Commodore PET 
were among the earliest personal computers. 

However, several drawbacks limited mass-market acceptance of these early 
systems. Data was stored on cassette tapes offering only 16 or 32 kilobytes of 
usable memory; only a limited number of programs was available; and modifi­
cations to the basic system could be both expensive and difficult. 

Perhaps the most important personal computer to appear (before the ffiM PC) 
was the Apple II computer system introduced in the late seventies. Several key 
factors led to the success of the Apple II over previous systems: 

• It was a graphic system in color-a major feature that placed the Apple II 
above its competition 

• The sluggish and cumbersome cassette tape system was replaced by 
5 1/4-inch disk drives 

• It was expandable through a series of plug-in cards inside the chassis 

• It was affordable 

• With the Apple II Plus, it boasted a relatively whopping 48K of RAM 

• It was seeded 
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This concept of seeding was one of Apple's great successes. Apple targeted the 
education market by offering it reasonably priced computers. This virtually 
assured that an Apple II would likely be the first exposure to computers that 
many students (and- their families) would receive, thereby establishing Apple's 
reputation as the machine for education and creating its own market. When the 
IBM PC was introduced in the early eighties, it quickly became the machine of 
choice in business, but failed to supplant Apple's leadership in education. 

Other manufacturers began building "personal computers" for the masses. 
Timex introduced the Sinclair, and other manufacturers followed suit. By 1981, 
a new industry was beginning to take shape. 

While Apple began to explore technologies that would eventually lead to the 
introduction of the Macintosh, mM was entering the PC marketplace with its 
first offering-the mM PC. mM was already the leader in computer mainframe 
technology and its credentials were unassailable. Where Apple was a company 
started in a garage and designed and marketed by young, radical visionaries, 
IBM was an established, conservative company that had the respect and the 
confidence of the business community. 

The IBM PC was similar to the Apple ll in many ways. They both featured an 
open, expandable architecture. Both came with color or monochrome systems 
and could handle graphics. Both came with a built-in Basic programming 
language, disk drives, and separate monitors. 

The mM PC also differed from the Apple in many important ways. For 
instance, it came with 64K RAM (random-access memory), as much as the most 
powerful Apple ll, and was expandable to 640K. Back when the PC was first 
introduced, there were few people who expected to use all640K. Today, 640K 
of RAM is needed to effectively run most PC programs. 

One of the main reasons for the IBM PC's existence was to provide a common, 
independent terminal for use with IBM's ubiquitous mainframes. To some 
degree, the software interface, DOS, owes its existence to this plan. While 
Apple was looking at new ways for users to interact with the personal 
computer, mM was looking for ways to keep experienced mainframe operators 
comfortable. Therefore, the DOS command line was the best approach. 

Meanwhile, Apple had discovered some revolutionary work at Xerox and had 
acquired the technology as well as many of the engineers who developed it. 
That work would lead to the Macintosh interface and would change personal 
computing history. 

Both the PC and the Macintosh systems were based on the component concept. 
The mM PC is an open system which means that devices could be added or re­
moved from inside the system chassis. The Apple system allowed the addition 
or removal of components from outside the chassis through built-in plugs and 
input/output (1/0) ports. Both IBM and Apple maintained their respective 
methods of adding components until 1987, when Apple introduced the 
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Taking the Other Road 

Macintosh II, which allows both internal and external methods of connecting 
devices. 

Many battles have been waged between die-hard IBM PC users and faithful 
Apple Macintosh users regarding the pros and cons of each system. PC users 
often contend that the Macintosh is a mere toy, lacking the expandability and 
processing power required by serious applications. Mac users call the PC 
limiting because it's accessible and truly usable by only the most hardy com­
puter users. Neither argument applies to today' s PCs or Macs; but some of 
these misconceptions remain. 

SYSTEM CONFIGURATIONS 
In this section, you will see how the hardware of the two systems compares. 

Evolution of PCs 
Since its introduction in 1981, the IBM PC (and its "clones") have gone through 
several evolutionary steps. However, from the user's point of view, most PCs 
operate pretty much the same way. The main differences between PCs are as 
follows: 

• CPU (central processing unit). The kind of chip used as the central processor 
is either the Intel 8088, 8086, 80286, or 80386. As you move through the list, 
the chips become faster and more powerful. 

• Speed. The newer chips are faster. The 80386 chip will run the machine at 
speeds up to 33 megahertz (MHz) where the original 8088 ran at 4.77 MHz. 

• Memory. Basic systems originally came with 64K, but today's machines 
generally begin with the full 640K that the CPU can directly address. This is 
called conventional memory and can handle larger amounts of expanded or 
extended RAM which is used to speed up operations or run multitasking 
solutions. 

Expanded RAM is memory above 640K that is not directly addressed. 
Extended RAM is directly addressable memory above 640K (used mostly on 
80386 machines). 

• Drives. Some systems use floppy disks only; others use hard disks of 
various sizes. Currently, there are two standard disk sizes for the 
PC-5 1/4-inch and 3 1/2-inch. (The Macintosh uses the 3 1/2-inch 
standard.) 
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• Input/Output (110). The PC uses both parallel and serial output ports. Some 
systems have these ports built in to the motherboard while others do not. In 
addition, more recent PCs (starting with the IBM AT and its clones) include 
onboard clocks and parameter settings. Older models, like the IBM PC and 
the IBM XT, lacked the clock and set most system parameters by using dip 
switches on the motherboard. 

• Open architecture. All PCs feature an open architecture, meaning that users 
have access to the inside of the computer and can add peripheral 
equipment. Slots on the motherboard can accept a variety of peripheral 
cards which may be display adaptors, memory enhancements, network 
controllers, and a variety of other special purpose devices. 

• Screen. Early PCs used lower-resolution monochrome or color screens, 
commonly divided into 25 rows and 80 columns. They offered no built-in 
graphic control. 

During its evolution, the PC has passed several milestones: The introduction of 
the IBM PC established new standards and markets for the personal computer. 
The IBM AT offered greater speed and power using the 80286 chip. The 
Compaq Deskpro 386 was the first major machine to use the 80386 chip. The 
IBM PS/2 line of computers with Micro Channel architecture marked a new 
design and direction for IBM's line of computers. 

Evolution of the Mac 
What most distinguished the Macintosh from the DOS computers were the 
following features: 

• Configuration. The Mac used the Motorola 68000 Family of chips, not the 
Intel series used by the PC. It carne with its display screen, full memory, 
disk drives(s), and I/0 ports built in. About all you could add to the system 
early on were a second floppy disk, a printer, and a modern. 

The Mac also carne with a very sophisticated set of programs in ROM (Read 
Only Memory). These programs formed the basis for the graphical interface 
that helped make the Mac famous. Because these routines were built into 
the computer, almost all Mac applications look and act alike. In contrast, the 
PC had no such set of built-in routines and PC applications tended to 
present themselves using very divergent methods. 

• Design. Where the PC was an open architecture, the Mac was closed. Just 
opening the cabinet voided the Apple warranty. 

• Screen. The Mac used a small, but very high-definition monochrome 
display. Every pixel on the screen was controlled by the proprietary 
QuickDraw routines in ROM. 

10 
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• Mouse. The mouse, a Xerox invention used by the Xerox Star and Alto 
Computers, was introduced to the world at large by the emergence of the 
Macintosh. Much of the identity of the Mac was tied to this form of screen 
manipulation and the mouse went ''hand-in-paw'' with the icon and menu­
driven graphical interface. 

• Keyboard. The Mac began life with a small, separate keyboard which 
lacked a numeric keypad. Since then, several Macintosh keyboards have 
appeared, the most recent of which is an almost exact duplicate of the 
popular AT keyboard on the PC. 

• Connections. The Macintosh comes with two built-in serial ports and no 
parallel ports. The mouse originally connected to the back panel, but recent 
Macs feature the Apple Desktop Bus (ADB), which allows peripheral 
devices to be strung together. Using the ADB, the mouse is now connected 
to the keyboard. 

In addition, the Mac features a built-in networking protocol, originally 
called AppleTalk. Though there wasn't a network available at first, this 
protocol and special cabling enabled the Mac to use "intelligent'' 
peripherals like the LaserWriter. Later, these same cables were used to 
connect multiple Macs. 

As the Macintosh developed, a new 1/0 port, the Small Computer System 
Interface (SCSI) port, was added for high-speed data transfers. This port 
was originally used to connect up to seven hard disks to a single system. 

The Macintosh has evolved from the first 128K machine introduced in 1984 to 
the present models-the Macintosh Plus, the Macintosh SE, the Macintosh 
SE/30, and the Macintosh II, Ilx, and Ilcx. 

Among the systems currently available, the Macintosh Plus is the most basic. It 
comes standard with 1 megabyte of RAM, a single built-in 3 1 /2-inch floppy 
disk drive (that reads and writes only Macintosh formats), keyboard, mouse, 
and basic 1/0. It is a closed system, and can be upgraded only with some 
difficulty. 

The Macintosh SE is the next step up from the Mac Plus. It runs a little faster 
and usually comes with a built-in hard drive as well as one floppy. Although it 
is primarily a closed system, it does feature a single expansion port which 
allows the connection of ETHERNET, color, or graphics peripheral equipment. 
It comes with 1 megabyte of RAM. 

The first truly open Macintosh is the Mac II. This computer resembles the 
standard PC both in its physical appearance and its open architechture. It has 
shed the built-in screen display in favor of a separate monitor. It can. contain 
either one or two floppy drives and a hard disk, though it is usually sold with 
one hard disk and one floppy drive. 
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The Mac II cabinet opens to reveal five NuBus slots, similar to the slots found 
in PCs. These NuBus slots, which were originally developed by Texas 
Instruments, are used to add video drivers, co-processors, network boards (like 
the EtherTalk board), and other peripheral equipment. In addition, memory 
can easily be added to the system in the form of Single In-line Memory 
Modules (SIMMS). The maximum capacity of the Mac II is eight megabytes of 
RAM, though its Motorola 68020 chip is capable of handling much larger 
amounts of memory. Additionally, the Mac II was the first Mac to feature high­
resolution color modes, which rival the highest resolutions available on today' s 
PCs. 

In the same way that the PC made the transistion from the mM AT to the 386-
based machines, the Macintosh IIx is an enhancement to the Mac II. It is built 
around the Motorola 68030 chip, a very powerful processor. Representing the 
next step in the Macintosh II series, it retains many of the features of the Mac II, 
including 256K ROM, graphics, high quality four-channel sound, SCSI bus, and 
NuBus. 

The 68030 microprocessor in the Mac IIx is coupled with an SO-bit-precision 
68882 math coprocessor, both running with a 16MHz clock. The 68030 has 
separate 256-byte caches for data and instructions plus a built-in Page Memory 
Management Unit (PMMU) used by advanced multitasking operating systems 
such as A/UX (the Macintosh implementation of UNIX). 

Two caches speed up system operations by providing rapid access to the most 
recently used data and instructions. The new Motorola 68882 coprocessor 
shares the same instructional set as the 68881 used in the Mac II, and is capable 
of performing at up to two times the speed of the 68881 due to parallel 
operation capability. Therefore, all software written to take advantage of the 
68881 can automatically take advantage of the 68882. Of great signficance to 
DOS users, the 3 1 /2-inch disk drives in the Mac IIx will read and write PC 
formats (as well as Apple Il's ProOOS) and store up to 1.4 megabytes on a 
single disk. 

In 1989, Apple introduced both the Macintosh SE/30 and the Macintosh Ilcx, 
two new systems based on the Motorola 68030 processor. The Macintosh Ilcx is 
very similar to the Macintosh Ilx in that it comes with the 68882 math co-pro­
cessor. The main difference between the Macintosh IIcx and the Macintosh Ilx 
is the smaller size of the chassis (footprint), and the inclusion of a new floppy 
disk drive, the Apple FDHD. This drive reads from and writes to MS-DOS, 
OS/2, and Apple II (ProOOS) formats. 

The Macintosh SE/30 is also based on the 68030 processor and operates at up to 
four times the speed of the Macintosh SE. The SE/30 also comes with the new 
floppy drive as well as a new add-in slot called the Apple 030 Direct Slot, 
which allows special video cards to be added to the system to support gray 
scale and color monitors. 
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At the time of this writing, rumor has it that Apple plans to introduce the first 
laptop Mac. PC laptop computers are commonplace, but, so far, Apple has not 
introduced a Macintosh version, although they are available from other 
companies. 

A more complete and technical discussion on PC and Mac hardware is 
contained in Chapter Six. One of the most significant differences between the 
two systems is, not hardware, but user interfaces, which represent two very 
different design philosophies. 

PRACTICAL PHILOSOPHIES 
When you think of a computer, you probably don't think about philosophy. 
You probably think most about the work you have to accomplish and how that 
machine can help you get it done. After all, computers do pretty much the same 
thing, don' t they? They're number crunchers and information storage devices, 
not logicians or theologians. 

It is true that computers can all perform the same, or similar tasks. However, all 
computers are the products of human design, and while they were evolving, 
different design philosophies were implemented. 

The PC and the Macintosh now represent two very different approaches which 
are based on different philosophies of human interaction. One is essentially a 
verbal, language-based system. The other is visual and tactile. One issues 
commands. The other performs actions. 

The PC philosophy is that users communicate best with their computers through 
language. Words and syntax, labels and commands are the bases of the lan­
guage-based computer interface. 

The Macintosh philosophy believes that users communicate best by direct 
manipulation of objects. Icons, windows, and menus along with a pointing device 
(the mouse) are the basic tools of the graphic interface. 

Each of the statements in the list below presents ideas and concepts, setting the 
stage for a deeper understanding of the two systems. In the chapters that 
follow, each of these contrasts will be explained in more detail. 

HOW YOU COMMUNICATE. 

• The PC uses the keyboard as the primary communication device. Your 
location on the PC screen is indicated by a cursor. You issue commands at 
the cursor position by typing at the keyboard. You choose courses of action 
or choose menu choices by using the keyboard. Even movement on screen 
is performed using cursor movement keys. 

• The Mac uses the mouse to perform an action; the keyboard for entering 
text. The Mac has two cursors--the mouse pointer and the insertion point. The 
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mouse pointer is used to position the cursor for selecting and manipulating 
objects on the screen. The insertion point is used to indicate where to enter 
text. Simple mouse techniques can often perform the same operation as 
several commands on the PC. 

WHAT You SEE. 

• On the PC, you see information a screen at a time. Whether you are 
viewing a directory listing or running a program, you generally see one 
action or 11position" within the system at a time. In a sense, you have a local 
point of view. 

• The Mac splits the saeen into windows. On the Mac, each action or place 
occupies its own window at the Finder. Each drive or folder (directory) 
occupies a window, and each document in a running program also 
occupies a window. Because several windows can appear on the same 
screen, you can see different aspects of your work concurrently. In a sense, 
you have an omniscient point of view. 

TEXT ys. GBAPHIC ORIENJATION. 

• The PC is text-oriented. Because the PC is primarily concerned with text, 
visual information is often lacking. For instance, most programs simulate 
formatting and visual layout with text-based codes embedded in a 
document or report. Font styles and other effects as well as positioning of 
elements for printout are rarely shown on screen the way they will print. It 
is very difficult to combine graphics and text on screen and only 
specialized programs can combine them in print. 

• The Macintosh is graphic-oriented. Because the Macintosh screen always 
displays high-resolution graphics, whatever you see on the screen is 
(almost always) what prints out. Layout and formatting details are 
accurately portrayed on the Mac screen and all Macintosh applications 
display different fonts and styles. In addition, it is common practice among 
Mac applications to combine graphics and text on screen, and in print. 

USER INtERFACE. 

• The PC has no consistent user interface &om program to program. 
Programs written for the PC each reinvent the user interface. There are very 
few consistent standards, and users must learn each new program from the 
beginning. 

• On the Mac, the interface tools are built-in. The Macintosh comes with its 
own interface standards. All Macintosh developers can use the built-in 
Toolbox routines to achieve a consistent interface. Therefore, each 
Macintosh application shares many features and techniques with every 
other one. Users learning a new program already know how to perform 
most basic operations. 
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DATA FORMAI. 

• The PC lacks any consistent means of sharing data between programs. 
Few PC programs can share information easily, though some can translate 
the files of other programs. However, there is no standard data format and 
no consistent way to transfer information directly from one program 
document to another. 

• The Mac has the Clipboard, Scrapbook, and standard data formats. The 
Clipboard lets Macintosh applications share both text and graphics. Any 
information cut from one document can be pasted into another via the 
Clipboard. There are a few limitations; for instance, you can't paste graphics 
into a document or an area of a document that can only accept text, but, for 
the most part, information can flow freely from one application to another. 
Virtually anything that can be displayed on the screen can be cut and pasted 
between applications. 

fiLE 'I'XPES. 

• The PC differentiates between executable files and other files. DOS uses a 
three-letter extension at the end of a file name to identify the kind of file it 
is. However, only three extensions really make any difference to the 
operating system: .exe, .com, and .bat. These three extensions designate 
executable files. All other extensions are optional and mean nothing to the 
operating system itself (though they may have meaning to individual 
programs). 

• The Mac tracks not only the file type, but the application that created the 
file. Macintosh files each contain special information that identifies what 
kind of file it is (application, document, dictionary, and so on). Also, each 
file contains information that relates it to the program that created it. This 
enables the Macintosh to display each file with a unique and identifiable 
icon (pictogram). It also allows users to run a program simply by selecting 
one of its documents (document launching). 

The PC is moving more and more toward a graphic interface standard. Many 
programs on the PC have now incorporated Mac-like features-Framewor~ 
and Reflex, to name only two. Even programs like dBASE IV™ use pull-down 
menus like those on the Mac, and Microsoft Windows creates an operating 
environment very similar to that of the Mac. 

The newest PC operating system, OS/2 Version 1.1, will operate from a 
graphical interface, too. In fact, future applications on the PC will probably 
look very much the way the Macintosh looks now. As the two roads begin to 
reconverge, this book can help guide you along the path to a new way of 
working with computers-a way you will probably encounter in the future. 
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GOING FORWARD 
By now, you're probably anxious to learn how best to translate your existing 
knowledge of PCs to the Macintosh. In the following three chapters, we present 
the operating environment of the Mac. 

In Chapter Two, you will learn about the basic components of the Macintosh 
environment-icons, the mouse, windows, and more. These Macintosh objects 
are found in every Macintosh application. 

Chapter Three continues this discussion by presenting the Finder, the 
Clipboard, and MultiFinder. The Finder is a collection of tools and menus that 
duplicates most of the functions of the DOS command line. You'll learn about 
each of the techniques and menus that the Mac uses to manipulate dis~ drives, 
files, and folders (directories). In addition, we'll introduce the Clipboard, the 
standard method for data exchange on a Mac. Finally, we'll discuss 
MultiFinder, the Macintosh multitasking operating environment. 

Chapter Four explores the remaining System tools and utilities. Some of these 
tools and utilities correlate directly with DOS commands and procedures. 
Others are unique to the Mac. In addition, this chapter details the methods 
used for selecting printers and peripherals. 
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Basic Operating 
System Concepts 
INTRODUCTION TO THE OPERA liNG ENVIRONMENT 

A one-to-one comparison between the Mac interface and the DOS interface is 
virtually impossible. DOS is the PC language-a language of commands. By 
typing commands at the DOS command line, you can manage files and 
directories, run programs, and communicate with peripherals. 

The Mac interface is not a language of commands. In fact, it is not a language at 
all. The Mac operating system does many of the same things as the PC 
operating system, but it does them in a different way. 

On the PC, all commands have names. Type the name; the command is carried 
out. Many commands have syntax, which is the proper way to phrase the 
command and its parameters. 

What the PC does with typed-in commands, the Mac does with procedures, 
menu choices, and other utilities. There is very little typing and no syntax. In 
place of syntax, there is method or technique. 

The Consistent Interface 
Many people credit the Mac's continuing success to its graphical interface, 
which is the subject of several of the chapters in this book. What makes the Mac 
interface especially useful is that it is always the same. Where PC programs 
may vary tremendously in how they look and act, almost all parts of the Mac 
environment- from the disk and file management and other DOS-like 
functions to complex third-party productivity programs-share a common set 
of techniques and features. 
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One result of this approach is that if you know how to work with one program 
written for the Mac, you know how to work with almost every other program 
written for the Mac. Many features and techniques may vary, but certain basic 
ideas do not change. 

A complete comparison of the PC and Mac operating environments requires 
you to look at several parts of the Mac system and how they relate to the PC 
commands you have been using. In a sense, the Mac environment presents a 
puzzle-a collection of interrelated pieces that, together, make up a system 
more or less equal to the sum of the DOS commands. 

About This Book 
Most of the information presented in this chapter applies to the basic Mac 
operating environment called the desktop. The desktop is where all the action 
takes place. In its way, it is the equivalent of the entire screen on a PC, but, 
unlike the PC, the desktop has many characteristics that remain consistent 
whether you are running a program or working with the Finder, the closest Mac 
equivalent to the DOS level on a PC. 

The Finder deserves some mention here, though you will learn more about it in 
Chapter Three. Briefly, the Finder is where you will perform basic file and 
folder (directory) management tasks including launching applications, viewing 
file listings, copying and erasing, changing folders and drives, viewing system 
statistics, and much more. This chapter contains some information abouf the 
Finder. In particular, all information about the mouse, icons, windows, and 
dialog boxes apply to the Finder as well as to other programs that you will run. 

In this chapter, you will also learn how to start working with the Mac. We will 
discuss the following: 

• The boot up sequence 

• Mouse techniques 

• Icons 

• Windows 

• Dialog boxes 

• Menus 

The information in this chapter is essential to using the Mac. If you can, read 
this chapter with the Mac running and look at the objects described. Try the 
procedures. The best way to familiarize yourself with the Mac is to experiment 
with your hands-as well as your mind. 
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In addition to the basic Mac information this chapter contains, you will learn 
something about the Mac equivalent (where one exists) of the following DOS 
commands and navigation keys: 

• DIR 

• CHDSK (partial equivalent) 

• PATH 

• ChDIR(CH) 

• PgUp and PgDn 

• Other cursor keys 

For an alphabetical guide to DOS commands and their Mac equivalents, see 
Appendix A. 

Some of the pieces of the Mac puzzle are always used. This chapter introduces 
you to these basic concepts-universal Mac tools, components, and techniques. 

Another piece of the puzzle is provided by the Finder, through which you can 
duplicate the functions of most of the DOS commands-in addition to 
performing some uniquely Mac-like tasks. The Finder and its multitasking 
cousin, MultiFinder, are the subjects of Chapter Three-"Commands and the 
Finder." 

Finally, there are some special utilities and tools that complete the Mac puzzle. 
Chapter Four, "Other System Utilities," deals with these special system tools 
and how they correlate with DOS commands and procedures. 

Together, Chapters Two, Three, and Four provide a complete picture of the 
Mac operating system and environment. 

Throughout this book, we will use the terms program and application 
interchangeably. However, we recognize that many people, especially PC 
developers, think of these as different terms. In ordinary PC language, a 
program is an executable file while an application is a specific, task-oriented 
system created by another program (for instance a dBASE accounting 
application where dBASE IV is the program). However, most Mac people use 
the term application to apply to the program itself. Therefore, when you see 
references to Mac applications, these refer to program files. 

In addition, PC users generally refer to running a program where Mac 
terminology would say launching an application. Keep in mind that these two 
phrases are identical in operation, though the techniques used to perform them 
may vary. They both mean that a new program or application is activated. 
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DIFFERENT PERSPECTIVES-AN INTRODUCTION 
As a PC user, you are probably familiar with DOS, the PC's Disk Operating 
System. DOS is a command-oriented language designed to communicate with 
the PC-to work with files; to run programs; and to communicate with 
peripheral equipment like monitors, modems, printers, and so forth. Any time 
you tell the PC to do something, you do so by typing a word at the command 
line, and you locate your current position within the system by reading a 
prompt- for instance the A: prompt that designates the first floppy disk drive, 
drive A. 

On the PC you may think of moving from one directory or disk to another or 
logging onto a different drive or directory. On the Mac, the operating system is 
very different. On the Mac you think of bringing a different window to the front or 
making a new window active. The difference is one of concurrency. On the PC, 
you move to a new location. On the Mac, you activate a different object, but 
other objects are also present, waiting to be activated. There is no sense that 
you have gone anywhere. 

You have a more omniscient viewpoint on the Mac because you can see various 
folders (directories) at once, though only one is active. On the Mac, you operate 
in two-dimensional space. On the PC, you only view one directory at a time; 
you exist in only one dimension at a time. 
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Figure 2·1. Mac folders and DOS directories 
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You will rarely type an instruction on the Mac. In place of typing you will use a 
variety of actions and procedures, and you will work with a variety of new types 
of objects. 

Objects on a Mac are usually graphic representations of the information the 
computer has in storage or in memory. For instance, a file, which is represented 
on a PC by a name in a file listing, is represented on a Mac by an icon, which is a 
picture that represents that file. 

Other Mac objects include folders (which are the equivalent of directories on a 
PC), menus, windows, and dialog boxes-all of which are essential features of the 
Mac operating system. 

More and more PC programs are adapting diferent components of the Mac 
operating system. Microsoft Windows is one example. If you've used 
Windows, you are already familiar with many Mac concepts, but you will 
probably have to relearn certain techniques and procedures. To a lesser extent, 
many other programs now feature Mac-like options, for example, pull-down 
menus, dialog boxes, windows, and more. However, even though many 
programs have begun to use these features, they are by no means standard to 
software running on the PC. 

ROMs 
ROM (Read Only Memory) is a set of programmed instructions and data built 
into a computer and stored on a memory chip. Information stored in ROM is 
permanent and does not change when you change software. 

On the PC, there is a little bit of ROM which is used to control basic Input/Out­
put (l/0) functions and system-level operations. The PC ROM routines do very 
little to dictate how the PC screen should look, nor do they contain any specific 
techniques for performing everyday operations. Nothing in the PC ROM 
suggests a style for menus, a form for screen images, or helps in any way with 
interface design. These ROMs, also known as BIOS (Basic Input/Output Sys­
tem), determine how the system communicates between different devices at a 
very basic level. 

On the Mac, ROM provides the tools for the elements of mouse technique, 
icons, menus, windows, and the rest of the Mac "cast of characters." 

Uniformity among Mac programs is no accident. The Mac was designed that 
way. The routines in the Mac ROMs are available to all developers, which is 
why the Mac interface is consistent from one program to the next. In fact, 
Apple has published several books of guidelines, and they strongly encourage 
potential Mac developers to follow established rules. 

22 



Basic Operating System Concepts 

STARTING THE SYSTEM 
Some of you are probably anticipating an end to all ordinary events-an end to 
computing as you know it. From all you've heard, the Mac is either a toy or a 
breadbox disguising itself as a computer. But you shouldn't be be surprised to 
learn that you can turn on a Mac the same way you turn on a PC. The only 
difference is that the switch is in back on the Mac and on the side (or in the 
front) on most PCs. 

There is one exception. The Mac II family with any Apple keyboard, lets you 
turn on the computer from the keyboard. If you have such a system, the button 
in the upper-right corner applies power to your Mac II. 

Figure 2·2. Extended keyboard power-on button 

Anyway, once you turn on the machines, they do what all good computers 
do-they boot up. Booting a Mac is very similar to booting a PC. Once the 
power is applied, the Mac does an internal system check, then searches for a 
valid System file on an active disk. This is pretty much the same thing your PC 
does as you can see from the chart in Figure 2-3. 

Bing! Oh, you might think the doorbell just rang or you might look around to 
see what floor the elevator is on, but that ring is just the Mac beeper, more 
melodic than that tinny noisemaker in the PC. You'll get used to it. 

The discussion that follows compares the boot procedures of the two machines. Howev­
er, you can probably start using the Mac without knowing all this, just as you can use 
a PC without understanding all about memory, the Config.sys, or the Autoexec.bat. 
You may want to jump ahead to the section called A First Look at the Mac 
Environment, and return to this section later. 

Comparing Memories 
After the PC is switched on, it starts to display the system memory on the 
screen while a small, square cursor blinks. How much memory gets counted 
depends on the kind of PC you have and how much memory is installed. 
However, from the PC's point of view, there are several kinds of memory. 

Anything up to 640K RAM is considered conventional memory. This is the 
memory that the PC uses to run your programs. In addition, depending on the 
type of PC you use, you may have either expanded or extended memory. Without 
going into a long and possibly confusing discussion of PC memory issues, 
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suffice it to say that, from DOS, conventional memory is directly usable. The 
other kinds of memory require special software and hardware, and the PC is 
virtually "tricked" into using it. Only the 80386 chip (and future chips) can use 
memory above 640K directly. 

In contrast, all the memory in a Mac is recognized as a block. There is no 
distinction, though most Macs can contain only 8 megabytes of memory on the 
system. (Note that the Macllx and Mac Ilcx can contain up to 32 megs of 
memory.) 

One significance of this memory difference is that the Mac can (and does) use 
programs that require 1 megabyte or more to run. PC programs are still 
essentially limited to running with less than 640K of available RAM. Having 
more than one large program in memory at once, as the Mac MultiFinder does, 
is much easier to accomplish. On the PC, memory manipulation is a more 
complex issue. 

Even though the Mac does not display the results of the memory check the way 
the PC does, it does examine the internal memory while the machine is booting. 
It just does it faster. 

D D D 
I - I I -- I I -- I 
Memory Test Disk Drive Test Read Config.sys 

System Test Disk Drive Test Load INITFiles 

Figure 2·3. Comparing boot up 

Looking for the Boot Disk 

D 
I -- I 
Read File Table 

Build Desktop 

D 
I -- I 

Execute Autoexec.ba.t 

Execute Set Startup 
Procedures 

The PC can only boot from a floppy drive or from drive C, but the Mac can use 
any drive that contains the appropriate System files. This gives the Mac greater 
flexibility to boot from an externally attached drive. 

The Mac normally looks at the drives in order, beginning with the floppy 
drives, then looking for an internal hard disk. If there is no internal hard disk, 
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the Mac searches the external SCSI ports for a hard disk. It boots from the first 
of these drives it encounters with the appropriate System files and it can boot 
from any attached hard disk. In addition, you can set which drive it should 
look at first using the Startup Device selection in the Control Panel (see Chapter 
Four for more about the Control Panel). 

If the Mac cannot find a valid drive, it displays an icon with a question mark in 
the middle. If the Mac finds a bad floppy disk or one without a system, it ejects 
the disk and displays a disk icon with a large letter X. 

In contrast, when the PC can't find a valid system, it may do any number of 
things, usually hanging endlessly with floppy drive A spinning. 

Figure 2·4. No system disk on boot 

Figure 2·5. Rejected disk on boot 

A System by any Other Name 
The PC looks for a valid Command.com file on the A or C drive. In addition to 
the Command.com, it looks for two hidden files (whose names may vary from 
one version of DOS to another). These three files together make up the DOS 
System. 

The Mac looks for two essential files-System and Finder. There are many other 
files associated with the Mac operating system, but these two are the only 
essential ones. The presence of these two files is what makes a disk a System 
disk or a non-System disk. 

Like DOS, the Mac System has gone through numerous revisions. At the time 
of this writing, DOS 4.0 is the most recent issue of the PC operating system, and 
System 6.03 is the most recent Mac system. These software revisions are used to 
update the technology and to add features. 
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For the most part, Mac systems are upward-compatible, meaning that, as a gener­
al rule, programs that ran effectively with older versions will still work with 
the newer ones. When upward compatibility fails, developers mass produce 
updated versions of their software shortly after the release of a new system 
from Apple. 

At any rate, system software is necessary to boot both machines, and once they 
have located the necessary system files, both the PC and the Mac then proceed 
with the boot-up process. Look first at what the PC does as it sets up the 
operating environment. 

The PC Boot 
The PC reads important information from a file called Config.sys. Config.sys is 
not necessary to boot the computer, but provides a way to configure the 
operating system 1/0, various system level settings, like FILES= and 
BUFFERS=, and to load various system device drivers. The PC uses device 
drivers to set up a mouse, networks, RAM disks, and expanded memory or any 
device that is system-specific rather than application-specific. 

After reading the Config.sys, the PC reads a file called Autoexec.bat. This 
special batch file is not required, but if it is present, the PC will execute its 
commands in order. The Autoexec.bat is useful for establishing additional 
operating system conditions, for loading memory-resident programs, and for 
running a startup program. For instance, many people run special menu 
programs from their Autoexec.bat which lets them choose their applications 
from menus. 

The Autoexec.bat is the last step in the PC's boot-up procedure. Unless the 
Autoexec.bat runs another program, the PC stops at the DOS prompt and the 
command line, ready to receive input from the keyboard. 
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Enter neu date (""-dd-yy) : 

Figure 2·6. Typical PC screen after boot 

The Mac Boot 
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Like the PC, the Mac performs its internal system and memory checks, then 
proceeds to the next step. The Mac does not have a Config.sys file. What is does 
have are special files called !NIT files which may install additional device 
drivers or other special attachments to the system (more about !NITs in the 
next section). 

After the Mac reads INITs, it reads information about the disk's contents from 
an invisible file called Desktop, then builds the desktop image and displays it 
on the screen. In the process of building the desktop, the Mac reads special 
information about startup programs and loads the programs defined through a 
special dialog box called Set Startup. In some ways, this correlates with 
functions normally handled by the Autoexec.bat on the PC. You'll learn more 
about Set Startup later. 

Config.sys vs. INITs 
Although !NITs often serve the same functions as device drivers, some are 
more complex than any DOS device driver and are more like TSRs. These more 
complex !NITs actually function as independent programs running in the 
System memory. 
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Examples of INIT files include special network drivers, drivers for non-Apple 
disk drives and other peripherals, useful utility programs that install 
themselves at startup, and special sounds or pictures to use with the standard 
interface. 

MACHINT: The Mac frequently allows you freedom of expression. It's 
something a PC user will just have to get used to-or ignore. During boot up, 
the Mac will display something called a Startup Screen. This can be any 
MacPaint style picture that has been converted to the Startup Screen using one 
of several methods. (Some third party utilities allow you to use graphic 
standards other than MacPaint.) The Startup Screen will replace the standard 
Apple logo that usually appears. 

In addition to a startup graphic, you can add special startup sounds. There are 
many digitized sound files available through bulletin board services and other 
public domain outlets. (A favorite personal startup sound is a digitized file of 
HAL, the computer from 2001, saying, ''I'm completely operational and all my 
circuits are functioning perfectly." Another bleats "What did you do that for!") 

Figure 2· 7. Standard startup screen 
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Figure 2·8. Customized startup screen 

As the PC reads the information from the Config.sys, it often displays 
information about any device drivers it loads. For instance, a typical mouse 
driver, when loaded, displays its name and version number as well as the basic 
copyright information. 

Similarly, the Mac displays a small, distinctive icon as it loads each INIT file, 
and sometimes a special message appears. Not all INITs display icons or 
messages on bootup, nor do all device drivers display information when 
loaded on the PC. 

On the PC, you might use the Config.sys to set up a program to a buffer of 
memory, known as a cache, to improve the speed and handling of information. 
Caching can speed up operations, particularly repetitive ones. In DOS, the 
cache is set up while the machine boots. You cannot usually control the size or 
existence of a cache program from the operating system. On the Mac, a special 
RAM feature exists but you control it from the operating system after booting. 

Another Config.sys function has no exact equivalent on the Mac. The settings 
for FILES = and BUFFERS = are not used on the Mac. On the PC, these settings 
initialize special areas of memory which manage the number of files that can be 
used concurrently. On the Mac, the number of open files is determined by the 
system itself. 
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Desktop vs. FAT 
After displaying the startup screen and loading all the IN1Ts, the Mac reads a 
special hidden (invisible) file called the Desktop. The Desktop tells the Mac 
which files and folders are present on the disk as well as where to place every­
thing contained in the graphical display. At this point, it "builds the desktop" 
and displays the Finder on the screen. 

This Desktop file has some similarity to the File Allocation Table found on a 
DOS disk. This FAT table, as it is called, keeps a list of all the files and 
directories on a disk. It is the FAT table that determines the order of files when 
you list a directory of files. 

The Desktop file tracks the locations of all files and folders on a Mac disk; it 
also produces the visual map that locates the associated position of each file 
and folder on the Finder window. Both files are invisible to the user, but 
absolutely necessary to the operation of their respective machines. 

There is one important difference between the FAT and the Desktop. If the 
Desktop is lost or corrupted in some way, the Mac can examine the disk and 
recreate that file. A lost FAT is usually a complete disaster, requiring, at best, 
the use of some very sophisticated recovery programs, and at worst, a complete 
reformat of the afflicted drive. 

Other Factors 
As we stated earlier, the two files that must be present to boot a Mac are the 
System and the Finder. However, there are other files that become associated 
with the System- for instance, the !NITs. All System files, including third-party 
IN1T files, must be located in a special folder called (not surprisingly) the 
System Folder. (This is true of all current versions of the Mac operating system. 
The only exception concerns MFS disks which are explained in Chapter Three.) 

Which computer boots faster? The answer depends on several factors. For 
instance, the graphic Macintosh Desktop screen takes more time to produce 
than the DOS prompt on a PC. Also, on a Mac with plenty of memory, you may 
find people using five, ten, or even more !NITs. Though useful, each INIT takes 
some time to load. In consequence, booting a fully loaded Mac can take some 
time. 

The equivalent situation on a PC would involve loading ten or more device 
drivers or Terminate and Stay Resident Utilities (TSRs). There are some 
networks that require loading a host of utility drivers during boot up, but 
generally, a PC will only load a few drivers and TSRs at boot time-largely 
because of lack of available memory. 
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In the Mac's favor, it performs a very fast memory check-even up to its fullS 
megabyte capacity-while many PCs still seem to count memory on their 
fingers and toes. You'll notice this especially on systems with expanded or 
extended memory. 

Generally, things tend to even out. Sometimes a PC wil boot faster; sometimes 
a Mac will. Overall, the speed of booting is not too critical. 

Startup Files (Autoexec) 
Earlier we mentioned a correlation between the Set Startup menu option and 
the Autoexec.bat. On the Set Startup dialog box you determine which 
applications to start when the Mac boots. Generally speaking, either the Finder 
or MultiFinder is the startup application. Finder is the default. You could, 
however, set HyperCard as the startup and then the Mac would always start 
HyperCard when you booted. 

Another setting in the Set Startup dialog box allows you to tell the Mac to 
remember which applications you are running and reopen them the next time 
you boot. This can be used as an equivalent to the DOS Autoexec for loading a 
set of applications at boot time. However, there is nothing in one place in the 
Mac operating system that performs all the functions of the Autoexec. Some 
Autoexec functions are performed by INITs, others are performed by System 
utilities like Set Startup, and some are not needed at all. 

For instance, an Autoexec might be used to load TSR's like Borland's Sidekick. 
On the Mac, TSRs are replaced by INITs and desk accessories (DAs). This is ex­
plained in more detail in Chapter Four. 

You might also use the Autoexec to set the PATH statement on the PC. 
However, there is no equivalent Path statement on the Mac. For additional in­
formation on organizing your files, see Chapter Three. 

Although it seems that much has happened while the Mac is booting up, it all 
happens quickly (depending on how many INITs must be loaded). At the end, 
you'll see the standard Mac desktop environment called the Finder. Once the 
Finder is displayed, the boot-up process is complete. It's time to interact with 
the Mac. You'll learn more about the Finder in Chapter Three, but for now, you 
can think of it as the Mac equivalent of the DOS command level (the DOS 
prompt). 
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A FIRST LOOK AT THE MAC ENVIRONMENT 
Among the concepts most critical to understanding the Mac operating environ­
ment, the most central may be the icon. 

Icons 
In some ways, working with a PC is pretty straightforward. You use words all 
the time in daily life, and, in a similar way, you use words on the PC. You're 
used to reading something and typing a response. You've done it hundreds of 
times-taking tests, applying for jobs, visiting a new doctor. In a sense, you are 
used to responding to words with words. 

You are also accustomed to issuing commands: "Take me to Third and Broad­
way;" "Don't forget to write;" "I'd like a sirloin, medium rare." In the same 
way, you're used to telling the PC what to do-maybe not in English, but in its 
own language. You rarely issue commands on the Mac; you simply perform an 
action or choose from a menu. It's a little like the difference between saying, 
"Hey, you, move that rock over there," and picking up the rock and moving it 
yourself. 

On the Mac, you use icons. Look at it this way-an ancient Egyptian would feel 
right at home. That is not to say that icons are hieroglyphics, but they are 
pictoral representations of things that, on a PC, would be words. 

What are icons, anyway? In one sense, words are icons, but very sophisticated 
ones. Mac icons are much simpler. They are pictures that represent things. For 
instance, an icon for the Mac equivalent of a PC directory (called a folder) looks 
like a manila folder. An icon for a word-processed document looks like a page 
of text. In general, icons convey in a picture what might otherwise require 
several words. 

The Mac uses icons to represent files, folders, disk drives, commands, and other 
Mac objects. Some of the most common standard icons are the disk drive icons, 
the folder icon, the trashcan icon, System icons, and the standard document 
icon. You will learn about the specific properties of Mac icons as you read 
further. 
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Figure 2·9. Standard icons 

File Naming 
On the PC, you can use almost any character except the backslash, the space, 
and the period to name a file. Each DOS file can have up to eight characters 
and the file extension up to three letters . A DOS file can be one character in 
length, with or without an extension. You probably never felt limited. You 
always understood what gr5d-4.doc meant even if nobody else did. 

The Mac doesn't seem to be very word oriented, with its icons and windows 
and all, but it does like a good name. In fact, it likes names so much that you 
can create names with spaces (a PC no-no) and even with intelligible 
descriptions. 

File and folder names can be up to 31 characters long and disk names can be up 
to 27 characters long. On a Mac, names can contain just about any character 
except the colon (which is the equivalent of the DOS backslash, used to 
designate elements of a path). Though the Mac lacks a PATH command, it does 
keep internal path information about every file, folder, and disk. 

On the Mac, as on the PC, file names are not case-sensitive. A name like "apple 
folder" is the same as "Apple Folder" or "APPLE FOLDER." 

Some PC users will miss the file extension. Not that you can' t use a file 
extension on the Mac, it's just that the extension doesn' t serve the same 
purposes as it does on the PC. On the PC, .exe, .com, or .bat files are all 
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executable files. .doc files may designate the files from your favorite word 
processor while .wkl and .db may hold some special meaning for you. In 
addition, you can use wildcards to perform operations on bunches of similar 
files (Oir *.doc, for instance). 

From the Mac point of view, file extensions are just another part of a name and 
hold no special signficance to the operating system. Nor can you perform 
wildcard operations with Mac files. For more about wildcards, see Multiple 
Selections later in this chapter. 

Selecting Objects 
In many PC programs, when you want to perform an operation on a segment 
of the information, you select it, using various commands. For instance, in 
many word processors, you mark the beginning of a block, then the end of it. 
The block changes color or highlights to indicated that it is selected. Similarly, 
you may select a range of cells in a spreadsheet or a subset of records in a 
database. You can then perform some operation on the selected portion of your 
data. 

Though you will also select blocks of text, cells, or records in Mac programs, 
the concept of selection is even more important and pervasive in a graphic 
system like the Mac. Each icon is an object. You must select an object to tell the 
operating system, ''This is the one I want to act upon." 

Mac objects indicate the selected state in several ways, but the most usual way 
is to change the highlight color-the same way that a block of information on 
the PC is highlighted. In addition, certain icons may change shape when 
highlighted. Though this is rare, you may notice that some icons change 
completely when you select them. 

USING THE MOUSE 
At this point, you will have to hang up your keyboard for a while and start 
mousing around. If you are really a hard-liner, you may find yourself asking, 
"Isn't there a better way?" But take heart. Many a reluctant keyboard wizard 
has discovered that rodents aren' t all bad. 

One of the most important tools you will use when working with icons is the 
mouse. On the Mac, the mouse is not an optional appendage to the keyboard as 
it is for most PCs. It is an integral part of the Mac operating environment and is 
used to select objects as well as to perform a variety of other tasks. 

When working with the mouse, you will often be working with icons. Most 
mouse techniques involve manipulating icons or choosing menu commands. 
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Button, Button ... 
If you are an experienced PC mouse user, you will probably feel that the Mac 
mouse has been through a difficult operation-to wit, the amputation of one of 
its buttons. (We all know what happens when you lose one of your buttons.) 
However, the Mac has always had only one button, while most of its PC 
counterparts have two or three. 

Before you lament the vagaries of mouse evolution, you might want to know 
that the news isn't all bad. The single-button mouse is not as handicapped as it 
might seem. On one hand, you don't have that extra dimension, that extra 
choice or option represented by another button or two. On the other hand, you 
don' t have to remember which button selected a word, which combination of 
buttons selects a paragraph, opens the menus, and so forth. On the Mac, the 
button is The Button. There is no other. 

The question of how many buttons suggests several arguments. In favor of 
more buttons is the possibility of greater flexibility and control solely from the 
mouse. In favor of one button is the argument of simplicity. In addition, the 
single-button mouse has made a significant contribution to uniformity of 
technique among programs. Software developers can' t be tempted to 
experiment with combinations of button presses. Though there will be 
proponents of both solutions, there does not appear to be any change in sight. 
The Mac mouse has always had one button, and appears destined to remain 
unchanged. 

You might feel slightly handicapped at first if you are experienced with a 
multi-button mouse, but the Mac system has merit and works well. With a 
combination of simple techniques, you can use the Mac mouse to perform a 
variety of actions, and you'll soon find the very simplicity which at first seems 
limiting, becomes second nature. 

Figure 2·10. Holding the mouse 
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Cursors, Foiled Again 
The mouse is a positioning tool. On the PC, you may be used to the cursor 
control keys located on or next to the numeric keypad. Among other things, 
you will use a mouse the same way you have used those keys-to relocate the 
cursor. 

Usually, the cursor takes the form of a small blinking underline. This cursor 
represents the place where typed characters will appear on the screen. In Mac 
terms, this is the insertion point, and you'll see why this term holds significance 
on the Mac in a moment. 

Another property of the PC's cursor is its ability to change shape. For instance, 
it can sometimes change from a blinking underline to a solid blinking square. 
This change often signals a shift from typeover mode to insert mode in certain 
programs. 

THE MOUSE POINTER. Because the mouse is primarily a positioning tool, it 
uses its own cursor on the screen called the mouse pointer. When you move the 
mouse from one position to another, those movements are echoed by the 
mouse pointer on the Mac screen. 

Ordinarily, the mouse pointer is a small arrow shape, but, like the PC's cursor, 
the pointer will change at times. This change in the pointer shape is a signal 
that the mouse function has changed or that the properties of the area beneath 
the mouse pointer are different. For instance, one common pointer type is 
called the !-beam cursor. The 1-beam appears when you place the mouse pointer 
within an area that can accept text from the keyboard. Another common 
pointer shape is the watch (sometimes a spinning ball), which signals that the 
Mac is busy. 

Many Mac programs use their own pointer shapes to indicate the current oper­
ation of the pointer. For instance, many paint programs use a brush shape to 
indicate that you can paint, a pencil for drawing, and a paint can for filling 
shapes with color or patterns. 

THE INSERTION POINT. It is important to understand the distinction between 
the mouse pointer and the insertion point. The insertion point is marked by the 
presence of a blinking vertical bar. The insertion point is placed by clicking 
with the 1-beam pointer. For instance, in a word processor, the insertion point 
represents the place where letters will appear if you begin typing. Essentially, 
the insertion point is the equivalent of the PC cursor, which always indicates 
the place where typed information will appear on the screen. 

+ I 
Figure 2·11 . Mouse pointer shapes 
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The mouse pointer, on the other hand, is independent of the insertion point, 
and can be used to move the insertion point or to carry out other actions. In 
some programs, the mouse pointer will disappear while you type. However, 
moving the mouse will instantly make it reappear. At other times, there may be 
no insertion point until you specifically locate the mouse pointer in a text area 
and click. 

MACHINT: Holding and using a mouse is a fairly intuitive process, 
however for those of you who have never tried, here's a quick guide to 
proper mouse technique: 

To begin with, learn to hold the mouse comfortably. Place your hand, 
palm down, over the mouse. It won't bite. Your thumb should be 
located on the side of the mouse, and your third and little fingers 
should support the opposite side; the "tail" curls out in front of your 
fingers. Position your index and middle fingers over the mouse button, 
ready to tap it. Now move the mouse forward, backward, and side to 
side. Part of your hand can rest lightly on your desk or mouse pad 
while you move. By the way, a mouse pad is highly recommended. A 
mouse may find an ordinary table somewhat slippery and lose its foot­
ing. It also tends to get dirty and everyone knows that a dirty mouse is 
an unhappy mouse. 

Sometimes you may find your mouse moving erratically. It may skip or 
become hard to control with precision. At first, you may suppose that the little 
rodent is damaged but it may only be dirty. 

To clean the mouse, turn it over, twist the circular ring to open it, and remove 
the mouse ball. You may want to inspect the ball first, but inside the mouse are 
three round wheels. These often become encrusted with dirt from your desk 
and environment. With a toothpick, pen point, or other handy object, you can 
scrape off the coating of dirt, replace the ball, and find yourself with a mouse 
reborn. 

Mouse Techniques 
PC techniques almost all require effective use of the keyboard, the arrow keys, 
and the function keys. Important keys are the Ctrl and Alt keys which help 
modify the meanings of many of the PC keys. 

On the Mac, the mouse is essential (not that the keyboard is entirely ignored). 
You use the keyboard primarily for basic text input, for issuing special 
commands (like on the PC), and for modifying the effect of the mouse actions. 
But you can't really use a Mac without getting your paws wet. 
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The basic mouse techniques are: 

• Clicking 
• Dragging 
• Double-clicking 
• Triple-clicking 
• Marquee selections 
• Shift-clicking 

CLICKING. Clicking is used to select an object or to position the insertion point. 
Clicking the mouse is simply pressing the mouse button and letting go again, 
although sometimes, when you read a statement like "Click on the icon, and 
drag the mouse ... " it refers to the dragging technique explained next. 

To select an item, you simply position the mouse pointer over that item, press 
and release the button. 

DRAGGING. Dragging is what you do at the end of a hard day at the PC. On 
the other hand, when you use a Mac, you start dragging almost immediately . 

Dragging is actually a combination of clicking and moving the mouse. To drag 
an object, click the icon to select it, but don't release the button. Then, with the 
mouse button still down, move the mouse. The outline of the object moves with 
the mouse pointer. When you release the button, the icon of the object moves to 
the location of the outline. 

You might give the command, copy xyz.txt A: on a PC to copy the file xyz.txt to 
the A drive. On a Mac, you simply would drag the file icon from one disk to 
the other disk. 

You can use the dragging technique in many places. You use it to move files to 
other disks and folders; to relocate and resize windows (more on that later), to 
change the arrangement of objects on the screen, to draw shapes and lines in 
graphic programs, and even to select ranges of text, cells, or records within 
applications. As you will see later in this chapter, dragging is also the basic 
technique you'll use when working with the Mac's ubiquitous pull-down 
menus. Sometimes instructions in manuals will state simply "drag the icon ... " 
but sometimes they will say, "click and drag the icon .... " Both statements are 
equivalent. 

MACHINT: Sometimes, when you are dragging an object, you will find that 
you cannot physically move the mouse any further in a certain direction. As 
long as you do not release the mouse button, you can lift the mouse from the 
desk or pad and reposition it. Then, you can continue with the dragging tech­
nique. This is especially useful when you have very little desk space available 
for the mouse. 
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DOUBLE-CLICKING. When you load a program on the PC, you usually type the 
name of that program or a ba tch file that runs it. To run a program on the Mac, 
in general, you would double-click on that program's icon. 

Double-clicking is often used to activate a selection. For instance, to start a 
program, position the mouse pointer over the program's icon, then click the 
mouse button twice in rapid succession. You will learn many other appropriate 
places to use double-clicking. And don't worry if it seems awkward at first. It 
soon becomes very easy and it's generally much faster than typing a command. 

MAcHINT: Most mouse buttons have the same tension, but we have found 
some to be stiffer than others. If the button on the mouse you use seems very 
stiff, you may find double-clicking awkward and you may wish to trade it for 
an easier one. 

TRIPLE-CLICKING. Triple-clicking is just what you'd think-clicking three times 
in rapid succession. Clicking three (or more) times isn' t used too often. 

Multiple Selections 
Because icons on the Mac are individual objects, you can select them, pick them 
up and move them, and perform various other operations on them. What you 
can do to one icon at a time, you can often do to several. In this section you will 
see how to select more than one icon. 

Although basic mouse techniques may seem foreign to many PC users, double­
clicking often serves the same purpose as typing a .com, .exe, or .bat file name 
to execute a program. Here, multiple selection techniques are the closest Mac 
equivalent to PC wildcard operations which enable you to perform a single 
command on several files at once. 

The Mac does not have wildcards. Because it is not text- or command-based, 
wildcards are not appropriate. However, this doesn't prevent you from acting 
upon more than one file or folder at the same time. It does mean that you will 
use different methods to choose the files and folders. 

On the PC, wildcards are used to perform the same action upon a group of files 
that have some text information in common. For instance, you might issue a 
command like COPY *.com A: to copy all .com files to the A drive. Or you 
might issue a command like ERASE Book*.doc to erase all files that began with 
book and ended with .doc (bookOl.doc, booklet.doc, book999.doc). 

On the Mac, there is no way to select multiple icons with wildcards by using a 
trait that they have in common. You can select icons on an individual basis or 
you can select multiple icons. 
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There are three basic techniques for selecting more than one item at a time: 

• Marquee: Drawing a box around the icons to select multiple icons 
which are physically near each other on the desktop 

• Shift-dick: Using the Shift key with the mouse to select (or deselect) 
icons individually 

• Select All: Using a commonly occuring menu item to select all the 
icons in the current folder (directory) 

Dauid's Driue 
17 itt"ms 12,347K in disk S, 132K availablt' 

LiJ 
System Folder 

CJ CJ 
First Dr aft FULL WRITE 

Full Paint 

Figure 2·12. Marquee selection 

THE MARQUEE. The first technique uses the dragging technique to draw a box 
around the items you wish to select. To do this, first envision the objects you 
wish to select as enclosed by an invisible square or rectangle. Then, find one 
comer of the shape and click once on that place. The mouse pointer should not 
touch any object or icon. Now drag the mouse from the original comer to the 
one diagonally opposite. A dotted enclosure (called a marquee) will expand as 
you move the mouse, and when you release the mouse button, all the objects 
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within that square or rectangle will be selected. You can now perform 
operations on those objects en masse. 

SHIFT-CLICKING. The other way to select more than one object is called Shift­
clicking. Shift-clicking involves holding down a Shift key on the keyboard 
while clicking the mouse. Shift-clicking extends the current selection, meaning 
that any currently selected objects or icons will remain selected, but the newly 
selected object or icon will also be selected. 

Use Shift-clicking when you want to select non-contiguous objects and also to 
deselect an already selected object. · 

You can combine marquee selection with Shift-clicking. To do so, first select 
one or more objects using normal methods. Then, holding down the Shift key, 
draw a marquee around some additional objects. The new objects will be 
selected along with the original selections. 

SELECT ALL. The Select All menu choice occurs at the Mac Finder level as well 
as in many programs. It simply selects all the files and/ or folders in the current 
window (at the current folder, or directory, level). Most often, Select All is 
abbreviated Command-A. 

MACHINT: You can also use the Shift-click technique as an exclusion 
operation. For instance, you can use Select All to select all the icons in the 
current window or the marquee technique to surround an imaginary rectangle 
containing the icons you want. But suppose that you don't want to select one or 
more of the icons within the selection. You can easily Shift-click on those that 
don't belong to exclude them from the selection, and therefore, from the current 
operation. 

The characteristics of the mouse operation can be set to individual tastes. 
Chapter Four will explain how to set mouse speed, double-clicking speed, and 
other useful parameters. 

WINDOWS 
If you consider icons as the basic objects in the Mac system, and the mouse as 
the primary means for manipulating these objects, you still need a place to keep 
your information. In a sense, you need a container for your icons and for your 
work. 

The Mac uses windows as the containers for information. These windows have 
many special characteristics. You can open them, close them, move them, 
change their shape and size, and display them side by side-one on top of 
another, or any way you want. Windows are another of the universal objects in 
the Mac system. 

The bare DOS screen shows very little information. Typically, a drive letter and 
a flashing cursor are displayed. Until you actually issue a command, there is 
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little else to see-despite the fact that there may be a vast array of programs 
and document files on the disk waiting for you to work with them. 

Likewise, it is probable that when you to boot up a Mac for the first time you 
will see nothing but a set of menus across the top of the screen, a disk drive 
icon, and the trashcan icon. If you are looking for the command line, forget it. 
There's no place to type a command. 

r a File Edit Uiew Special 
., 

Figure 2·13. Finder with no open window 

Now on the PC, if you want to see what is on a disk, you would use the DOS 
DIR command to list the contents of the disk to the screen. At any one time, 
you can list the contents of a single directory, and the root directory listing 
shows all the basic files and subdirectories at that level of the disk. This root 
directory listing is, in a sense, like peeking at the basic contents of your disk 
drive. 

The information you see on the PC scrolls up and out of view. You can't move 
backward to view it at your leisure, though you can use various commands to 
stop the scrolling display a screen at a time. 

The Mac places most of its information in windows. File and folder listings are 
always in individual windows; programs run inside their own windows; 
multiple documents opened at the same time by programs may each occupy a 
separate window. These windows aren't plate glass or even plexiglass. They 
are simply little software environments. But Mac windows all share certain 
common characteristics-whether they are file listings, a single folder, or a 
document running within an application. 
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Other than Microsoft Windows, Framework®, and various other specific PC 
programs, windows play little part in the daily life of the PC user. However, as 
much as you may think mouse when you think Mac, you'll also come to think 
window. 

In this case, double clicking on the disk drive icon opens its associated window. 

r • File Edit Uiew Specl61 
, 

Figure 2·14. Finder with basic window 

In some ways, the information displayed in that window is the same 
information you got when you executed the DIR command on the PC. It 
displays the file and folder icons that represent the information on the disk-at 
the root level. However, this display does not scroll, but remains stationary as 
you view it. Though these are both views of similar data, they employ vastly 
different systems and offer vastly different features. 

Earlier, we said that you can open a disk drive window by double-clicking on 
the disk drive icon. This is also true of folders. Double clicking on a folder icon 
not only opens the associated folder window, it also makes that folder active. 
This is the direct equivalent of using CHOIR to change directories, then DIR to 
display the file listing for that directory. 

(You can also open a disk drive or folder window by selecting its icon and 
choosing Open from the File menu). 

When you open the drive window, ordinarily you will see a set of icons 
representing the files and folders on that disk. You'll also notice that the 
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window seems to expand out from the original disk icon. This is one of the 
useful features of the Mac that you'll probably take for granted. Whenever a 
window opens or closes, it expands out from or back to its origin- a disk icon 
or folder. On a crowded desktop, this can be a valuable way to locate your 
current working location. In addition, the drive or folder icon last used will 
remain selected. Although this may seem an unnecessary visual trick, it is 
much more. 

D Dauid's Mail DOH 0 
0 items 32K in disk 2,330K available 

Q 

K} 
~I I~ '2l 
Figure 2·15. Labeled window example 

Each disk, folder, or application window contains several important features: 

• Title bar 

• Close box 

• Zoom box 

• Scroll bars 

• Size box or grow box 

These features do not have exact analogies with familiar DOS constructs. They 
are more concerned with the physical side of window navigation and 
manipulation. However, some windows, particularly disk and folder windows, 
display information that you might obtain from various DOS commands. And 
some window operations have analogous procedures on PCs. Where these 
exist, we'll point them out. 
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The title bar. The title bar is the horizontal area at the top of the window. It 
contains the name of the disk, folder, or document to which the window 
belongs. Click and drag the title bar to move the window anywhere on the Mac 
screen. When there are multiple windows displayed on a screen, the title bar of 
the most recently selected, (active) window shows a series of horizontal black 
lines. Inactive windows still display their titles, but the lines are missing. Scroll 
bars are displayed only for the active window. 

D Oauid's Mail BoH 

Figure 2·16. Title bars 

Beneath the title bar of a disk or folder window, is a line containing information 
about the number of files on the disk or in the folder, and the space used and 
space still available on the disk drive. This is some of the same information you 
might obtain using the DOS command, CHKDSK. The contents of a window 
are, in fact, a directory listing of the disk or folder. Therefore, no explicit DIR 
command is used on the Mac. Simply opening a disk or folder window 
produces a file and folder listing. You'll learn more ways to display file listings 
in Chapter Three. 

In contrast to disk and folder windows, ordinary document windows (the kind 
you use when running applications) display the data with which you are work­
ing (for instance, your writing- if the window belongs to a word processor). 

D Oauid's Moil BoH 

Figure 2·17. Close box 

The close box. In the upper left comer of the window inside the title bar is the 
close box. Clicking on the close box-you guessed it-doses the window. 
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The zoom box. The zoom box is handy for temporarily making a window fill 
the entire Mac screen. Click the zoom box again to return the window to its 
original size. Of course, if the window filled the screen to begin with, the zoom 
box will have no effect. (The zoom box is not available on some of the oldest 
Mac computers. If you don't see zoom boxes, chances are you have one of those 
systems.) 

D Oauid's Mail BOH 

Oauid's Mail BoH 

Figure 2·18. Zoom box 

The scroll bars. Most PC programs, including DOS, display information screen 
by screen. In word processors, databases, spreadsheets, and the like, you can 
scroll to points above, below, right, or left of the current cursor position. You 
do so with the aid of keys on the keyboard (like the arrow keys, PgUp, and 
PgDn) and also special keys unique to the program you are running. In 
unmodified DOS, you can scroll information only in one direction. You can't 
scroll back up, for instance, in a directory listing. 

Scroll bars are used in Mac windows and virtually all Mac programs wherever 
the contents of a window exceed that window's boundaries. Whatever kind of 
window-disk, folder, or document-the scroll bar is a standard feature. 

Scroll bars can be either vertical or horizontal. The vertical scroll bar is more 
common, occurring in a wide variety of situations. It sits along the right side of 
a window. The horizontal scroll bar appears when the full contents of a 
window cannot be displayed in the window as sized. In some cases, if there is 
no data outside the current window's boundaries, the scroll bars will appear as 
empty outlines with no scroll box. If a window is inactive, the scroll bars will 
appear as empty rectangles with no scroll box or arrows. 
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D Oouid's Moil BoH 0 
0 i-tems 32K in disk 2,330K available 
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Figure 2·19. Window with empty scroll bars 

A scroll bar itself is made up of several parts: the vertical or horizontal bar, the 
scroll arrows, and the scroll box (thumb). 

l¢1 
Figure 2·20. The scroll arrows in the scroll bar 

The scroll arrows are at either end of the scroll bar. Clicking once on a scroll 
arrow moves the data within the window to display additional information one 
line or character at a time. 

The scroll arrows work in much the same way as the Up and Down Arrows do 
in PC programs. For instance, with the cursor positioned at the bottom of a 
screen, you would press the Down Arrow key to move to the next line down. 
On the Mac, you would click on the downward facing arrow at the bottom of 
the scroll bar. The main difference is that, on the PC, when you press the Down 
Arrow, the cursor itself moves. On the Mac, clicking the scroll arrow always 
affects the entire contents of the window, not the insertion point (though the 
insertion point will usually stay in view). 

The scroll arrows on a horizontal scroll bar function similarly to the Right and 
Left Arrow keys on the PC. 

The scroll box (sometimes called the thumb) serves two purposes- neither of 
which has any exact parallel in most PC programs. 
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First, it gauges where you are in relation to the beginning and end of the win­
dow's contents. For instance, if the scroll box is in the exact middle of the scroll 
bar, then you are viewing data that is approximately halfway between the be­
ginning and the end of the window's contents . 

lol I .................................................... l¢1611 ..................................................... ···················································· ...................................................... .................................................... ..................................................... 

Figure 2·21. The scroll box in the scroll bar 

Second, you can drag the scroll box to any location along the scroll bar, 
positioning the window view at a particular point. This allows you to scroll 
almost immediately to any position within a window. 

If you click once in the scroll bar to either side of the scroll box, you cause the 
viewpoint within a window to move by approximately one screenful 
(depending on how much data remains to be displayed). This is a quick way to 
scroll through a desktop listing or document. Using this method is similar to 
using PgUp and PgDn within PC programs to scroll one screen at a time. 

The size box. Where the scroll bars meet is another small square called the size 
(or grow) box. Drag this box to make the size of the window very small, very 
large, square, rectangular, and so on. 

Figure 2·22. Size box or grow box 

Using the size box and the title bar to size and position windows, you can cus­
tomize the way your Mac screen appears. The Finder saves the size and 
position information for each window, so you needn't resize and reposition 
windows again and again if you like the way you have them organized. This is 
especially handy if you work with large screens, since you can have many 
folder windows positioned so they can all be visible at once. The Finder does 
not remember if a window was zoomed or not, however, so if you like to work 
with zoomed windows, you will have to click the zoom box each time you 
open a window or return to it after running an application. 
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MACHINTS: you don't want the Finder to "remember" anything 
about opening a window-its size or shape, or even the fact that it was 
opened at all-hold the Option key while you open the window. For 
instance, if you want to run an application within a folder, but you 
want the folder window to be closed when you quit the application and 
return to the Finder, hold down the Option key when opening the 
folder window. 

With multiple windows on the Desktop, click one to make it active and 
bring it to the front of the stack. You can move a window that is 
currently in the background without activating it by holding down the 
Command key while dragging the window. It will move, but will not 
become active. 

If several windows are open, and you want all of them to close, hold 
down the Option key and click the active window's close box. 

Selecting the Active Window 
The Mac uses the mouse to select objects, including drives and folders. 
Therefore, to select a new active drive, you would click either on its drive icon, 
or in its open window. Either action is the equivalent of typing a drive 
designation on the PC. 

Similarly, to change active folders, either click on a folder icon or on the folder's 
open window. Either action takes the place of the DOS CHDIR command. 

There is one additional circumstance-that of clicking an application window. 
You'll learn more about that in Chapter Three when you learn about 
MultiFinder, the Mac multitasking operating environment. 

49 



Chapter Two 

MENUS AND DIALOG BOXES 
Menus 
Well, you probably noticed those words at the top of the Mac screen right off. 
You probably recognized them as menu titles. Pull-down menus are pretty 
common these days in PC programs, so you probably aren't too mystified by 
the Mac versions. 

On the other hand, you may not have used this kind of menu since not all PC 
programs use them. However, chances are good that you have used the so­
called Lotus-style menus. Lotus-style menus are hierarchical menus that show 
a single line of options across the top of the screen. Some options lead to 
submenus while other options lead to prompts or carry out actions. 

Some common PC programs that use Lotus-style menus are RapidFile®, Lotus 
1-2-3 (of course), and Paradox. 

On the other hand, many PC programs now use pull-down menus. Among 
them are some top programs like dBASE IV™, Windows, and PageMaker. So 
there is a passing chance that you've see Mac-like menus before. 

A pull-down menu shows its menu title along the upper edge of the Mac 
screen. This lineup of menu titles is called the menu bar. Clicking on a menu 
title and holding the button down causes the actual menu to appear below the 
mouse. To select an option from a Mac menu: click on the menu title, keeping 
the button pressed as you pull down on the mouse to highlight the menu item 
desired. Release the mouse when you have selected an item. The selected item 
will flash briefly and the command will be executed. 

MACHINT: If you start to choose from a menu, and then change your mind, 
simply drag the mouse pointer out to the side or out the bottom of the menu 
before letting go of the button. No menu item will be selected. 

Most Mac applications feature their own sets of menus, but certain menus are 
almost universal. The Finder displays the Apple menu (indicated by a small 
Apple icon), the File menu, the Edit menu, the View menu, and the Special 
menu. Of these five menus, the Apple, File, and Edit menus are found in most 
applications (although frequently with some modifications to their contents). 
These menus are examined in more detail in Chapter Three. 

Although menu items are ordinarily selected by dragging the mouse pointer 
(as explained above), many menu items have what are called Command-key 
equivalents. These are generally marked on the menu itself. For instance, in the 
File menu of the Finder, Command-N creates a new folder, Command-O opens 
a window on a selected folder or disk or launches a selected application, and 
Command-W closes a window (the same thing the close box, and the Close 
item on the File menu does). 
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AUTHORS' NOTE: How and when to use keyboard commands as 
opposed to menu commands or mouse techniques is a matter of personal 
preference. Each Mac user finds a unique blend of techniques that fits his 
or her personal work habits. Sometimes you'll find yourself using one 
technique more than another, then, suddenly, you'll find that you prefer 
to do things a different way. That's one of the beauties of the Mac system. 
You aren't locked into one way of doing things. The mouse is an intuitive 
way to do things, but keyboard commands are often more convenient, 
once you get used to them. 

An experienced PC user at first may find using a mouse a bit awkward. 
Removing your hand from the keyboard to manipulate the mouse may 
be distracting. It was for us. However, as time passes, the techniques of 
keyboard and mouse will blend into a smooth operation, and the initial 
awkwardness will give way to a greater efficiency. 

So if you are experiencing some difficulty adjusting to the mouse, you 
aren't alone. In all likelihood you'll find the transition is short and worth 
the effort, just as we did. Moreover, you don't have to feel trapped by the 
mouse. You'll learn that you often have options that let you use the 
keyboard for many operations. 

Many menu options carry out commands immediately. These options are 
similar to DOS commands, which are usually immediate in effect. However, 
some menu items do not execute an immediate command. Instead, they cause 
the display of a special information box called a dialog box. 

Dialog Boxes 
DOS communicates with you in a brief and often cryptic way. A mistake is a 
Syntax Error, a Bad Command, or a Filename Error. In any case, what the PC 
says to you is short and to the point, but sometimes inadequate. 

On the other hand, the Mac does things a bit more visually, and perhaps more 
loquaciously. The Mac communicates with you by means of dialog boxes. And 
what's more, it often gives you a chance to answer where messages from DOS 
are almost always rhetorical. 

Often, a menu command will lead to a dialog box, which may simply be an 
alert box (a warning or message only), or a dialog box that requires you to make 
selections, insert text, or interact in some way. 
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(- ) Completely erase disk named 
II Dauid·s Mail BoH II (Cirrus 21 D 

(SCSI #O))? 

K Concel ~ ( Initialize ) 

Figure 2·23. Alert box 
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Figure 2·24. Dialog box example with buttons, default buttons, radio buttons, 
check boxes 

Dialog boxes may contain one or more of the following items: 

Buttons. Clicking a button instantly implements the action the button 
represents. Almost all dialog boxes have both the OK and the Cancel buttons. 
OK is used universally to accept the information in the dialog box and 
continue. Cancel generally backs out of an operation. 

Default buttons. A button that has a thick outline around it is the default 
button. Pressing the Return key or sometimes double-clicking an item will also 
activate the default button. Buttons, however, are single-click items. You do not 
need to double-click a button. 
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Figure 2-25. Default button 

Radio buttons. Radio buttons are used to select from a list of possibilities. 
Only one radio button in a list of radio buttons may be selected. Selecting a 
radio button does not initiate an immediate action. It sets an option or choice to 
be implemented when you click the OK button. If you click the Cancel button, 
any choice you have made by selecting a radio button will be canceled as well. 

Paper: ®US Letter 
0 US Legal 

Figure 2-26. Radio button 

0 R4 Letter 
0 85 Letter 

0 Tabloid 

Check boxes. Like the radio button, check boxes are used to select items from a 
list, but more than one check box can be selected per list. 

Printer Effects: 
t8J Font Substitution? 
0 TeHt Smoothing? 
t8J Graphics Smoothing? 
1:83 Faster Bitmap Printing? 

Figure 2-27. Check boxes 
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Text boxes. A text box is a place to insert text information. For instance, in a 
typical save file dialog box, you type the name of the file to save in a special 
text box field. When a dialog box contains more than one text box, use the Tab 
key or the mouse to move between them. Pressing the Return key will probably 
activate a default button or possibly erase the contents of the current text box. 

I a Full Paint I 
~ F"uiiPnin t Q c:::> Dauid's Dri. .. 
CJ Illustrations 

[ I:jt~e1 ] 

( Driue ] 

~ 
Saue Document Rs: ~ [ Saue ] 

[ Cancel ] 

Figure 2·28. Text boxes 

List boxes. On the PC, you select a program to run or a file to use by typing its 
name. Some PC programs will display a list of available document files from 
which you can choose. Others simply require you to remember which file you 
want. There is no universal convention used by PC programs when choosing 
files to load. 

On the Mac, however, when you must select from among several files, most of 
the time you will see a list box. You can choose the appropriate file by scrolling 
through the list and selecting the file to use or by typing the first few letters of 
the file you want. You can often double-click on the name of the desired file 
both to select it and perform the action represented by the default button. 
Pressing the Return key with a file selected will also do so. Notice that you 
rarely have to type the actual file name itself. In fact, you usually type the name 
of a file only once on the Mac-when you first name (or rename) it. 
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The Drive button. On the PC, you can often load files from or save files to 
different directories or disk drives. Most PC programs provide a way to do so. 
However, there is no uniform method for doing so other than to type in the 
DOS path at the appropriate promp t. 

On the Mac, you can select other active drives by clicking the Drive button on a 
standard list or save fi le box. You can move to folders at a lower level by 
double-clicking a folder name in the list, or by selecting and then clicking the 
Open button. If you need to change disks in a floppy drive, you can press the 
Eject button to remove the current disk and then replace it with another. Any 
time you place a new disk in a floppy drive while a dialog box with a Drive 
button is showing, that disk becomes the default d rive. 

You can move up the hierarchy of folders by clicking on the folder name above 
the file list, then dragging down to highlight the level to which you wish to 
move. 
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Figure 2·30. Selecting a folder in a dialog box 
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MACHINTS: Besides typing the first letter or so to select a file from a 
list, you can use keyboard shortcuts to change drives, to move up and 
down within the HFS system, etc. These shortcuts don't work within 
every application, but some quick experimentation will tell you whether 
they will or not. 

• To change drives in certain dialog boxes, press the Tab key. To eject a 
disk in some dialog boxes, press Command-E. To move up the 
Hierarchical Filing System (HFS), press Command-Up Arrow. To 
move down the HFS, press Command-Down Arrow with the sub 
folder highlighted (same as double clicking). (For additional informa­
tion on HFS and MFS, see Chapter Three.) 

• In some cases, you can use the tilde key to move quickly to the end of 
a list, and the Backspace or Delete key to move to the beginning, but 
be advised that these options will not work in dialog boxes where a 
text box is present. In such dialog boxes, the insertion point is 
automatically placed in the first text box, and pressing any normal 
keyboard character will operate on the text box contents, not the list. 
This is also true of using the first letters to locate a specific file or 
folder. 

Some practice with dialog box shortcuts will increase your enjoyment of 
the Mac. As you become more and more familiar with the tricks and 
shortcuts offered on the Mac, your actions will become more 
streamlined and you will save time and effort. 
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A Closer Look at Menus 
Many PC users praise the simplicity of the DOS command line and like a no­
frills approach to computing. If that description fits you, then you probably 
won't appreciate the many details that the Mac operating system throws at 
you. But, if the PC operating environment has some of the basic simplicity and 
beauty of the high desert, the Mac environment has perhaps made a forest path 
out of it-with lots of trees and subtle undergrowth. 

One of the subtle visual clues the Mac offers has to do with the way it displays 
menu choices. There are several important and useful visual conventions 
designed to help you be more effective with menus. 

• The Mac operating system is intelligent about when a particular menu 
command can or can't be used. When a menu item is unavailable, it is 
dimmed, or displayed in gray. For instance, if nothing is selected, the Open 
item in the File menu will appear gray-there is nothing to open. Click once 
on any icon, and the Open menu command appears dark again, meaning it 
is available. 

• Menu items with Command-key equivalents usually indicate the 
appropriate Command-key to the right of the menu item. 

• Often, menu commands are separated by horizontal lines. Though these 
lines do not change the functions of the menu commands, they are used to 
group menu commands for easy interpretation. 

Other clues tell you something about what will happen when you choose a 
menu command: 

• Plain menu choices perform an immediate action. These act as direct 
commands. 

• Some menu commands lead to a dialog box. These contain an ellipsis (. .. ) 
after the menu command name. 

• Menu commands followed by a right-facing arrow lead to submenus or, in 
Mac terminology, extended menus. 
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New 
Open ... 
Close 
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Quit 

Figure 2·31. Menu example with dimmed items, command keys, ellipsis 

EXTENDED MENVS. Extended menus are among the newer innovations in Mac 
menus. You can open an extended menu by selecting a menu item which 
contains a right facing arrow after the option name. Once the extended menu is 
open, you keep pressing the mouse button, dragging it into the extended menu 
where you can highlight another choice. Releasing the mouse carries out the 
chosen action on the extended menu. This action requires more precision with 
the mouse than choosing from an ordinary menu. 

Some special extended menus will remain on the desktop when you choose 
their title on a previous menu. You can then choose an option from one of these 
so-called sticky menus without the manual dexterity sometimes required of the 
ordinary extended menu. 
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Figure 2·33. Tear-off menus 
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The newest kind of menus are called the tear-off menus. Although currently 
rare, this menu type allows you to actually take the menu out of the menu bar 
and place it anywhere on the Mac screen. There is no visual clue to indicate that 
a menu is of the tear-off variety, but the easiest way to find out is to drag the 
mouse all the way through a menu, out the bottom, keeping the button pressed. 
If the menu is a tear-off menu, a dotted outline of the menu will follow the 
cursor. An example of a tear-off menu is the Tools menu in HyperCard. 

For more information about different types of Mac menus, see Chapter Five. 

60 



Basic Operating System Concepts 

GOING FORWARD 
In this chapter, you have learned many of the basic tools and techniques 
necessary to work effectively with the Mac. You have learned about the mouse, 
icons, and windows. You have also learned about starting the Mac. In the next 
chapter you will learn more about the Mac interface-in particular, about the 
Finder. 

The Finder and the desktop are the Mac equivalent of the interactive portion of 
DOS. It is from the Finder that you will duplicate the operations you normally 
perform in DOS on the PC. However, the Finder has very different 
characteristics and methods as you have already seen in this chapter. Chapter 
Three explores these characteristics and methods further, with special attention 
to the standard Finder menus. 

The Finder menus are, in some ways, the equivalent of the many DOS 
commands that you use from the DOS command line on the PC. Therefore, 
they form an integral part of the Mac Operating System. 
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The Operating System­
Commands and 
the Finder 
The PC operating system comes with a set of internal commands like DIR and 
TYPE. It also features a set of external or file-based DOS commands that you 
access from a disk. These internal and the external commands are the primary 
tools of the PC operating system. You can use them to view and modify the 
contents of your disks, set the screen display, change input/ output port 
parameters, edit text files, and much more. 

(For a complete reference to DOS commands and how they relate to the Mac, 
see Appendix A.) 

DOS commands are only useful at the DOS level, however. You will never see 
these commands operating from within other programs, which always use 
their own command structures. As a consequence, although a knowledge of 
DOS is important for handling disk-related and system-related situations, that 
same knowledge is of very limited use when it comes to learning new 
programs on the PC. Each program has its own commands, structure, and 
methods. 

In contrast, many aspects of the Mac operating system are found universally in 
Mac applications. The reason for this uniformity has to do with the way the 
operating system works. 

What we usually think of as the Mac operating system actually has two 
identities-one, a true operating system running behind the scenes, and the 
other, the Finder, a special Mac application. The Finder is the closest Mac 
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equivalent to the total set of DOS commands, but because it is also a Mac 
application, it shares many important features with all the other Mac 
applications. 

Like the DOS system commands and tools, the Finder is a set of commands and 
utilities. Unlike DOS, however, the Finder uses the standard Mac interface with 
its icons, windows, menus, and dialog boxes-Mac features introduced in 
Chapter Two. In a sense, the Finder serves as a model for the Mac interface, 
which is why understanding how the Finder works offers such a leg up toward 
understanding how everything else works on the Mac. 

For the most part, icons, windows, menus, and dialog boxes work the same 
way, regardless of the application. What differentiates one Mac application 
from another has more to do with the contents of the windows, and the contents 
of the menus than with the way these features work. In the case of the Finder, 
the windows always contain file and folder icons, and the menus offer specific 
commands and tools for working with those files, folders, and other aspects of 
the system. 

Unlike DOS, many of the Mac system-level operations are always available. 
These features are not specifically part of the Finder, and you will learn more 
about them in Chapter Four in the discussions of System Folder files and desk 
accessories. For now, it is only important to realize that, although the Finder 
menus duplicate many of the functions of various DOS commands, they do not 
replace every DOS function. 

In addition to the Finder and the Finder menus, this chapter introduces a very 
important Mac tool-the Clipboard. There is no DOS equivalent of the Clip­
board, though some PC programs do offer internal clipboard-like utilities. 

The Clipboard keeps information that has been cut or copied from the Mac 
screen. You can then paste that information back to the screen at another 
location or even within another window. The Clipboard is discussed in more 
detail later in this chapter. 

The Clipboard becomes even more exciting when you start working with more 
than one application at the same time. On the PC, multitasking is not common, 
and requires special software, and usually extra memory, and faster, more 
powerful machines. 

On the Mac, multitasking ability comes standard with every operating system. 
It's called MultiFinder, and you'll learn more about it later in this chapter. 
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In addition to a discussion of the Finder and its menus, the Clipboard, and 
MultiFinder, you'll learn more about the Mac equivalents (or the lack thereof) 
for the following DOS commands: 

• CHKDSK 

• VER 

• MKDIR 

• RENAME 

• PRINT 

• ATTRIB 

• COPY 

• XCOPY 

• MODE 

• DIR 

• SORT 

• MORE 

• DELETE or ERASE 

• FORMAT 
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Figure 3·1 . Generic Finder example 

The Finder is the primary Mac "desktop." More accurately, the Finder is a 
collection of graphic elements and utilities that form the basic platform for 
launching applications and managing data. The Finder is an integral part of the 
Mac operating system. It is the part of the operating system that you see and 
that interacts with you. 

In this chapter, you will learn more about the Finder, including specific infor­
mation about the Finder menus, which, in their own way, form a large part of 
the basic operating system interface just as the set of DOS commands comprises 
the main operating system interface on the PC. In some ways, the Finder menus 
are your "command line" when you are working with the Mac. 

Before learning about the Finder menus, however, you will find it helpful to 
learn how the Mac organizes and manages its files, folders (directories), and 
disks. 
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MANAGING FILES AND FOLDERS 
It is a good idea to organize your data logically. That's true whether you use a 
PC or a Mac. Here, at last, there is agreement. On any large PC hard disk, you 
must use directories and subdirectories to keep your files in order. 

Mac terminology refers to directories as folders and displays them as little 
images similar to manila folders used in file cabinets. Other than their 
appearance, folders serve pretty much the same purpose as PC directories. 
With folders you can manage even a very large hard disk with a minimum of 
effort. You might create a folder for all information pertaining to one 
department in your business, for instance, and create sub-folders for different 
document types. 

On the PC, when you want to create a new directory, you use the MKDIR com­
mand. To create a new folder on the Mac, you can select New Folder from the 
Files menu, or press Command-N. The folder is initially called Empty Folder, 
but you can immediately type a new name for it. 

The way you manage folders on the Mac is essentially the same as the way you 
manage directories on a PC. However, remember that Mac folders are also 
icons, and can be placed in different physical positions within a window. This 
ability to determine the order and arrangement of folders is a benefit in a 
graphical interface where objects exist in two-dimensional space. In contrast, 
you can work with PC directories one at a time, and nothing about their 
relative arrangement to each other makes any difference. 

MFS and HFS 
The folder icon is special in that it can contain other files and folders. Like a 
manila folder in a filing cabinet, a Mac folder can be used to contain numerous 
other items. 

However, the original Macintosh Filing System (MFS) was a flat system which 
did not allow more than one folder level per disk. It has been almost 
completely replaced by the newer Hierarchical Filing System (HFS) which 
allows multiple folder levels. Under HFS, folders can reside inside other folders 
many levels deep. The invisible Desktop file keeps track of where files and 
folders are found. 
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Figure 3·2. HFS folder structures 

Diverging Paths 
Part of managing directories on a PC involves using the PATH statement to 
make sure that you can run important programs from any disk or directory. 
Earlier in this chapter, we mentioned the absence of a PATH statement on the 
Mac. 

To understand why the Mac has no PATH statement and the PC does, first look 
at how the PATH is used on a PC. It is used to tell DOS where to look when 
you try to open a file that is not in the current directory. 

On the other hand, when you run a program on the Mac, you generally open its 
window and double-click on its icon. (This is the Edward R. Murrow 
approach-You Are There.) 

Having multiple folder windows open on the desktop is no problem; a simple 
click of the mouse can bring one or another to the front of the stack. On a PC, 
moving to a different directory is a complete action and to move back again re­
quires another complete action. 
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The PC's PATH command saves you from having to change directories. The 
Mac requires you to manipulate the icon directly. (There are some utilities 
available that allow you to run programs without direct manipulation of a 
program's icon, but ordinary Mac procedure is as described.) 

Identifying File Types 
Despite its lack of a PATH command, the Mac does have a few tricks up its 
sleeve and they have to do with the unique way the Mac operating system 
recognizes files. 

On the PC, files you identify files by their three-letter extensions. Some files are 
executable-those with .com, .exe, and .bat extensions. All other files are not 
executable, but must, in some way, interact with another program or with DOS 
to be useful. You might think of these other files as documents. 

The Mac also divides most files into two basic categories-applications and 
documents. Applications are like .com and .exe files. You can launch them. 
Documents must, in some way, interact with an application to be of use. There 
are some exceptions to this rule, including such files as INITs (which were 
introduced in Chapter Two) and desk accessories (which are discussed in 
Chapter Four). However, most files fall into either the application or the 
document category. 

Every file on the Mac contains information identifying the type of file it is and 
what application created it. The file type is a special four-letter code. For 
instance, an application always has the file type designator APPL; however, 
you don' t normally see the file type. It is used internally by the Mac operating 
system. Where you would use the PC's file extension to identify a file's type, on 
the Mac you use the file's icon to distinguish an application from a document. 
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Figure 3·3. Application and document icons 

Another internal code designates the application to which each document 
belongs. On the PC, you might know that Lotus 1-2-3 documents use a .wks or 
a .wk1 extension. At a glance, you can identify such a file as belonging to 1-2-3. 

On the Mac, each document has a special four-letter code that tells the 
operating system what file created it. This is called the Creator. The document's 
icon is determined by its creator; therefore, most document files use a 
distinguishing icon to help you tell what application they belong to: A 
FullWrite document icon looks entirely different from a Microsoft Word 
document, or, for that matter, from a dBASE Mac or a 4th Dimension 
document. It is that special icon that helps you identify which document be­
longs with which program. 

You'll notice that, in each system, there is a way for you to identify what kind 
of file you are viewing on a directory listing. However, on the PC, there is no 
way for the operating system to distinguish between a Lotus document and a 
dBASE document. ln contrast, the Mac actually tracks each file and knows not 
only the application to which it belongs but what kind of file it is. Is it a word 
processing document, a personal dictionary file, a file containing preference 
settings, or even an ASCII file created by a specific word processor? The Mac 
knows. 
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Figure 3·4. Application-specific icons 

Document Launching 

., 

One primary benefit of the Mac's system of tracking file types and creators is 
the common Mac technique called document launching. By double clicking a 
specific document icon you can launch that program and the selected 
document in a single step. In some cases, you can even select several 
documents, then double click to load them all at once. 

Programs don't have to be in the same folders as their documents. You can 
have word processor files in many different folders, arranged by department, 
or in some other way that is meaningful to you . 

Of course, you can have document files in directories separate from PC 
programs, too. And you can use the PATH command to run a program without 
actually moving to its directory. It is difficult, however, to run a program from 
another directory and simultaneously load a particular document. In DOS this 
usually won' t work. Few programs actually support that kind of document 
loading, and DOS can be finicky when you try to work with data files in 
directories outside the one a program is in. Regardless of whether it is possible 
to duplicate document launching on the PC, it is not standard practice. 
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MACHINT: There is a trick that uses document launching to save time and 
effort. If you launch an application from a document in a different folder, that 
folder becomes the current one-the one the Mac is logged onto. Even if you 
are going to create a new document in that folder, it is usually easier to open an 
existing document first, then close it and create a new document. That way, the 
new document is created in the document folder, not in the folder where the 
application resides. Of course, you can change folders before saving the new 
document, but that requires several extra steps. 

One of our favorite utilities is the DiskTop DA which can often facilitate file 
management on large hard disks. For more information about DiskTop, see 
Chapter Five, "Software Guidelines." 

Basic File Management 
On the PC, you often have to perform basic file management, and you probably 
use the DOS commands COPY and ERASE often. 

The basic file management operations on the Mac are quite different, though 
they accomplish the same results. In some cases, the Mac system is much easier 
and offers more flexibility. One example of that flexibility is that, in addition to 
file copy and erase, you can also copy and erase entire folders in one step. 

Once again, your perspective changes working on the PC as opposed to 
working on the Mac. On the PC, you type commands at the DOS prompt. You 
can issue the COPY and ERASE commands from any location (any logged disk 
or directory) in DOS. As long as you enter a complete path name for the files 
you want to copy or erase, it doesn't matter where you are in the system. 

Copy and erase functions on the Mac use objects. Once again, it is a matter of 
direct manipulation, meaning that you must be there. You can't perform any file 
or folder management from a distance, as you can in the command oriented 
DOS environment. The Mac style is strictly hands-on. 

Looking at the Mac copy and erase from another angle, however, you' ll also see 
that you perform them without using menu selections or typing keyboard 
commands. 

COPY AND MOVE. To move a file on the PC you would firs t use the COPY 
command, then erase the file at its original location. That's two steps. You 
would also have to type the full directory path of at least one of the 
files-twice. To move a directory to within another directory-well, that's 
another story. You can use XCOPY to copy subdirectories, but there is no 
ordinary DOS command for creating a copy of an entire directory within 
another. 
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The Mac treats files, folders, and disks as icons. A disk is a bigger container; it 
can hold folders and files. A folder cannot contain a disk, but it can contain 
other folders and files. Of course a file cannot contain a disk or a folder. This 
isn't really any different in concept from the disk-directory-file structure on the 
PC. 

But, there are some differences. Since a folder is just an icon on the Mac, you 
can move any folder to any other disk or folder as a whole object-with all its 
contents intact. What happens when you move the icon depends on where you 
move it, as you will see. 

To move any icon, simply drag it to a new location. 

• If the new location is within the same folder (window), the icon will be 
repositioned in two-dimensional space. This action has no PC equivalent. 

• If the new location is in a different folder (window) on the same disk, the 
icon will be placed within the new folder. 

• If the new location is on another disk, the file or folder will be copied to the 
new disk (the original will remain where it was). 

How you move an icon depends on whether the target folder is open or closed. 
To move an icon into a closed folder, drag the icon over the destination folder's 
icon. When the destination icon changes color, release the mouse button. If the 
folder is open, it is often easier to drag the icon into its window to achieve the 
same result. 

This is like a MOVE command since the original icon has been moved (not 
copied) somewhere on the same disk, but to a different folder. 

When copying a file or folder to a drive, drag the icon until it is over the drive's 
icon. Release the button when the drive icon changes color. If the disk is open 
(has a window on the desktop), you can also drag the file or folder icon into the 
disk's window. 

This action is more like a true copy on the PC-like typing copy filename.ext 
A: to create a copy of a file on another disk. The difference is that you can also 
copy a folder as easily, all in one simple action. On the PC, you would have to 
create a new directory on the target disk, then copy the contents of the orginal 
directory to the new one. On the Mac, the folder is copied intact. 

When you copy files to another directory or drive on the PC, you receive a 
simple message like 1 File Copied. In the case of multiple copies using 
wildcards, DOS displays the name of each file as it is copied. 

Remember, on the Mac you can copy or move more than one item at a time by 
using one of the multiple selection techniques described in Chapter Two. 
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Figure 3·5. PC screen after multiple copy 
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The Mac operating system offers no commentary when you move a file or 
folder to another folder on the same disk; however it does provide you with a 
considerable amount of information when copying to another drive. The Mac 
displays a graph that shows how much of the copying process has been 
completed. It also shows you how many files remain to be copied, and it 
displays the current file it is reading or writing. However, before the Mac 
begins to copy, it does something even more useful. 

Have you ever encountered that frustrating DOS message, Disk full, when you 
were copying files from one disk to another? If so, you'll appreciate one of the 
built-in features of the Mac. Whenever you drag one or more icons to copy 
them to another drive, the Mac automatically does some arithmetic and comes 
up with a figure. If all the files will fit, the procedure proceeds without 
interruption. However, if the target disk has, say, 145,000 bytes left and the 
icon(s) you have selected total153,000 bytes, the friendly, helpful Mac presents 
an Alert box that states: There isn't enough room on the disk to duplicate or 
copy the selected items (additional8,000 bytes needed). And it does so before 
starting to copy the files, so you don't get a partially copied disk that you will, 
in all probability, have to clean up to make room for something else. 

To move and duplicate a file or folder on the same disk, hold down the Option 
key while moving it to another folder. Using this Option-drag technique is the 
equivalent of the DOS COPY command. Without the Option key, the drag tech­
nique simply moves the file to a different position on the same disk (even if it is 
in a different folder). 

MACHINT: The key combination, Command-O, is a short cut to duplicate a 
file. 

ERASE. To erase a file or directory on a PC, you use the ERASE or DELETE 
commands. You can use wildcards to delete several files at one time. Once you 
have erased a file, that's it. You can't get it back by using ordinary DOS 
methods (though there are programs like Norton Utilities and Mace Utilities 
that can help you recover erased files). Furthermore, you can't erase a directory 
from a disk until you have removed all the files and subdirectories from it. If 
you try to do so, DOS warns you it its usual succinct way. 

On the Mac, to erase a file or folder, all you do is drag it into the trashcan. Get 
it? You throw it away. Drag an icon over the Trashcan until it is highlighted, 
then release the mouse button. In more recent systems, the Trashcan will bulge 
when it contains discarded icons. 

The Mac will let you throw away any file or folder. Throwing a folder in the 
trash also throws away any files or other folders (and their files) that are 
contained in that folder (see MacHint below). However, the file will not 
actually be erased from the disk until you: 

• Empty the trash (using Empty Trash from the Special menu) 
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• Launch an application 

• Copy a file to that disk 

• Drag the disk's icon to the trash (if the file was on a floppy disk- this both 
erases the file and ejects the disk from the drive) 

• Shutdown or Restart the Mac 

If you change your mind (and you haven't done one of the operations listed 
above) you can open the trash window, just like you would open any window, 
and move the icons back to your disk. 

Dragging a file or folder icon into the Trash is not really the equivalent of the 
DOS DEL or ERASE commands. Only when the actual trashcan is emptied by 
one of the methods mentioned above is the erasure actually carried out. 
Therefore, erasing files and folders is a two-step process on the Mac, even 
though the second step may be automatic. By contrast, erasing files is a one­
step process on the PC, and, as noted earlier, erasing directories and 
subdirectories is a multiple-step process. However, in neither case can you 
change your mind once the command has been executed. 

MACHINT: Whenever you try to move an application or folder containing 
applications to the trash, an Alert box asks you to confirm that you want to do 
that. Once you are comfortable with the process, you can hold down the Option 
key to skip that Alert box. However, it is a good idea to double check that you 
really want to throw the item or items away. With multiple selections, a 
separate alert box will appear for each application or folder that contains one or 
more applications. 

Copying or erasing more than one file at a time using multiple selections is 
similar to using DOS wildcard commands. However, each system offers 
advantages. With wildcards, you can process all files related by some common 
element without additional effort. With the Mac system of multiple and 
extended selections, files lacking a common element can be more easily 
managed, and files in close proximity to each other, or all files within a folder 
can be manipulated very easily and logically. 

MANAGING DISKS 
Ejecting Disks and Powering Off 
Most PC floppy disks are 5 1/4-inch flexible disks. When you insert one of these 
disks in a floppy drive, you can remove it at any time (except, or course, when 
the red light is on and the drive is working). 

76 



The Operating System-Commands and the Finder 

The Mac 3 1!2-inch floppies operate differently. Their eject mechanism is 
handled by the Mac. There are five ways to eject a floppy disk on the Mac: 

1. Highlight the disk icon and select Eject from the File menu. 

2. Highlight the disk icon and drag it into the Trashcan. This is the preferred 
method. 

3. Press Command-Shift-1 (for the internal floppy drive), Command-Shift-2 
(for the external floppy), or Command-Shift-0 for the third disk on a Mac 
SE. 

4. Restart or Shutdown-this will eject any floppy disks. 

5. In cases of emergencies, you can stick a wire (a bent paperclip does well) 
into the small hole to the right side of the disk slot and push. This 
activates a manual eject mechanism. Do this with the power off. 

In very rare cases, a disk may become stuck so that it won't come out using any 
of these methods. If that happens, don't force the disk; see your Apple service 
person. 

One very important fact to keep in mind: you must always use the Shutdown 
command (from the Finder Special menu) to tum off the Mac. This is especially 
important when you use a hard disk because the Mac reorganizes and updates 
all mounted disks during the Shutdown process. If you simply turn the 
computer off, you will have to wait longer for the Mac to rebuild the desktop, 
and you risk losing data or corrupting your drive. For a PC user who is 
accustomed to saving any documents and then flipping the power switch, this 
will be an important new habit to learn. 

What happens if you accidentally shut off the computer without doing a proper 
Shutdown, and you leave a floppy disk in the drive? If the floppy doesn't have 
a System on it, the Mac will reject it when you boot the Mac again. However, if 
the floppy does have a System, and you don't want to boot from it, hold down 
the mouse button when you restart the Mac. This will cause the floppy to be 
ejected before the Mac begins to boot from it. 

Write-Protecting Floppies 
On PC 5 1/4-inch disks, there is a notch on the upper left that is known as the 
write-protect notch. If you cover the write-protect notch on a 5 1; 4-inch floppy, 
the data on it is protected from changes, and you cannot write to the disk. 
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Both on the PC and on the Mac, 3 1; 2-inch floppies use a special tab in the 
upper left corner. If the write-protect tab is covering the hole, it is not locked. 
To lock a floppy disk, slide the tab until the hole is open and you can see 
through the disk. (Of course, you shouldn't try to use a PC floppy on the Mac. 
It won' t be recognized as a valid Mac disk, and the Mac will ask you if you 
want to initialize (reformat) it.) 

,.. a File Edit Uiew Special ~ 
., 

Figure 3-7. Locked disk window 

If a disk is locked, a small lock icon will appear in the upper-left corner of the 
window when you double-click the disk icon. 

Initializing and Formatting Disks 
The Erase Disk command on the Special menu is the equivalent of the 
FORMAT command in DOS. Erase Disk will completely re-initialize a selected 
disk, erasing all files from it. In most systems, you can choose between 
initializing in 400K or BOOK formats (called single-sided and doubled-sided, re­
spectively). If you choose Erase Disk, you will be warned before the disk is 
erased and given an opportunity to back out of the procedure. 

When you format a disk on a PC, you indicate the disk to format by identifying 
it as part of the FORMAT command (FORMAT A:). On the Mac, you select the 
disk to initialize by clicking on its icon-the same way you select any object on 
the Finder. You need to be sure that you have selected the correct disk, 
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however, as you won't be identifying it by name. However, if you place a 
blank, unformatted disk in the Mac floppy drive, the system will ask you if you 
want to initialize it, something that the PC does not do. 

Creating System Disks 
To make any formatted (initialized) floppy disk into a boot disk, you only need 
to copy a System Folder to it. In a sense, this is the functional equivalent of 
using the DOS SYS command to copy the hidden system files to a non-system 
disk on a PC. However, on a PC, you can also use the FORMAT IS command 
to create a system disk during format. On the Mac there is no option during 
initialization for adding a system. On the other hand, copying the System 
Folder is as easy as copying any other folder. 

One problem you may encounter when making floppy System disks is size. 
Unlike the PC system files which are relatively small and haven't grown 
significantly in past versions, the Mac System files have not only grown in size, 
but in number. Many new icons have been added to the basic set of necessary 
files, and quite a few more have become optional, but useful. As a consequence, 
the Mac System Folder can often get quite large--so large, in fact, that there is 
little room left on a floppy disk for the data or program(s) that you originally 
might have wanted on the disk along with the System. This is especially true if 
you ordinarily use a hard disk and have let your System Folder grow with 
extra fonts, DAs, !NITs, and other files beyond the basic System. Attempting to 
copy such a swollen folder onto a floppy disk is going to be non-productive. 

The solution is to copy only the most necessary icons and leave others on the 
hard disk (if you have one) where space is not as critical. Ordinarily, you 
would want to boot from the hard disk, but there may be times when you can't, 
or you may not have one. (If you don't have one, we highly recommend it. 
Neither the PC nor the Mac works at its best without a hard disk.) 

For more information about the System Folder and the Mac System files, see 
Chapter Four. 

THE FINDER MENUS 
You interact with Mac menus using the mouse, as you learned in Chapter Two. 
Each menu has a title and a list of options under the title. Mac menus are 
organized according to the type of options they contain; for instance, the File 
menu always contains options that deal with file management and the Edit 
menu always contains options that deal with management of data. Some 
specific options are always available-for instance, the File menu will always 
contain a Save option. However, other options may be unique to a specific 
application. 

The Finder menus are divided by type. You will see either five or six Finder 
menus, depending on whether you have a system that supports color or not. 
These are: 
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• The Apple Menu (4i): Contains desk accessories. 

• The File Menu: Contains options for managing files and windows. 

• The Edit Menu: Contains options for cutting, copying, and pasting 
information. 

• The View Menu: Contains different options for displaying the con­
tents of disk and folder windows. 

• The Special Menu: Contains options for working with windows, for 
erasing files and folders, and for shutting down or restarting the Mac. 

• The Color Menu: Lets you color individual file and folder icons if you 
have a color system. 

Many of the options on the Finder menus have special keyboard equivalents 
that use the Command key (3€). You'll learn about each of these menus, their 
options, and their Command key equivalents in the sections that follow. 

The Apple Menu 

File 
About the Finder ... 

Camera 
Chooser 
Control Panel 
Find File 
Key Caps 

Figure 3·8. The Apple menu 

The Apple menu is the first menu on the Finder menu bar. The Apple menu is a 
very special menu, and is used to contain what are called Desk Accessories 
(DAs). You'll learn more about DAs in the next chapter, but there is one DA 
under the Apple menu that you should know about. It is called About the 
Finder ... (Notice that it ends with an ellipsis, meaning that selecting it will dis­
play a dialog box.) 

The About the Finder DA performs some of the functions of two DOS 
commands: VER and CHKDSK: 
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• Like VER, About the Finder returns the current version numbers for 
the System and Finder files. Apple has periodically upgraded the 
operating system-including the Finder-sometimes adding new 
features or improving existing ones. Because the newer systems are 
more up-to-date and more powerful, it is a good idea to know what 
version you have. At the time of this writing, the current Finder is 
version 6.0. The current System file version is 6.03. 

• Like CHKDSK, About the Finder displays how much RAM is in the 
system as well has how it is being used. If you are using MultiFinder 
(Apple's multitasking version of the Finder), About the Finder will 
display how much memory is being used by each application currently 
loaded in memory as well as how much is available in the largest con­
tiguous block. The other functions of CHKDSK are duplicated at the 
top of the Finder window displays. For more information about these 
functions, see the discussion of the View menu later in this chapter. 
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Figure 3·9. About the Finder in MultiFinder 
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One significant difference between About the Finder and the equivalent DOS 
commands is, because the Apple menu is almost always available even when 
running another program, that information is always available. On the PC, 
CHKDSK and VER are only available from the DOS prompt and even then they 
don't show as much information as About the Finder can. 

About the Finder is actually just one example of what Mac users call an "About 
box." Every Mac application has an About box that is located as a desk 
accessory at the top of the Apple menu. About boxes range from simple 
copyright statements to elaborate presentations of credits similar to movie 
credits. Some About boxes contain on-disk manuals or an application's on-line 
help system. 

The File Menu 
The File menu contains commands used to manage files and folders. These 
include New Folder, Open, Close, Print, etc. 

New Folder XN 
Open XO 
t>rin t 
Close XW 

1;,•~ t Priuih~~~·~s ~;(,(> 

Get Info XI 
0 up H t; <t1 <~ ~;(, 0 
(>u t HUHUJ 

Page Setup ••• 
Print Directory ... 

1: (~( t 

Figure 3-10. The File menu 

New Folder. When you want to create a new directory on the PC, you use the 
MKDIR or MD command from the DOS prompt, then enter the complete 
PATH and name of the directory to create. 
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As we mentioned earlier in this chapter, you perform the same task on the Mac 
by choosing New Folder (Command-N). Use this option whenever you want to 
create a new, empty, untitled folder at the current folder level. Immediately 
after you create the folder, you can begin to type a name for it. The insertion 
point, even though it doesn't appear, is active on the name portion of the new 
folder and the entire name is highlighted. Therefore, the first normal key you 
strike will replace the words Empty Folder. In fact, whenever you highlight an 
icon, you can type a new name for it. If you type the same name as a file or 
folder at the same level of the hierarchy, you will receive a warning and the 
procedure will be aborted. 

n OK D 

Thot nome is olreody token. Pleose use 
o different nome. 

Figure 3-11. Duplicate name alert box 

As you can see, there is no RENAME command on the Mac, but any object may 
be renamed easily-even disks. 

If you want to alter the name of any file, folder or disk, you can select its icon, 
then type a new name. To edit the name, click once on the icon to select it, then 
place the mouse pointer over the text so that it becomes an 1-beam. Select the 
spot where you want to edit and click. You can also click and drag to select 
several letters, then start typing to replace them all at once. Or, double-click to 
select a word at a time. If you double-dick to select a word, then drag the 
mouse, you will continue selecting adjacent words. 

If a file or disk is locked (see Get Info), the mouse pointer will not change to an 
1-beam when you place it over the name of its icon. 

Open. The Open (Command-O) menu item opens disk and folder windows, 
and launches a selected application or document-depending on the type of 
icon currently selected. This command actually duplicates several PC 
commands. If you use Open on a: 

• File Icon: You launch (load) that file. If it is a document icon, you load the 
program that created it and the document itself. If it is a program icon, you 
simply load the program. This Open is equivalent to typing the name of an 
executable file (.exe, .com, .bat) at the command line. 
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• Folder Icon: You open the window of the selected folder, making that 
folder active. This is pretty much the same as using the DOS CHOIR com­
mand to change directories and then typing DIR to display the directory's 
contents. 

• Disk Icon: You open the disk's window. In effect, this is the same as typing 
the disk name at the DOS prompt and then typing DIR to view the root 
level directory. 

Print. The DOS PRINT command is used sparingly by most PC users. Most 
printing is performed from within programs running on the PC. The same is · 
true of the Finder Print option which is found on the File menu. Virtually all 
printing tasks are performed from within applications. The Print command at 
the Finder level is a unique case of the more general Print option found in 
almost all applications. (For more information about the application level Print 
option, see Universal Menu Items later in this chapter.) 

In DOS, the PRINT command is nothing more than a binary dump to an I/0 
device. What this means is that PRINT is only useful with files already 
formatted for your printer. It is generally easier to print directly from within a 
program. However, one advantage of the PRINT command is that you can 
print multiple files by sending them to the DOS print queue. For instance, you 
could issue the command PRINT Filenamel.ext Filename2.ext Filename3.ext 
to print three files: Filenamel, Filename2, and Filename3. You can also use 
wildcards with PRINT (i.e. PRINT temp*.doc to print all files that begin with 
temp and end with .doc). 

The Finder Print option does almost the same thing as the DOS PRINT 
command, but, as usual, it uses different methods to get the job done. To print 
from the Finder, you must select one or more document icons and select Print 
from the File menu. The Mac will then attempt to launch the document's 
Creator application, then load and print each document one at a time. In this 
way, the Finder Print acts like the DOS print queue, but it performs its printing 
tasks from within the application. 

Ordinarily, when you print on a Mac, you will see a dialog box that lets you set 
options for the current print job (see Universal Menu Items later in this chapter 
for more about the standard print dialog). However, when you print from the 
Finder, you will not see the dialog box; you will not have an opportunity to set 
print options; and one copy of each selected document will print. 

On the PC, to print a file from DOS, the file must be formatted with special 
printer information. Most ordinary document files for programs like word 
processors, databases, and spreadsheets (to name a few) are not formatted to 
print. You can select the 1/0 port to print to (and a printer number if 
applicable), and you can affect the print quality a little by using the MODE 
command to set normal or compressed print. Otherwise, you have little control 
over the results of the PRINT command. 
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On the Mac, however, you need no special file to print from the Finder since 
the Mac will use the file's own application to invoke the actual printing. 
However, the document will print just as it was last saved. Also, you won't be 
able to choose a printer or 1/0 port at the time you print, though you can use 
the Chooser prior to printing to set the printer to use. (For more information 
about the Chooser and other print options, see Chapter Four.) 

Although the Finder Print option is a standard part of the Mac interface, not all 
applications allow you to print documents from the Finder. There are various 
reasons why certain applications don't support Finder Print, but they vary. The 
best way to find out if an application supports the Finder Print option is to try 
it. Select one of its document icons and then select Print from the File menu. 

Close. Close (Command-W) closes the currently selected window. It emulates 
the action of the close box, which was introduced in Chapter Two. 

As you can see, there are three ways to close a window on the Finder-from the 
close box, from the File menu, and from the keyboard (Command-W). 

Where Open has several meanings, depending on the selected icon, Close 
performs only one task-to close a window. Close does not have an equivalent 
DOS command. 

Get Info. Get Info (Command-1) can serve several functions. It tells you the 
name of the selected icon, what kind of icon it is, how big it is and how much 
actual disk space it consumes if it is a file, and how many bytes of files it 
contains if it is a folder. If you check Get Info for a disk icon, it shows how 
many files are on the disk and how much space they consume. 
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Info 

JnJ Ex•mp~o 2 

Looked D 

Kind : WriteNow docum•nt 
Size : 6 1832 by t•s used 1 11< on disk 

Vhere: HARD DISK, •xt•rnal hard disk 
drive 

Cre~ted: Tu•, Sep 30 1 1986, 9 :54 AM 
Modified: Thu 1 F•b 5 1 1987 1 5 :24 PM 
Version: not availabl• 

Figure 3·12. Get Info screen (file) 

Get Info also shows you where the selected icon is located (what d rive), when it 
was created, and when it was last modified. A text box allows you to enter 
notes about the icon which may help you identify it further. 

Get Info also allows you to lock a file. A locked file cannot be altered (though it 
may be read). 

Get Info performs some functions of DIR. Specifically, it indicates the name and 
size of a file as well as its date of last modification. However, you' ll notice that 
it does somewhat more. It also performs some of the function of A ITRIB for 
setting or removing read-only status (AITRIB +R Filename or AITRIB -R 
Filename). A ITRIB also sets other parameters such as hidden or visible; how­
ever, Get Info does not duplicate these other functions. On the other hand, 
some of the other Get Info features are not available on the PC. 

For instance, Get Info also serves a special purpose under MultiFinder. It lets 
you choose the amount of memory that an application will use. On the PC, you 
will rarely, if ever, have the opportunity to change the amount of memory a 
program uses. For more information about this Mac technique, see the section 
on Using MultiFinder at the end in this chapter. 
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Duplicate. When you want to create a duplicate file on the PC, you simply use 
the COPY command and give the copy a new name, or copy the file to another 
directory. Duplicating a directory is also possible with XCOPY, though with 
some limitations. 

On the Mac, the equivalent of COPY is to drag an icon from one place to 
another, but in many cases this results in a new position for the same file, not 
two distinct files. Therefore, a special command is needed to create copies 
easily. 

Duplicate (Command-D) is used to make a copy of a file or folder. The 
resulting copy will be named Copy of <Filename>. For instance, duplicating 
the System Folder would create a folder called Copy of System Folder con­
taining copies of all the files in the original System Folder. Also remember, you 
can duplicate an item by moving it to another folder while holding down the 
Option key. 

Put Away. You can move an item onto the desktop, outside of any window. It 
is technically still connected with its original disk, but it will display outside 
the window. You might do this, for instance, when you want to move an icon 
from one position in the window, to another that requires scrolling a long dis­
tance. By placing the icon outside the window, you can scroll to the new 
location, then drag the icon back into the window to its new place. 

On the other hand, if you want to replace an icon that is currently on the 
desktop outside any windows, select Put Away from the File menu. Put Away 
will put any icon on the desktop back to its original location. 

Page Setup. The Page Setup option displays a standard dialog box used to 
select default standards for your printer. These standards vary with the kind of 
printer you are using. For the ImageWriter, they allow you to set the size of 
paper, the orientation of the print, and certain special effects. 

lmogeWriter 

Poper: @ US Letter 
0 US Legol 
0 Computer Poper 

Orientotion Speciol Effects: 

II raJ 
Figure 3·13. lmageWriter Setup 

0 R4 Letter 
v2.6 ~~( .. o .. K---t,~JJ 
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D Toll Adjusted 
D 50 '7. Reduction 
D No 6ops Between Poges 
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For the LaserWriter, Page Setup controls the orientation of the page as well as 
offering options for faster printing, smoothing of images, and reduction 
percentages. 

,;;;,L,;,os;..;e;.;.r,;;;;W~r.;.;lt.;.e,;..r ,;.,P .;;.:ogi:.e~Se;.,;t.;.,u,;,;,p ____ ~,.....--=-=-=-=s=.2a-- n OK )J 
Paper: ® US Letter 0 H4 Letter 0 Tabloid 

0 US Legal 0 85 Letter ( Clmcel ) 

Reduce or l111nll"1· 
Enlorge: 

Orlentotlon 

-~ 
Figure 3·14. LaserWriter Setup 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 
181Grophlcs Smoothing? 
181 Foster Bltmop Printing? 

(Options) 

Help 

There is no exact equivalent for Page Setup in DOS. Although you can use the 
MODE command to set normal or compressed print, you can't change the 
orientation, paper size, or other details that the Page Setup allows. Some 
programs running on the PC may have their own settings to duplicate those of 
the Page Setup. 

Print Directory. Print Directory (which was called Print Catalog in older 
systems) will print an image of the current Finder window to the currently 
selected printer. This image will vary according to the kind of view the window 
is currently displaying. (For more information about Finder window views, see 
the discussion of the View menu later in this chapter.) 

This directory printout is equivalent to redirecting screen output to your 
printer and then using the DIR command to send a directory listing to the 
printer. The difference is that the Mac printout may list files in different sort 
orders or it may print an image of the icons visible in the current window. Print 
Directory always prints what the current Finder window displays. 

When you select Print Directory, a standard printer dialog box will appear. The 
standard printer dialog boxes contain various options, including how many 
copies to make, beginning and ending page numbers, and so on. You'll learn 
more about the standard printer dialog boxes in Universal Menu Items later in 
this chapter. 

Eject. You can simply take a PC floppy disk out of a drive any time you want, 
except when it is busy (the red light is on). However, there is no convenient or 
proper way to remove a floppy disk from a Mac drive without using some 
form of the Eject command. 
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Eject (Command-E) will eject a currently selected floppy drive. However, if the 
floppy disk that has been ejected contains the current System, it will have to be 
reinserted. 

Because the System is frequently in use, removing a floppy disk with an active 
System may mean that you will have to switch disks frequently. If you boot 
from a hard disk, you will not have that problem. 

On the PC, you would run into similar problems if you booted from a floppy 
disk and it expected to find Command.com on a disk you had removed. 

MACHINT: There are other ways to eject floppy disks. You can press 
Command-Shift-1 to eject a disk from the first floppy drive (usually the internal 
drive). You can press Command-Shift-2 to eject a disk from a second floppy 
drive. Preferably, you can drag the disk icon into the trash. This is usually the 
best method because otherwise, the Mac remembers that you had the disk 
installed, and you may have to reinsert it later, even though you are finished 
with it. Therefore, drag the disk icon into the trash to eject a disk you are 
finished with. 

The Edit Menu 
The Edit menu is another standard menu, and many of its options are found 
universally within Mac applications. The standard Finder options are Undo, 
Cut, Copy, Paste, Clear, Select All, and Show Clipboard. 

Unt1o 

r: ut ~)('I{ 

Copy XC 
Pt~s1 <~ ))(c lJ 
r: h~nr 
Select Rll XR 

Show Clipboard 

Figure 3·15. The Edit menu 

THE CLIPBOARD. Before discussing the Edit menu, it is important to introduce 
the Mac Clipboard. The Clipboard is a special area of the Mac's memory set 
aside to hold material that has been cut or copied. The Clipboard can hold 
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graphics as well as text. What makes the Clipboard unique is its ability to 
accept almost anything the screen can display, and to do so in standard data 
formats. So you can move data from one application to another with incredible 
ease. 

Since it is an independent part of the Mac operating system, the Clipboard is 
always functional. The Clipboard is automatically used when you cut, copy, or 
paste selected text or graphics. 

Whatever you may feel about the Mac, whether you are wild about it or think it 
belongs in a slag heap, you have to love the Clipboard. This is a feature that 
simply doesn't exist on the PC, and it should. The Clipboard has a myriad of 
uses ranging from the simplest cut and paste operations to combining graphics 
with text, merging graphic images from different sources, and saving 
frequently used graphic or text templates to the Scrapbook (which you'll learn 
about in Chapter Four). The Clipboard makes it an easy matter to cut several 
records from a database, or several cells from a spreadsheet, and paste them 
into a word processor with only a few mouse moves. You'll probably become 
hooked on the Clipboard's convenience sooner or later. If one thing could 
dampen your enthusiasm for the PC, the Clipboard is probably that thing (with 
the possible exception of MultiFinder, but we'll get to that later). 

There is only one Clipboard. Therefore, each time you cut or copy information 
to the Clipboard, it replaces what was there before. On the other hand, you can 
paste the information from the Clipboard as many times as you need to--even 
if you have changed applications since performing the last Clipboard 
operation. 

Usually, the contents of the Clipboard are kept in memory, but if you cut or 
copy something that requires a lot of memory, it is saved to a special System 
file in the System Folder called (no surprise here) the Clipboard File. 

The contents of the Clipboard are erased when you shut down the Mac, but, 
otherwise remain available during a session. 

EDIT MENU OPTIONS. 

Undo. There is no built-in undo function in DOS, and there isn't one at the 
Finder level of the Mac 0/S. However, Undo (Command-Z) is the first option 
on the Edit menu, and it is a useful option within a variety of programs on the 
Mac. (In some products, the tilde key (-) functions as Undo, also.) 

Undo is largely ignored at the Finder level where it serves little function other 
than to restore file or folder names in the case of inadvertant change or erasure. 
As useful as this may be, Undo is really most useful in applications where you 
may be able to undo an accidentally erased block of text or data or a mistake in 
a paint, draw, or CAD program. 
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Cut. Cut (Command-X) is used to remove text or graphics from the screen, 
placing it in the Clipboard. Although Cut will work with graphics in programs 
that can create and manipulate graphics (paint programs, word processors, 
desktop publishing systems), it does little on the Finder. It can be used to Cut 
icon names to the Clipboard, but there is really little reason to do so. 

Copy. Copy on the Mac has no relation whatsoever to the DOS COPY com­
mand which copies files. Copy (Command-C) creates a copied image of any 
selected text or graphics and places the image in the Clipboard. Copy does not 
alter the original text or graphics. Like Cut, Copy offers little utility from the 
Finder level, but is widely used within applications. 

Paste. Paste (Command-V) is used to move the contents of the Clipboard to the 
insertion point. Of course, if you attempt to Paste a graphic into a document or 
field that can only accept text, you will accomplish nothing. Like Cut and Copy, 
Paste doesn't see too much action at the Finder level, but is used extensively 
within many applications. 

Clear. Clear is used to cut material, but not put it in the Clipboard. Clear is 
often used to remove information that has been placed in a text box within a 
dialog box or other field-oriented application. 

Select All. Select All (Command-A) can be used to highlight all objects in a 
current window or document. It is the functional equivalent, at least in some 
ways, of using the PC wildcards *.* to indicate all the files in a directory. Of 
course, Select All will select files and folders. 

As we said in Chapter Two, this command can be used if you wish to select all 
the icons in the current window. You might also use Select All when you wish 
to select almost all the objects in a window. You can then Shift-click those you 
don't want, to deselect them before performing the intended task. 

~D~ Clipboard ~0§ 

~ 

Figure 3-16. Show Clipboard with graphic 
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Show Clipboard. Show Clipboard cfoes just what its name implies. If you are 
wondering what you last cut or copied-text or graphics-select Show 
Clipboard to open a Clipboard window that behaves just like any other Mac 
window. However, you can't alter the contents of the Clipboard within that 
window; you can only observe it. The Clipboard window is dynamic to the 
extent that its contents will change immediately if you cut or copy anything in 
another window while it is open. 

The View Menu 
The next standard Finder menu is the View menu. This menu allows you to 
alter the standard appearance of Finder windows. 

by Sm811 I con 
Y"'by Icon 

by N8me 
by 08te 
by Size 
by Kind 

Figure 3·17. The View menu 

Even though the Mac is associated with the graphical interface, the View menu 
allows you to list files and folders within any window sorted by name, date, 
size, or kind-or color on a color system. You can also use small icons, allowing 
you to see a miniaturized image of the graphical interface. 

The information displayed in the window varies with the different views. As 
you will see in the following sections, some of the information duplicates 
information you can obtain by using DOS commands like DIR, SORT, and 
CHKDSK. 
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BY ICONS. 

By Small Icon: Choosing to display By Small leon for any window allows you 
to see many more files in the same space. The icon graphics are still present, but 
they are very small. 

0 System Stuff 0 
35 items 12,449K in disk 6,571 K available 

5! Scrapbook Fil~ ~Word Settings • A Dictionary lQ 
~ Backgrounde~ New Scrapbook File 91mageSaver rtl MacSpell+lH 

ri!IDA Handler LJChoos.r stuff LJ Fonts /D As ~Wor.ds 

~Key Layout LJLaser Spool stuff~ O&D Note Pad IJ Resume Exce 1 

~ Clipboard File D SLS Copy LaserWriter ~ Easy Access 

~ lmageWriter DsLS Alerts II SuperLaserSpool ~Finder 

15! Find~r Startup ~Switcher 5 .1 ~Laser Prep ::! LaserWdter 

~General I!!!!!! Keyboard 'lJ Mouse ~ MultiFinder 10 
~I I~ 121 

Figure 3·18. Small icon view 

In addition to the small icons themselves, which represent the files and folders 
in the current window, the By Small leon window also displays the number of 
items in the current window (like DIR), the amount of disk space used, and the 
amount of disk space remaining (like CHKDSK). 

By Icon: By Icon is the normal Mac display that utilizes the full-sized icons. In 
addition to the icons themselves, the By Icon window also displays the same 
disk-related information as the By Small leon window does. 
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Figure 3-19. Icon view 

IN A SORT ORDER. The following five View menu options all display 
information very similar to the information you see when you type the DIR 
command from DOS. These views are text listings, but each displays the 
contents of the current window in a specific sort order. 

On the PC, when you use the DIR command, you can also add special 
"switches" like /p or /w for page at a time or wide display. The Mac handles 
these text listings in its usual fashion-by fitting what it can in the current 
window and using scroll bars to let you see the rest at your leisure. Unlike DOS 
directory listings, you can scroll backward and forward to view the contents of 
your disks and directories, and you can, of course, view several listings on the 
same screen, each in its own window. 

Each of these five views displays the same information about each file: 

• A miniature generic icon that indicates whether it is an application, 
a document, or a folder 

• The file or folder name 

• Its size (for files only) 
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• The type of file it is. For instance, a dBASE® Mac® document would 
state, dBASE Mac Project; a folder simply states, folder 

• The date and time the file was last modified 

In contrast, a PC directory listing shows the file name and extension, the size of 
the file, and the date and time it was last modified. You can tell all the same 
information from the DOS listing, with the possible exception of the specific file 
type. However, the filename extensions tell you a lot about the kind of file you 
are viewing. 

None of the text views display the file and disk information displayed by the 
By Icon and By Small Icon views. Therefore, though these views duplicate most 
of the functions of the DOS DIR command, they do not duplicate any functions 
of the CHKDSK command nor do they count the files in the current window 
(which the DOS directory listing does do for the directory listed). 

The By Name listing, in particular, is similar to using the DIR command in 
combination with the SORT command. This will work with versions of DOS 
that accept Pipes. For instance, to sort by name, type DIR I SORT and press 
Return. To sort the directory by extension (similar to By Kind), type DIR I 
SORT /+10 and press Return. To sort by size, type, DIR I SORT /+14 and so 
forth. To display any of these listings a screen at a time, add I MORE to the 
end of the command (i.e. DIR I SORT I MORE). 

By Name. By Name orders the contents of a folder into a text listing sorted 
alphabetically by name. By Name displays a miniature icon; the file or folder 
name; its size; the kind of object it is (applications, folder, dBASE Mac, and so 
on); and the date and time it was last modified. 

0 -- S stem Stuff 

rllin1 Sizt Kind 

D A Dictionary 169K documtnt 

D Backgroundtr 5K Systtm documtnt 

Cl Choostr stuff foldtr 

D Clipbo~rd Filt OK SIJstfm documt nt 

D DA H~ndltr 6K documtnt 

D Easy llcctss 4K st~dup documtnt 

D Findtr 105K Systtm documtnt 

D Findtr st~rtup 1K Systtm documtnt 

Cl Fonts/DIIs foldtr 

D Fu11Writt Prtftrtncts 1K FW Thtnurus doc ... 

Figure 3-20. By Name window listing 

Last Modifitd 

Mon, Aug 25, 1986 2:19PM 

Sat, Apr 30, 1988 12 :00 PM 

Sat, Apr 25, 1987 6 :26 PM 

Fri , Dtc 30, 1988 1:55PM 

Fri , Aug26,1988 12 :00PM 

Tut , Apr 14, 1987 12 :00 PM 

Fri, Dtc 30, 1988 2 :00PM 

Thu, Dtc 15, 1988 3 :54PM 

Thu, Ftb 12, 1987 5 :50PM 

Tut, Nov 8, 1988 
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By Date. By Date sorts the contents of a window by the last modified date. This 
is very useful since the most recently modified files are placed at the top of the 
list. Use this view, for instance, to manage your correspondence or other word 
processor tasks. Since the most recent documents will appear at the top of the 
list, they will be in order. You might also use the By Date view with projects 
that use different versions of files. The most recent versions will always be at 
the top of the list. 

,. • File Edit Ulew Speclol g) 

D o,.~ .... Documtnt 

D dB AS£ M~c Projtct 

<1fl dBASEMu 

1K M~cDI'~'*' documtnt F"ri, F" tb3, 1989 4 :03PM 

4K dBASE H~c documtntSun, J•n 29, 1989 2:36PM 

690K •pplic~tlon Sun, Stp 20,1997 9:49AM 

Figure 3·21 . By Date window listing 

., 

By Size. By Size shows you a listing of all applications and documents ordered 
from larger to smaller. Folders are automatically placed at the end of the By 
Size listing. 

By Kind. To see a listing of files and folders sorted by file type, use the By Kind 
listing. This can be handy if you have several different types of files in a single 
window and you want to see what files you have for HyperCard or FullWrite, 
for instance. Again, folders are placed at the end of the By Kind listing. 

By Color. On color systems, you can add another dimension of organization by 
assigning colors to different files and folders, then sorting the listing by color. 
In this way, you could assign different colors to regional documents or to dif­
ferent divisions in your company, making it easy to sort them by type using By 
Color. 
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MACHINT: Sometimes you can actually lose a file or folder when working 
with icons or small icons. You know the file is there, but you just can't spot it on 
the screen for some reason. This can easily happen on a large capacity hard 
disk with hundreds of files. One trick is to change the view to By Name, find 
the file, select it (by clicking on it), then change back to By Icon. The file will re­
main highlighted, and will stand out from the crowd. 

The Special Menu 
The Special menu is just that. It contains some useful and important Finder 
selections like Clean Up, Empty Trash, Erase Disk, Set Startup, Restart, and 
Shut Down. Most of these options duplicate familiar PC tasks. For instance, 
Empty Trash is step two of the Mac equivalent of ERASE or DEL (though with 
some differences as noted earlier in this chapter). Another example is Restart 
which duplicates the Ctrl-Alt-Del sequence used on the PC to warm boot the 
machine. And, as you'll see, most of the other Special menu options duplicate 
procedures you know on the PC. 

Spefial 

Clean Up Window 
E:mp tt.J ·r n~stt 
Erase Disk 
Set Startup ... 

Restart 
Shut Down 

Figure 3-22. The Special menu 

Clean Up. There is no DOS equivalent to the Clean Up option on the Special 
menu. Clean Up is used to physically reorganize icons within the current 
window. Since this is an inherently graphic operation, it has no counterpart in a 
text-based system like DOS. 

Clean Up is unusual in that it's name changes depending on the circumstances. 
For instance, if a window is open, but nothing is currently selected, the Clean 
Up command. actually reads Clean Up Window, and, if activated, it will 
reorganize the icons, placing them on an invisible grid. Any icons not on that 
grid will be moved to another location. 

If there is one or more icon selected, Clean Up reads Clean Up Selection, and 
it will only rearrange the currently selected icons. This is useful for moving one 
or just a few icons to new locations without completely reorganizing the 
desktop. For instance, you may actually prefer to place some icons outside the 
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grid for the sake of convenience. Choosing Clean Up Window will move those 
icons. But if only certain icons need to be reorganized, select them and choose 
Clean Up Selection. 

If you hold down the Option key, then open the Special window, the item reads 
simply, Clean Up, and selecting it will rearrange all the icons in the window 
starting in the upper left hand corner of the window and moving in horizontal 
rows. If you have a hopeless mess on your desktop, this might be a good way 
to go about rearranging it. Using this method periodically can also improve ef­
ficiency on a hard disk because it reorganizes the invisible Desktop file. 

~ 
~ 

Dictionary 

Figure 3·23. Before Clean Up 
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Figure 3·24. After Clean Up 

MACHINTS: You can use the Clean Up command to control the way the 
icons on your desktop appear. For instance, suppose you want to change 
from normal icons to small icons. As you saw earlier in this chapter, the 
small icons are spaced far apart. You can simply choose Clean Up 
Window, but the icons will be rearranged randomly. Holding down the 
Option key when you rearrange the small icons should result in an 
arrangement closer to the original one, but more tightly packed. 

Another trick allows you to create a window with all the icons arranged 
alphabetically. To do that, first change the view to By Name. Then Select 
All (Command-A) and drag the icons onto the desktop (outside all the 
windows). They will form a pile of icons, but will remain selected. Now 
drag the icons back into the original window and select by Icon (or by 
Small Icon). They will be arranged alphabetically, left to right in rows. 
The same technique can be used to arrange icons by size, date, or kind by 
choosing the appropriate view from the View menu. 

Tricks that involve dragging icons to the desktop may not be available 
when you are working with a network on a remote server. If you try to 
drag icons to the desktop on some networks, you will get an alert box 
message and the task will be aborted. 

Also remember, the Clean Up command works within the current window 
size, and organizes according to the window's width. Therefore, if you zoom a 
narrow window, the icons will display in a narrow column, leaving a lot of 
white space. If you zoom such a window, then choose Clean Up Window, the 

99 



Chapter Three 

icons will be rearranged to fill the zoomed window. However, remember that 
the window will not remain zoomed the next time you come to it, and many of 
the icons will be out of sight below and to the right of the normal window 
boundaries. (The Finder does not remember the zoom condition of a window, 
though it does remember its size and location.) To see the full view again, click 
the zoom box. 

Empty Trash. The next command on the Special menu is Empty Trash. This 
option will ordinarily be dimmed, but once you drag something into the 
trashcan icon, Empty Trash will become activated. With newer systems, the 
trash can will bulge. Any time there is something in the trash, you can select 
Empty Trash to purge it from the disk. Until you actually choose Empty Trash 
(or perform one of the other actions listed earlier in this chapter), the files or 
folders that you placed in the trash may still be recovered by opening the 
trashcan window and dragging the files back to one of the active folders. 

Completely erase disk named 
Full I mpact™ (internal 

driue)? 

n Cancel B (One-Sided) (Two-Sided) 

Figure 3·25. Erase Disk dialog box 

Erase Disk. Erase Disk will re-initialize a selected disk, erasing all files from it. 
For more information, see the section Initializing and Formatting Disks and 
Creating System Disks earlier in this chapter. 

Set Startup. The Set Startup option duplicates some functions of the DOS 
Autoexec.bat, but it is not as versatile. Essentially, you can use Set Startup to 
predetermine the application the Mac will use when it first boots up, or you can 
tell it to reopen the current set of open applications the next time you boot. 
Choosing Set Startup reveals a dialog box on which you can set the s tartup 
application. 
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Figure 3-26. Set Startup dialog box 

You have three choices on startup: 

• Start with either Finder or Multifinder active. 

• Start with a chosen application loaded. 

• Start with all currently opened applications and desk accessories. 

If no application (or document associated with an application) is currently se­
lected or operating, then you will only be able to select between Finder and 
MultiFinder startups. If you select an application or document before selecting 
Set Startup, you will be able to select that application as the startup application. 
If you have one or more applications or DAs running when you select Set 
Startup, you can instruct the Mac to reopen them the next time it boots. 
Normally, either the Finder or the MultiFinder is the startup application. 
Whenever you change the startup application, you must reboot for it to take 
effect. 

Restart. Restart is the equivalent of the Ctrl-Alt-Del key sequence for rebooting 
the PC. However, because of the differences between the two operating 
systems, the Mac performs several specific tasks before rebooting. For instance, 
before rebooting, the Mac checks to make sure all applications are closed and 
all modified documents have been saved. If not, you will see a dialog box for 
each application and document asking you what you want to do. In addition, 
the Mac empties any current trash, saves the desktop information, then ejects 
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all floppy disks. The beep sounds, and the computer starts the boot up 
procedure over again. 

Restart is often used when you have changed a system parameter (like the 
startup application) and you want the new parameters to take effect 
immediately. 

Shut Down. In most cases, you can shut off a PC any time without losing data 
as long as you have saved all work in progress. On the Mac, however, you 
must use the Shut Down command so that the Desktop file will be updated. 

If you do not shut down properly, you may risk corrupting or losing files, 
although the Mac will usually rebuild the Desktop after an improper shut 
down or (heaven help us!) a system crash. It will take longer to boot up, 
however, if the Desktop file has to be rebuilt. 

Choosing Shut Down instructs the computer to perform the same steps it does 
when you choose Restart (check for open and modified documents, empty 
trash, save desktop, eject disks), but this time, it will not reboot immediately. 
On all Mac models (except the Mac II family of products), an alert box will 
display with a message, You may now switch off your Mac safely, and a 
button stating Restart. If you click the Restart button, the Mac will reboot. 
Otherwise, you may cut the power at that point. On a Mac II, instead of the 
alert box, the system simply turns off. 

The Color Menu 
The Color menu appears only on color systems like the Mac II series. Selecting 
this menu displays eight color bars. You can use this to colorize any selected 
folder or file icons. Color is useful for making some icons stand out and also for 
sorting the contents of a window By Color. (See the section on the View menu 
earlier in this chapter.) 

UNIVERSAL MENU ITEMS 
Each application usually has its own menu structure. However, most Mac 
applications use certain standard menus. All of them feature the Apple menu 
(which is discussed in Chapter Four). In addition, most Mac applications 
include the File menu and the Edit menu. Other menus may vary greatly from 
application to application. 

Although the Edit menu items are almost always the same items found on the 
Finder Edit menu, they are often more useful inside an application. The 
common File menu items, however, differ from those found at the Finder level. 
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Common File Menu Options 
Virtually all Mac applications include the same File menu options. The 
Command key equivalents given are most common choices, though a few 
applications don't use them or use them for other tasks: 

• New (Command-N). To create a new document file. 

• Open (Command-O). To load a document file from disk. 

• Close (Command-W). To close the current document window. 

If you try to Close a document that has been modified, the Mac will 
warn you (see the note under Save below). 

• Save (Command-S). To save a file. 

The first time you select Save from the File menu, you'll see a dialog 
box that lets you name the file. You can change the active folder or disk 
before completing the Save action. 

Edit Goodies Windows 

leo::::::~ HARD DISK I 

Cl Ch3 Illustrations 
Cl dBASE M8c 1.0 
Cl EKcel 1.5 
Cl FuiiPolnt 
Cl FuiiWrlte 
Cl Gray Matter 

Figure 3·27. Save File dialog box 

~ co::::::~ HARD DISK 

Driue 

Saue 

Cancel 

NOTE: A Mac application will generally not let you quit or close the 
document without saving any work in progress. 

., 
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If you quit an application without saving any files you have created or 
modified during the current session, the Mac will display another 
dialog box that asks you if you want to save the file. You can answer 
Yes to save the file, No to quit without saving, or Cancel to return to 
the application. 

S8ue th8nges before closing? 

n Yes D 
(- No ) ( C8ncel ) 

Figure 3·28. Save File alert box 

• Save As. To save a file under a different name. 

Save As saves the current document in memory under a new name 
without affecting the original file, which still retains its name. Save As 
lets you work with multiple versions of a file or use another file as a 
template. By loading a file, then using Save As to save it to a new 
name, you can use the original file as a starting point. 

In a way, Save As is the DOS equivalent of using COPY to create a 
duplicate of a file with a new name. The difference is that it works 
from within an application and is always available to make 
incremental versions of the same work. 

• Page Setup. The same as the Finder menu option. 

• Print (Command-P). To print the current document. 

When you select Print from an application's file menu, you will see the 
Print dialog box. The dialog box you will see depends on the current 
printer assignment (see Chooser in Chapter Four). 
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lm8geWriter 
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Copies: D 
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Figure 3-29. lmageWriter printer dialog box 

LoserWriter "LoserWriter II NTH" 5.2 n OK D 
Copies:IIMI Poges: ® Rll 0 From: D To: D ( Concel ) 

Couer Poge: @No 0 First Poge 0 Lost Poge ( Help ) 

Poper Source: ® Poper Cossette 0 Monuol Feed 

Figure 3-30. LaserWriter printer dialog box 

The standard printer dialog box lets you choose the number of copies 
to make and the range of pages to print. Other options depend on the 
type of printer currently chosen. Figures 3-29 and 3-30 show the 
standard ImageWriter and LaserWriter printer dialog boxes. 

Even though the printer dialog box is a standard Mac feature, 
application developers can customize the dialog box to incorporate 
special features for their printing needs. For instance, many 
applications will print collated documents. 

• Quit. To close the application and return to the Finder. 

If you try to quit an application with any modified documents still 
open, you will see a dialog box as described in the Note under Save. 

By learning the most common Finder and application menu options, you have 
learned how to do many common Mac operations. Some of these operations are 
similar to the DOS commands we have mentioned, while others may vary 
greatly from one PC program to another. For instance, quitting an application, 
and saving files are two common operations for which there is no standard 
method on the PC. Each program uses its own commands and methods. 
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ABOUT MULTIFINDER 
The Finder is the closest Mac equivalent to the collection of commands that 
make up the DOS command interface. However, the Finder has a cousin, 
virtually identical, but different in one major respect-it is a multitasking system. 
It allows you to run more than one application at the same time, switching as 
easily between applications as you would between disk and folder windows on 
the Finder. In the following section, you'll learn about the Finder's 
cousin-MultiFinder. 

Although the Clipboard may possibly be the feature that you most appreciate 
about the Mac, it may be MultiFinder that really gets to you. That's because, 
though it isn't perfect or complete, MultiFinder is practical, useful 
multitasking-something that DOS simply doesn't have by itself, and 
something that even the best of the multitasking programs like DESQview and 
Windows can't offer without limitations, reservations, and incompatibilities. 

MultiFinder is a part of the Mac operating system and, as such, is supported by 
almost all Macintosh programs. While MultiFinder shares many features with 
the Finder, it also allows multiple applications to run concurrently and even 
allows a degree of foreground and background tasking (meaning that an 
application may continue to process information while you work actively with 
another one). 

Before looking more closely at MultiFinder, look at the issues that face both the 
PC and the Mac when trying to create a multitasking solution. 

106 



The Operating System-Commands and the Finder 

The PC Multitasking Dilemma 
On the PC, you can create a multitasking environment. You can use programs 
like Windows and DESQview or you can use the new operating system, 05/2. 
In each of these cases, you need a powerful, fast PC with lots of extra memory. 

Multitasking on a PC began long before the advent of MultiFinder. Early 
attempts, like Topview and APX Core, partitioned the conventional PC 
memory (up to 640K) into separate segments. These were never completely 
acceptable solutions due to memory limitations and a basic awkwardness of 
design. Even recent programs, like Microsoft Windows and DESQview, (so­
phisticated, powerful programs that have many users), do not fit into most PC 
users' systems. 

Part of the problem is that most people do not have machines powerful enough 
to take full advantage of these newer multitasking systems. Also, these pro­
grams still have to contend with the limited amount of memory that the PC can 
address directly; every solution uses some of that precious memory. Newer 
systems, particularly those with the 80386 chip, like the IBM PS/2 Model 80 
and the Compaq 386 Deskpro, are capable of much more than their 
predecessors. 

Despite advances in technology, DOS is still not a multitasking operating 
system. In contrast, OS/ 2 is designed to be a multitasking operating system, 
and its future development will provide new capabilities for the PC. Current 
implementations of OS/ 2 are able to run several programs at the same time, 
both in the background and the foreground, though there are, as yet, only a 
limited number of programs available for OS/ 2. And OS/2 requires a lot of 
memory, as well as a PC with one of the more advanced chips. 

On the other hand, MultiFinder works today on just about any Mac. Why is 
MultiFinder already here when PC multitasking is still difficult and expensive 
to implement? 

MultiFinder is the beneficiary of several Mac features: 

• The earlier Mac Systems (the Mac Plus and SE) can directly address 
any amount of RAM up to 4 megabytes. This limitation was made be­
cause the ROM programs started at the 4-megabyte location. 

Because all RAM is considered equal on a Mac, the operating system 
can dynamically allocate whatever amount of memory is needed by 
each application you run. 

• The graphic interface-windows in particular-allow an easy platform 
upon which to run multiple applications. 

• The Clipboard makes data sharing easy and practical. 
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None of these Mac advantages are shared by PC systems. There is no DOS 
metaphor that makes multitasking easy, nor is there any universal data format 
and exchange medium like the Clipboard. And, most importantly, memory 
usage is limited and difficult on 005 systems. 

There is a definite, on-going convergence of style and approach between the PC 
and the Mac and the graphical interface is becoming more and more the norm. 
OS/2 is heading toward the graphical interface, and the emergence of the 
Presentation Manager does offer hope to PC users who would prefer a more 
Mac-like approach. 

The newer versions of 005 4.0 supply a semi-graphical interface very similar 
in appearance to the Microsoft Windows. DOS 4.0 still limits the user to 640K 
partitions, however, while the available memory for running programs is 
whittled away by the graphical menu. 

Multitasking on the Mac 
Unlike the PC, to create a multitasking environment on the Mac, you don't 
really need a powerful, fast, expensive system. You need-a Mac. Although 
MultiFinder works best on a Mac with more than the (current) standard of 1 
megabyte of RAM , no extra hardware or software is needed. 

During normal operations using the Mac, it is necessary to return to the Finder 
whenever you quit an application. Each time you do so, the invisible Desktop 
file is loaded, and the Finder is rebuilt. On slower systems using slow drives, 
this can take some time. 

Suppose you are working on a document in your word processor, and you 
need to check some information that is stored in your database. In ordinary 
circumstances, you would have to quit the word processor (saving any current 
documents, of course), return to the Finder, load the database, and check the 
information (perhaps copying it to the Clipboard). Next you would quit, and, if 
necessary, save the database, return to the Finder, then load the word processor 
and its files again. If you had copied information from the database to the 
Clipboard, you would now paste it where you needed it. There must be an 
easier way! 

Suppose that, by clicking the mouse one time you could be in your database. 
By clicking once more, you could return to the word processor with your 
documents still intact. That would be much better. 

The first multitasking system for Apple computers was called Switcher. 
Switcher allowed you to allocate different parts of memory to run more than 
one application at a time. Each application resided in memory simultaneously, 
but only one could be active at any one time. In many ways, Switcher was 
similar to the early PC attempts like Topview and APX Core. It partitioned 
memory and allowed you to switch from one partition to another. The main 
difference is that the Clipboard made data sharing fairly easy with Switcher, 
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but the lack of data standards limited the data sharing abilities of Topview and 
APXCore. 

Switcher proved to be a help to many people who needed to work with more 
than one program at once, but it was not particularly elegant and it wasn't 
always reliable with some programs. Furthermore, when Switcher first came 
out, Macs had, at most, 1 megabyte of memory while programs grew larger 
and larger. As the trend continued, it meant that fewer programs could reside 
at one time in Switcher memory. 

In 1987, Apple released MultiFinder, its first system with a multitasking operat­
ing system. It is a substantial improvement. First, it is part of the Mac system 
software, not a separate program. Second, it contains true multitasking 
elements that allow programs to work in the background. 

Also, MultiFinder is easier to use. With Switcher, you had to concern yourself 
with the amount of memory each application required, sometimes resetting the 
amount to minimum amounts which might make the program run poorly or 
become unstable. MultiFinder generally knows how much memory a program 
requires and allocates that amount. (There is a way to modify the amount of 
memory an application uses under MultiFinder, as you will see later.) 

Even though most applications do not actually continue to process in the 
background, their windows remain open when you move from one application 
to another. Therefore, simply clicking in a background window is sufficient to 
open that window and make the other application the active one. With the 
increasing availability of large-screen monitors and higher memory 
configurations, it is conceivable to have several applications all open on the 
screen at once. 

Suppose you work regularly with a word processor, a database, a spreadsheet, 
an accounting package, and telecommunications. With enough memory, you 
would be able to leave all those programs open at once, switching between 
them at will. For example, a telecommunications session could continue, or a 
spreadsheet could carry on a long calculation, while you work on another 
project. Cutting, copying, and pasting between applications is a snap, and you 
can still use your desk accessories, too! Such a system is entirely possible on 
today's Macintoshes. 
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Multitasking Differences 
There are three major differences between multitasking on the PC and on the 
Mac: 

• First, saving work in progress is automatic on the Mac. No Mac 
application will let you close a modified document, database or 
worksheet without prompting you to save it first. You can then decide 
to save it, not save it, or cancel the current operation. 

Saue changes before closing? 

Yes D 
( No ) ( Cancel ) 

Figure 3-31. Standard Mac Save dialog box 

• Second, returning to DOS is quicker than returning to the Finder since 
no desktop graphics have to be displayed. Also, some DOS 
applications allow you to exit to a DOS shell (a multiple copy of the 
Command.com run under the first copy). Although there can be some 
problems with trying to do too much in a DOS shell, it does represent 
an alternative to quitting the current application. The Mac has no 
equivalent of the DOS shell. 

• The third difference is, of course, the Clipboard. There is no built-in 
DOS method for extracting data from one application for immediate 
use in another, and, even if there were, there is no universal format 
that all PC programs can share. 

The parallel development of MultiFinder and OS/2 is being closely watched by 
industry analysts, and anticipation is high that both systems will eventually 
provide complete multitasking solutions. Presently, MultiFinder is a better 
established and more feasible solution. 

Of all the current DOS multitasking solutions, DESQview is emerging as the 
best. Using DESQview, you can emulate most of the functions of MultiFinder 
or OS/2 multitasking in a DOS environment, though cut and paste functions 
will not work as smoothly as they do on the Mac. The main limitation is the 
lack of uniformity among PC text and graphics formats. 
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USING MUL TIFINDER 
With MultiFinder, you can load more than one application at a time. The Mac 
automatically places each active application in its own window. 

r S File Edit 

Figure 3·32. Multiple applications in individual windows 

There are three ways to switch between multiple tasks: 

• Click in any inactive window to bring it to the front and make it active. 

• Open the Apple menu and select the application from the list that 
occurs after the desk accessories. 

• Click the MultiFinder icon at the upper right corner of the screen. 
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About DRs ... 

Camera 
Chooser 
Control Panel 
Find File 
Key Caps 

~ Finder 

~ FuiiPaint 

~ MacWrite 

About Multifinder ... 

Figure 3·33. Switching applications from the Apple menu 

Here are some tips for using MultiFinder most effectively: 

• Load either the largest or the most stable applications first. 

MultiFinder assigns memory to tasks as you open each new 
application. As you open and dose applications, memory is 
dynamically reallocated. However, your ability to load new programs 
into memory is dependent on how large a block of contiguous memory 
is available. If there isn't enough memory in one "block," you may not 
be able to load a particular file. Therefore, to be safe, load the 
application that requires the most memory first. 

That is one way to manage applications. Another way is to first load 
the most stable programs-the ones that you will want to remain in 
memory all the time. The programs that you may open and close often 
should be the last ones you load since they will probably be the first 
ones you'll close. 

• Manage your windows. 

Move and resize windows as needed to place windows in convenient 
locations. On a small screen, you may want to overlap the windows so 
that you can click the mouse on a visible edge to bring a hidden 
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window to the front. H you aren't careful, you'll bury your windows, 
making it harder to activate their applications. Remember, you can 
switch MultiFinder tasks by selecting from the Apple menu or by 
clicking on the MultiFinder icon in the upper right comer of the screen. 

• Increase the Application Memory Size. 

If an application does not seem to be performing correctly, or you are 
receiving out-of-memory messages, you may want to increase the 
amount of MultiFinder memory allocated to the product. To do so: 

Click the product's application icon once (not one of the document 
icons) to highlight it. Select Get Info (Command-I) from the File menu. 
You will see a dialog box that describes the current version. 

At the bottom of the dialog box, you will see the captions Suggested 
Memory Size (K): and Application Memory Size (K): with numbers 
printed next to each one. You'll notice that the number for Application 
Memory Size is enclosed in a standard Mac text box. You can change 
this value. 

If you change the value in the Application Memory Size box, then dose 
the Get Info dialog, MultiFinder will attempt to load the file using the 
amount of memory specified. 

WARNING: If you attempt to lower the Application Memory Size 
below the Suggested Memory Size, the program may run incorrectly. 
Also, making the Application Memory Size a higher value does not 
always guarantee improved performance, and may result in unneces­
sarily wasted memory. In addition, you must be sure you have 
enough memory available on your system to run an application using 
more memory. Don't forget that the System and Finder will require 
some of your available RAM. 

• Watch performance with background programs running. 

There are several programs that will run in the background while you 
continue to work in the foreground, but these programs may cause the 
performance of your foreground programs to suffer. Background 
tasking is very useful for telecommunications sessions, large spread­
sheet calculations, and other time consuming tasks. Just remember that 
the performance of other applications may be affected. 

MultiFinder is something new and unfamiliar to PC users. So is the 
Clipboard for that matter . The main point we would like to stress here 
is that both are very useful tools and can make your time on the Mac 
time well spent. 
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GOING FORWARD 
In this chapter, you learned about the Finder menus, some common application 
menu items, the Clipboard, and MultiFinder. With the information here and in 
previous chapters, you are well on your way to making effective use of the 
Mac. 

In the next chapter, you will see the final pieces of the puzzle that, together, 
form the whole Mac user interface. In particular, you will see what we call 
System Tools. Some of these tools, like DAs, have many uses, including taking 
the place of TSRs on the PC. Other tools, like the Chooser, perform operations 
that you also perform on the PC, but do so very differently. The Control Panel 
is a very important desk accessory, a powerful and highly useful System tool 
that parallels many PC functions and introduces a few new ones. 

When you complete Chapter Four, you will have learned enough about the 
Mac graphical interface to do just about anything you want. Throughout the 
rest of this book, you will learn about other aspects of the Mac-from software 
to hardware to resources. 
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Other System Utilities 
Chapter Two introduced many of the most important Mac techniques and 
concepts. Chapter Three presented the Finder and common application menus, 
the Clipboard, and MultiFinder. Both chapters dealt with basic information 
about the Macintosh operating system and graphical interface. However, there 
is one more piece to the puzzle that still needs to be filled in-System Tools. 

Some of the Macintosh System Tools correlate directly with DOS commands. 
Others are unique to the Mac. In addition, the Mac provides special kinds of 
System drivers called desk accessories (DAs). DAs serve many functions 
including setting system parameters and selecting printers and printer ports. 
However, the closest PC concept that approximates DAs is the Terminate and 
Stay Resident (TSR) utility. 

On the PC, TSRs are not a part of the operating system. In fact, the idea of the 
TSR didn't exist on PCs until the advent of Borland's Sidekick, which showed 
PC users and developers how to create a program that could sit in memory and 
wait for you to activate it-even from within another program. Until Sidekick, 
all work on the PC was done using one program at a time. TSRs opened a 
world of new opportunities for PC users. 

The Macintosh DA is not a technological development added after the fact. 
DAs are an integral part of the Macintosh operating system, and allow an extra 
level of operation similar to what TSRs add on the PC, but without inherent 
memory and compatiblity issues that plague TSRs. 

DAs are activated from the Apple menu. You have already encountered one 
DA in Chapter Three, "Commands and the Finder." In this chapter, you will 
learn about several other important DAs that come with the Macintosh system. 
These System DAs often duplicate the functions of one or more DOS 
commands. 
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In addition to DAs, there are several files associated with the Macintosh 
System. Most of these files are found in the System Folder. In this chapter, we 
will provide a short description of each of the files and icons that you will find 
in the System Folder. Though you will not interact with all of these icons, you 
may be curious about their functions and how they relate to DOS. 

In this chapter you'll learn about desk accessories and other system tools, in­
cluding the following: 

• Chooser 
• Control Panel 
• Find File 
• TeachText 
• Disk Firstaid 

The Macintosh system files are a collection of files that work together to make a 
consistent whole. In some ways, these system files fulfill many of the same 
functions as the DOS internal and external commands. In other ways, they are 
completely different. 

MAC SYSTEM ICONS: A BRIEF OVERVIEW 
The Macintosh system is actually made up of several different 
components-some in the hardware and the rest in software. 

The hardware portion of the Mac system is called the Toolbox or the ROM 
(Read-Only Memory) Operating System. The Toolbox determines the basic look 
and feel of the Macintosh. 

Unless you are a programmer, you probably won't be too concerned with the 
Toolbox or with ROM. In contrast, nothing in PC ROM suggests a style for 
menus, a form for screen images, or in any way helps with interface design. 

As we have indicated in earlier chapters, not only do the Macintosh ROMs 
suggest such form, they contain standard programming that is available to all 
developers, making the Macintosh interface consistent from one program to the 
next. These ROM routines are built into the Mac and don' t change often. 

The Toolbox and ROM portion of the Operating System is, in some ways, 
equivalent to the ROM routines built into the PC. However, the Mac ROM 
routines are more extensive, mapping out many of the features of the graphical 
interface presented in Chapters Two and Three (including window 
management, menus, and mouse handling, among others). The PC ROMs 
control basic I/0 functions and system-level operations, but don't affect the 
software interface the same way the Mac ROM routines do. 
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The software component of the Macintosh System is made up, primarily, of the 
System and the Finder files which are normally found in the System Folder. 
However, there are many other files that function as part of the operating 
system. These include the hidden Desktop file, MultiFinder, the printer drivers, 
the Clipboard File, and many more. 

In the following section, you will learn more about the functions of the System 
Folder files. 

00 System Folder 
The System Folder serves the important function of containing all the System 
files. Its closest PC equivalent might be the \DOS directory that many people 
create to contain all the DOS files; however the analogy is not complete. For 
instance, where the \DOS directory is used to collect all the DOS files in one 
directory, you can still work with those files regardless of their location. In 
addition, to implement DOS commands, you still have to type the command at 
the command line. 

The files in the System Folder, for the most part, are files that the -Macintosh 
uses without your intervention. They must be in the System Folder. What 
contact you do have with those files is generally through other parts of the 
Macintosh system. One good example is the Clipboard File. You never deal 
directly with the Clipboard File-the Mac does that automatically when you 
cut or copy a large block of text or graphics. Your involvement is to implement 
the appropriate procedure. The Mac then works directly with the appropriate 
files. 

You can recognize the System Folder, not only by its name, but by the small 
picture of a Mac that is on its folder icon. No other folder can display this icon. 

system folder 
Figure 4·1. System Folder icon 
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What makes it a System Folder? Any folder which contains both the System 
and the Finder files can be a system folder, regardless of its name (though it is 
standard practice to name it System Folder). When you boot the Mac, it will 
search for an appropriate system folder, first on the internal floppy disk, then 
on an internal hard disk, and finally on a hard disk attached to the SCSI port. 
You can set the Mac to look first on any attached hard disk and ignore the 
floppy drive. 

System Folder 
8 items 13,221 K in disk S ,798K aviilable 

System Finder Startup Easy Access Backgrounder 

Finder Clipboard File MultiFinder Scrapbook File 

Figure 4·2. The System Folder files 

The System folder is where the Macintosh operating system looks to find 
certain special files, including: 

• System, Finder, and MultiFinder 

• Printer resources 

• INITs and CDEVs (Control Panel Device files) 

• Startup sounds and pictures 

• Clipboard File and Scrapbook File 

Many applications also use the System Folder as a place to keep their specific 
settings files. For instance, many word processors and databases can be 
configured by the user to keep their global settings in the System Folder so the 
program will always be able to find them, even if the application is moved. 
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Figure 4·3. System illustration 

Like Command.com on a PC, a System file is essential to run a Mac. The 
System version determines the features of the operating system of the Mac, and 
is periodically updated. The most recent system version is 6.03. With each 
system release, Apple modifies the capabilities of the Mac. In the same way 
that DOS has increased its functions and power with its first release of DOS 
Version 1.00, and now progressing to DOS Version 4.xx, so has the Macintosh 
System evolved. 

As you read this chapter, you will learn more about the specific System Folder 
icons and their functions. The only two that are absolutely necessary are 
System and Finder, though you may want to include other files as part of any 
floppy boot disk. (You learned how to create a System disk in Chapter Three.) 

THE SYSTEM FOLDER FILES 

SJ Finder 
Whereas the System file serves many background functions in the Macintosh 
operating system, the Finder interacts with you and helps you manage your 
files and folders. The Finder controls the way you interact with the Macintosh 
graphical interface as explained in Chapters Two and Three. The Finder is not 
technically part of the actual operating system. It is an application like any other, 
but one that accompanies each release of the System and forms an integral part 
of the Macintosh interface. 

The Finder keeps the invisible Desktop file updated. It is the Desktop file that 
helps the Finder locate and keep track of all the files and folders on a 
disk-hence the name Finder. 

SJ Multifinder 
You learned about MultiFinder in Chapter Three. In short, MultiFinder works 
with the Finder to allow more than one application to share the desktop. In 
essence, MultiFinder is a multitasking application used in conjunction with the 
System and the Finder. 
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7"-.-
.~h·:. · ~ Control Panel 

On a PC, when you want to alter the system level operations of the computer, 
you must issue DOS commands-often accompanied by a collection of 
command line switches (like /S /E, and so on). For instance, to change the 
screen display you might issue the command MODE C040 or MODE COSO. To 
change the system time, you would type TIME and then enter a new time. 

On the Mac, the Control Panel is one of the most important System desk 
accessories. It lets you set many of the system-wide parameters of your Mac 
including the time and date, the speed of mouse movement, speaker volume, 
and more. 

The Control Panel actually displays special control device files called CDEVs 
(their file type is cdev). Although several of these are supplied with the 
operating system, third party developers also have increased CDEVs to give 
you access to the operation of other products. 

There are three CDEVs that are used by all Mac systems-General, Keyboard, 
and Mouse. The Startup Device CDEV is used only by the Mac SE and the Mac 
II. The Color, Monitors, and Sound CDEVs are used by Mac lis only. 

To select a CDEV, first open the Control Panel from the Apple menu, then 
select the appropriate CDEV icon from the scrollable list on the left side of the 
window. Each CDEV will display a different set of options in the Control Panel 
Window. 

You'll learn more about the specific Control Panel utilities later in this chapter. 

SJ Clipboard File 
The Clipboard is the universal background storage area for text or graphics that 
you cut or copy. This temporary storage area works between applications, so it 
is possible to cut or copy text and / or graphics from one application and paste 
to another. 

For more information about the Clipboard see Chapter Three. 

SJ Scrapbook File 
The Scrapbook is a desk accessory that comes with the Macintosh System 
releases. This is a handy place to keep text or graphics that you may use often 
in your work. Since it is a DA, you can dig into your Scrapbook any time to 
recover a picture or paragraph copied originally from another document. The 
Scrapbook works a little like a permanent Clipboard. The Scrapbook file is 
generally found inside the System Folder where it can always be located. 

The closest PC equivalent to the Scrapbook would be a TSR like Sidekick or one 
of the freeform data managers like MemoryMate or AskSam which allow you 
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to store and retrieve information "on the fly." One major difference is that the 
PC applications don't store graphics-only text. 

SJ General 
The General icon represents the file which contains many of the settings used 
by the Mac interface. These settings and others are determined in the Control 
Panel desk accessory discussed in more detail later in this chapter. 

Backgrounder 
The backgrounder file is used in conjuction with Print Monitor to allow back­
ground tasks. This allows background processing to occur without interrupting 
the task on the desktop. The function of the Backgrounder is handled entirely 
by the Mac. 

There is no exact equivalent for the Backgrounder on the PC, though the DOS 
print queue is similar in function. On the PC and the Macintosh the Back­
grounder and print queue files are usually passive in nature, that is, they oper­
ate without any input or intervention from the user. 

00 DA Handler 
The DA Handler is responsible for monitoring and controlling memory alloca­
tion for desk accessories. The DA Handler is something that many people 
would like to see on the PC-a manager for memory allocation for TSRs. 

0 Font/DA Mover 
Unlike TSRs, which exist independently of other programs on the PC, desk 
accessories are often loaded into an application file so that, when that 
application is launched, the desk accessory is also made available through the 
Apple menu. The most common place to put a desk accessory is to load it in the 
System file which makes it available at all times. 

The Font/DA Mover is a utility which loads and removes fonts or desk 
accessories to and from application files. It also can save fonts and desk 
accessories to special files reserved only for fonts or desk accessories. These 
files are shaped like suitcases and are referred to as suitcase files. 

The Mac handles fonts the same way it handles desk accessories: they can be 
associated directly with a specific application or loaded into the System File to 
be used by all applications. 
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--P' --~ 

• loA Handler 

Figure 4·4. Suitcase files 

Font/DA Mover is usually required to install most DAs and even DAs that 
come with an Install file usually use Font/DA Mover to do the loading. 

®Font 
0 Desk Accessory 

Autmt Garde 1 0 
Autmt Garde 12 
Auant Garde 14 
Auant Garde 18 
Auant Garde 24 
Bookman 10 
Bookman 12 

System 
on HARD DISK 
6229K free 

[ Close ) 

( [OPt.~ 

( lh~mom~ 

( Help 

[ Quit 

Figure 4·5. FonVDA Mover screen 
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FZ' · -1 Keyboard 
Keyboard is a Control Panel utility (CDEV) which allows you to define the key­
board delay rate and speed. For more detail about Keyboard, see The Control 
Panel later in this chapter. 

D 

9 ~ . 

General 

··~ 

Mous• 

Sound 

3 .3 

Control Panel 
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Figure 4·6. Keyboard screen 

Printer Drivers 
Since there are few if any standards for printer communications on the PC, 
most PC programs provide their own printer drivers. On the Macintosh, there 
are basically two printer standards-ImageWriter and LaserWriter-and 
specific printer drivers for Apple printers are provided with the System 
releases. These drivers are located in the System Folder. In addition, some 
third-party printer manufacturers provide printer drivers for the Mac for use 
with non-Apple-compatible printers. 

You select the printer driver to use by accessing the Chooser DA You'll learn 
more about the Chooser later in this chapter. 
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~ Easy Access 
Easy Access is a new addition to the system files. It allows handicapped users 
to perform multiple key operations with one hand. Through the use of special 
shifted keystrokes, which Apple terms as "sticky keys," keys stay depressed 
even after released. There is no PC equivalent for Easy Access. 

~ CloseView 
CloseView is a new Control Panel utility (CDEV) which allows up to 16 times 
magnification of a section of the screen. This is helpful for people who are vi­
sually handicapped as well as being an excellent tool for precise work when 
using a draw or graphics program. It has no counterpart on the PC, nor is one 
needed. 

There's more information about the Control Panel later in this chapter. 

~ MacroMaker 
MacroMaker is a Control Panel utility (CDEV) which allows users to record 
keystrokes, mouse movements, and mouse button clicks to be replayed in the 
same sequence at a later date. The replay mechanism can be tied to specific 
keystrokes to invoke the replay or can be chosen from the MacroMaker menu. 

MacroMaker is the closest System equivalent to DOS batch files (.BAT files). 
Like a batch file, you can create a file that, when invoked, will carry out a series 
of pre-programmed commands. There are other, more powerful macro utilities 
available, but MacroMaker is the only one that comes with the System. 

Figure 4·7. MacroMaker screen 
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~TeachText 
TeachText is a text editor that is commonly distributed with software packages 
and System updates. It provides basic instructions and hints to users similar to 
the Read.me text files frequently found on installation disks for PC software 
packages. 

In a sense, TeachText is the Macintosh equivalent of EDLIN and the TEXT 
commands in DOS. It lets you create simple text files like EDLIN, and it lets 
you read text files like the TEXT command does. There are better text editors on 
both systems, but EDLIN and TeachText are useful and are included with their 
respective systems. 

One difference between the TEXT command and TeachText is that you can 
scroll back and forth in TeachText; you can only watch the text go by when 
using the TEXT command. In a sense, using Teach Text to read text files is more 
like using the popular shareware utility, LIST.COM for doing the same thing 
on a PC. 

TeachText is a full application; therefore it is not as quick and easy as using 
TEXT on the PC. You'll probably find you use TeachText less often than you 
had previously used TEXT (or LIST). 

MAC SYSTEM TOOLS 
System DAs 
Desk accessories are one of the most important built-in tools that the Macintosh 
operating system provides. They can range from simple desktop tools like a 
calculator or notepad, to very sophisticated applications for database 
processing, text editing, or graphics. Desk accessories are found as menu 
choices under the Apple menu. 

DAs are, in many ways, the Macintosh equivalent of the TSR on the PC. Both 
are always available, even when you are working in another application, and 
both types of programs cover a wide range of uses from simple desktop tools to 
sophisticated integrated environments like Borland's Sidekick Plus. 

On the Mac, however, DAs also fulfill the function of many of the utilities that 
you would ordinarily find operating from the DOS command line. For instance, 
there are several DAs designed to help you find lost files on a hard disk. In 
DOS, there are several small utilities that do the same thing from the command 
line. The difference is that most people would not make a TSR of these small 
programs. The Macintosh makes it very easy to create all kinds of utilities and 
add them to the system by making them into DAs. 

Another significant difference between DAs and TSRs is the way they are 
loaded in memory. TSRs on the PC must be loaded into memory and must 
remain there until needed. They must take and hold onto a certain amount of 
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RAM; on a PC that RAM is often very critical. Therefore, you would never 
think of having 15 or more TSRs loaded at the same time. 

On the Mac, however, DAs do not actually occupy significant amounts of 
memory until they are specifically activated from the Apple menu. In this way, 
you can have the maximum of 15 DAs installed at the same time. In fact, with 
third-party products, like Suitcase and Font/ DA Juggler, you can have many 
more than 15 DAs available at any one time. 

The other important difference between TSRs and DAs has to do with how they 
are activated. A TSR is activated when you press a hot key combination. Since 
you need to be able to activate a TSR at any time, the program must constantly 
monitor the keyboard looking for its hot key combination. Though most 
modern TSRs are "well behaved," conflicts can arise between TSRs and the 
programs you run or simultaneously loaded TSRs. 

The Mac has no such problem. DAs are listed in the Apple menu, a System 
menu that is always present, regardless of the application you are running. 
Therefore, a hot key is not needed to activate a DA (though a few offer that as a 
choice). You simply pull down the ever-present Apple menu and choose the 
DAyou want. 

The Macintosh operating system comes with several desk accessories included: 

• About the Finder 
• Alarm Clock 
• Calculator 
• Chooser 
• Control Panel 
• Find File 
• KeyCaps 
• Scrapbook 

If you have AppleShare, you will also have the Access Privileges DA in your 
system which is used to manage network functions. 

In the sections that follow, you will learn more about each of these System DAs. 

About the Finder 
You learned about the About the Finder DA in Chapter Three, however, you 
may want to refresh your memory about what this very important utility does. 
You can open About the Finder to find out about: 

• The current Finder version number 
• The current System version number 
• Credits to the developers and copyright information 
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• Total memory (RAM) in the system 
• Largest unused block of memory available 
• The amount of memory currently in use by various applications 

(MultiFinder only) 

-0 About the Macintosh'" Finder 

Find•r: 6 .1 
svst•m: 6 .0 

Tobl M•morv: 

~ Find•r 

!iJ Sys\•m 

Figure 4·8. About the Finder 
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When you open About the Finder under MultiFinder, it displays memory 
information in a dynamic way. That means that you can leave About the Finder 
open on the desktop to view an ever-changing window into your memory use. 
You can open and close applications and perform various tasks at the Finder 
level, and the About the Finder window will continuously update its display to 
show how much memory is being used. 

The About the Finder DA serves several purposes-some that parallel DOS 
functions, some unique. The version numbers are similar to using the DOS VER 
command. The Total Memory is part of what you get if you run a CHI<DSK in 
DOS. However, there is no native DOS command that will return the exact 
memory usage of applications on the system, though the shareware utility, 
MAPMEM, from the TSR Utilities, will perform a similar service. There is also a 
similar utility, OS2MEM, that will return the largest available block of memory 
running under OS/ 2. 

Although About the Finder is the DA that accompanies the Macintosh System, 
most applications also have an About DA. For instance, dBASE Mac has one 
called About dBASE Mac, and Studio 8 has one called About Studio 8. 

These About DAs may serve several purposes of their own. Some simply list 
the current version number of the product, and includes the credit of its 
company and developers. Other About DAs will contain elaborate notes about 
the product or even complete help systems. Therefore, it is often useful to check 
the About DA of a product the first time you use it. 
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.::i~~ Alarm Clock 
Like About the Finder, the Alarm Clock comes with the Mac operating system. 
The Alarm Clock lets you set the System date and time (like the DOS 
commands DATE and TIME). However, it also lets you set an alarm, a feature 
missing from DOS. 

When you first open the Alarm Clock, it places a small window on the screen 
displaying the current time (as set in the system). At the upper right corner of 
the Alarm Clock window is a small key icon. Clicking on this icon opens the 
screen to display the date as well as three icons along the bottom of the 
window. The large clock icon lets you set the time on the clock. The smaller 
clock icon lets you set the alarm (which will cause the Mac to beep when it goes 
off). The middle icon is the calendar icon. 

I D 5:47:56 PM • I 
Figure 4·9. Alarm Clock window open to set time 

You'll notice that you can click on the lower display of time, date, or alarm time 
to enter a new value, either from the keyboard or by using the mouse to click 
on the small arrows that appear. 

You can also set the time and date from the Control Panel (which is explained 
later in this chapter). 

You can leave the Alarm Clock window on the desktop to display the time. 

Calculator 
Although many TSRs on the PC offer built-in calculators, there is no DOS 
calculator. The Calculator DA that comes with the Macintosh operating system 
is a simple calculator that opens in its own window and contains only the basic 
numeric operations. More sophisticated calculator DAs are available in 
commercial DA collections and in shareware. 

You can also cut and paste from the Calculator. 

Figure 4·10. Calculator DA 
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;: - Chooser 
The Chooser is one of the most important System desk accessories. Aptly 
named, it allows you to choose which printer to use and which network and/ or 
network zones to enter, as well as to turn AppleTalk on or off. It also lets you 
identify yourself by name on the AppleTalk networks. 

[ill 
~ 

Figure 4·11. Chooser screen 
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One of the Chooser's functions is to select the active printer to use. On a PC, 
you might direct printer output from a parallel port to a serial port by using a 
DOS command like MODE LPTl: = COMl. Another example simply changes 
the active printer port-MODE LPTl:. However, these commands only 
redirect output while you are at the DOS level. Most PC prog? .. ms let you 
select and change printers and 1/0 ports from within the program, but, again, 
these settings are true only for the current program. 

On the Macintosh, you can use the Chooser to select a printer for all applications 
at once. If you have more than one printer-several LaserWriters, for 
instance-you can open the Chooser and select the one to which you want to 
print. Since you can give each printer a different name, the Chooser makes it 
easy to identify different printers. Since the Chooser is a desk accessory, you 
can change printers at any time-within any application. You can also log onto 
different servers or zones on a network at any time, working through the 
Chooser. 

Although the Chooser replaces printer redirection on the PC, it also gives you 
somewhat more control over specific printer output over LocalTalk. Even 
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though there is only one Printer Port, you may choose among any number of 
printers specifically, by name (see How to Use the Chooser). On a PC, unless 
you are operating on a network that has its own "chooser," the most you can 
do is direct output to a parallel or serial port (of which you may have several). 

The Chooser DA also provides a convenient place for network logon to occur. 
Specifically, 3Com networks use the Chooser to log on and mount drives on the 
network. 

How TO USE IHE CHOOSER. To choose a particular printer, first open the 
Chooser from the Apple menu. Then select the kind of printer you want from 
among the icons in the upper left hand box. You should see icons representing 
the LaserWriter, ImageWriter and AppleTalk ImageWriter. Your system may 
vary, and you may see icons representing other devices, either printers or 
networks. 

Suppose you want to choose a LaserWriter. Click once to highlight the 
LaserWriter icon. A list of all LaserWriters currently connected to your 
Macintosh (or to the network you are on) will appear in the list box in the 
upper right. Click once to select the one you want, then close the Chooser by 
clicking in the close box at the upper left corner of the Chooser window. When 
you next print, the LaserWriter you chose will be the one used. 

Even if you don't have a LaserWriter, you can format the output from your file 
as if you did have one. To do so, select the LaserWriter icon in the Chooser. 
Since you don' t have one, no specific printer names will appear, but if you close 
the Chooser window, the LaserWriter will be the current printer type. Open 
any print dialog box or Page Setup to confirm this. 

The Control Panel DA 
Many PCs keep important system settings in a special memory backed up by a 
battery. Such settings include the system time and date, the memory installed, 
and the number and kind of drives connected to the system. 

The Macintosh also keeps specific information in memory and uses a built-in 
battery to maintain it. On the Macintosh, many of the settings of this parameter 
RAM are defined in the Control Panel DA. 

The Control Panel DAis a special case, like the Chooser. It is an integral part of 
the Mac system. Though it is similar to the Setup program that often 
accompanies PCs, it is more flexible and easier to use. 

Setup is a common file used by 80286 and 80386 machines, though the actual 
file name may vary from one manufacturer to another. You can use Setup to 
define the various parameters mentioned before. However, Setup must be run 
by itself, and you always have to reboot the PC once you have changed the 
Setup parameters. 
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In contrast, the Control Panel is always available, just like any other DA. In 
addition, the Control Panel uses special files called CDEVs, which stands for 
Control Panel Device. Although the Control Panel comes with several CDEVs 
as part of the Macintosh System, other developers can use CDEVs as control 
devices for programs and utilities of their own. 

When you open the Control Panel DA, it displays icons that represent each of 
the CDEVs in your System Folder. In a way, some of the Control Panel CDEVs 
serve purposes that, on a PC, would be served in the Config.sys file, but CDEVs 
are accessible at all times where the Config.sys only does its work at boot time. 

There are eight standard Control Panel devices that come with the Macintosh 
System: 

• General. Lets you define many standard parameter settings. 

• Color. Lets you choose highlight colors on color Macs. 

• Keyboard. Lets you set option for your keyboards. 

• Map. Lets you view a map of the world. 

• Monitors. Lets you select the number of colors and screen positions 
for multiple monitors, define screen resolution and color (on Mac IT 
series only). 

• Mouse. Lets you customize mouse response. 

• Sound. Lets you set volume. 

• Startup Device. Lets you define the drive to look at first during boot up. 

GENERAL. The General CDEV is the one you will use most often, though you 
may not have to use it at all. There are actually several different areas on the 
General screen. You can choose: 

• Desktop Pattern. To change the background pattern (behind the windows). 
To choose one of the predefined patterns, click on the small arrows at the 
top of the right-hand screen, then click inside the screen itself to make 
change the current pattern. To design your own background pattern, click 
in the left-hand box to alter the pattern of dots that make up the desktop 
background. If you have a color Macintosh, you can create backgrounds in 
color. 

Although you can change the color of the text display on a PC using 
complex ANSI codes, there is no exact equivalent for the Desktop Pattern 
customization on the PC. 
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• Rate of Insertion Point Blinking. To alter the rate at which the insertion 
point blinks on and off. 

• Menu Blinking. To set the rate at which a selected menu item blinks when 
you choose it, or to tum off menu blinking. The PC operating system 
doesn't ordinarily use menus, so there is no equivalent for this in DOS. 

• Time. To set the current System time. You can type in a new value for 
hours, minutes, or seconds, or click on the arrow keys to change them. 

Time is, of course, an exact equivalent of the DOS TIME command. 

• Date. To change the System date. System time and date are used by various 
applications and also for time stamping files. Remember, if you don't cor­
rectly set the date, file listings by date will be inaccurate. 

Date is also an exact equivalent of a DOS command-DATE. 

• RAM Cache. To set the amount of memory to use for caching and to set the 
cache on or off. The RAM Cache helps speed up some operations on the 
Mac by saving recently used instructions and executing th.em quickly if they 
are repeated. 

RAM Cache is an example of a setting that you would have to include in the 
Config.sys on a PC, but you can set and reset through the Control Panel on 
the Mac. 

NOTE: Optimum cache size on a Mac is 128K. 

• Speaker Volume. To set the volume level for the internal speaker. 

There is no equivalent DOS command. 

COLOR. The Color CDEV lets you use the Color Picker (a large color wheel) to 
select the highlight color for the Finder and other System utilities. Note that this 
does not affect the highlight in the menus or in other applications. 

KE\'BOARD. The Keyboard CDEV lets you set parameters for the keyboard. 
You can set: 

• Key Repeat Rate. To determine how fast a key will repeat when you hold it 
down. 

• Delay Until Repeat Rate. To determine how quickly a key will begin re­
peating when you hold it down. 

• Domestic or International To use the U.S. keyboard layout or an 
international setup. 
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You can use DOS KEYBxx (or KEYB in some versions) commands to select 
various international keyboards on the PC. For more information about 
KEYBxx, see your DOS manual. However, there is not, to our knowledge, a 
standard command to alter the key repeat rate or delay settings through DOS 
(though some third-party utilities and certain graphics-based applications can 
do so). 

_MM. The Map CDEV is new to System 6.0. It shows you a miniature map of 
the world and lets you see such information as the latitude and longitude of 
various cities, the distance between two cities, and the time in any part of the 
world. The Map CDEV has no equivalent on the PC. This utility is an extra gad­
get that Apple has added to the Mac System. It might be very useful for finding 
the time in different parts of the world as well as finding the locations of 
specific cities as well as the distance between two points. Those who don't need 
such information will wonder why the Map CDEV is there. Those who do need 
it will probably wonder why it was so long coming. 
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MONITORS. The Monitors CDEV is available only on the Macintosh II family 
of products. It lets you choose different color modes for your system. You can 
use Monitors to tum color on or off and to select the number of colors from a 
choice of 2, 4, 16, or 256. Some programs will not work unless the color mode is 
set appropriately. For example, some color programs will only work properly 
when set to 256 colors, while other non-color programs must be set to 2 colors. 
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Figure 4·13. Monitor screen 

The Convergence Test is used to make sure the display is clear on your 
monitor. You can use it in conjunction with the color convergence controls on 
your monitor to get the best possible display. 

The closest PC equivalent to Monitors is the DOS MODE command that lets 
you select different display modes for the PC. Though the PC display options 
are different, the basic idea is similar. On the PC, however, you switch between 
different color and black-and-white SO-column and 40-column display modes. 
MODE is also used to define settings for 1/0 ports, something that is handled 
from the Chooser on the Mac. 
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The Monitors CDEV is also used to position and select the default monitor on 
multi-monitor systems. 

MOUSE. The Mouse CDEV is found on all Macs. You can set the speed and 
responsiveness of the mouse movement, depending on your needs. For 
instance, if you have a very large monitor, you will want to set Mouse Tracking 
to Fast. By doing so, you will be able to move the mouse much more quickly 
from one edge of the monitor to the other. 
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Figure 4·14. Mouse screen 

Sometimes, especially when you are performing delicate graphics procedures, 
you may want the mouse to move very slowly for better control. In that case, 
you can set Mouse Tracking to Slow, or even to Very Slow, which is the speed 
used with graphic tablets. 

Since double-clicking is such a common action on the Macintosh, the Mouse 
CDEV lets you select one of three speeds. Each person has his or her own 
preference for the double-dick rate of the mouse. 
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Many PCs today also use a mouse, but the mouse settings are usually loaded 
during boot-either in the Config.sys or in the Autoexec.bat. Special mouse 
drivers are necessary, and the parameters that affect mouse operation are 
loaded with the drivers. Some mouse programs also include special 
configuration programs that allow you to modify the response of the mouse at 
any time (like the Mouse CDEV does on the Mac). 

SoUND. The Sound CDEV is only found on the Macintosh II series. You can 
use this resource to set the speaker volume (which you can also use the General 
CDEV to do), and you can set the beep sound used by the system. The choices 
that come with the Mac are Boing, Clink-I<lank, Monkey, and Simple Beep (the 
default selection). On a PC, a beep is a beep. 

STARTUP DEVICE. The Startup Device CDEV is available on the Macintosh SE, 
SE 30, and the Macintosh II family of products. It allows you to select one of the 
internal or external drives as the startup drive. However, if one of the drives is 
selected, it must be powered up and at full speed when you boot, or the system 
will search for another disk that has a system on it. Since the SCSI hard disks 
used on the Mac take some time to come up to speed, it is possible that the 
drive you have selected to be the Startup Device will not be ready in time. It is 
important, therefore, to understand your system and how the devices are 
powered up. 

There are other CDEVs that do not come from Apple, but which can add some 
interesting abilities to your system. For information about third-party CDEVs, 
see the section on CDEVs in Chapter Five, "Software Guidelines." 
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Find File 
The Find File DA comes with the Macintosh System files. You can use it to 
search for files on a hard disk. Find File will search for any file by name or by 
part of a file name. 

There is no DOS equivalent of the Find File DA, though there are several 
shareware utilities that perform the same service on a PC. 
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Figure 4·15. Find File screen 
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Key Caps 
Use the Key Caps desk accessory to see the character set for any font you have 
installed in your system. When you select Key Caps from the Apple menu, a 
new menu item appears at the top of the screen. You can open this menu to 
choose the font to display. Then click on a key to see what it will look like in 
that font. Hold down one of the Shift keys (or the Caps Lock) to see what the 
capital letters will look like, or hold down the Option key to see what the 
alternate character set contains. Key Caps is especially useful when you get 
specialized fonts and you want to examine all their character combinations, or 
when you are searching for a specific alternate character like the copyright or 
trademark symbols. 

On the PC, there is nothing like the Key Caps DA. For one reason, font styles 
are rarely shown accurately on the PC. In fact, until the past few years, PC 
users thought much less about using different fonts than Mac users. Because 
font styles are easy to change (and view) on a Mac, most Mac users have be­
come aware of different types of fonts. With the advent of desktop publishing 
on the PC, more and more PC users have become aware of the potential variety 
of fonts and the impact that using the right font can have. 

figure 4·16. Key Caps window 
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n 
8 Scrapbook 

The Scrapbook is used to keep text and graphics for later. Anything you can 
put in the Clipboard by cutting or copying, you can also paste into the 
Scrapbook. Since the Scrapbook is a desk accessory, you can easily retrieve 
anything it contains at any time. For instance, suppose you have several 
standard logos you have created in one of the Macintosh drawing or paint 
programs. You can keep your logos in the Scrapbook, then paste them into 
your word processor or page layout documents whenever you need them. 
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Figure 4·17. Scrapbook screen 

There is no exact duplicate of the Scrapbook on the PC, though, as we said 
earlier in this chapter, there are some TSR utilities that can function similarly, at 
least with regard to keeping and retrieving text information. 
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GOING FORWARD 
In this chapter, you have filled in the pieces of the Macintosh operating system 
puzzle. From the information in Chapters Two, Three, and Four, you should be 
able to manage files and folders, manipulate windows, run programs, use desk 
accessories, and CDEVs, and select printers. Only practice will make the tech­
niques and various functions of the Mac become second nature. 

We have tried, throughout these chapters, to relate what you know about the 
PC to what you are learning about the Mac. For a different way of looking at 
this comparison, see Appendix A, which contains a functional reference of DOS 
commands and their Macintosh equivalents. 

Now that you have a good idea of how the PC and Mac operating 
environments compare, you may be wondering how the software that runs on 
them compares or differs. In the following chapter, we provide a brief overview 
of basic differences between the way programs work on the PC and the way 
programs work on the Mac. 
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Software Guidelines 
Up to now, this book has discussed and compared the operating system 
env1roments of the PC and the Mac. If this were strictly a 005-oriented book, 
you would have learned little about the nature of the programs that run on the 
PC. However, in learning about the Macintosh operating system as well, you 
have probably already learned a great deal about Macintosh software. 

The purpose of this chapter is to summarize the Macintosh graphical interface 
as it affects off-the-shelf software programs. 

You might be wondering what it will be like to begin working on a Mac. Will 
the word processor, database, or spreadsheet bear any resemblance to what 
you've used on the PC? 

The answer is yes, for the most part. All word processors process text 
information, all databases keep lists, and all spreadsheets crunch 
numbers-whatever system they run on. Although software for the Mac per­
forms the same basic functions as software for the PC, you may find that you 
don't work with it in the same way. The standard Macintosh interface accounts 
for many of the differences you will encounter, but there are other obvious 
ones you might like to know about. 

A complete treatment of Macintosh and PC software would be another book in 
itself. This chapter discusses some of the basic differences you may encounter 
and identifies some of the leading programs for the two types of machines. 

THE SOFTWARE INTERFACE 
Personal computer software reflects the design philosophy of the programmers 
who make it. In the case of DOS programming, however, the operating system 
does not suggest much about the way the program should look or operate, and 
developers have invented many different user interfaces. 

The Macintosh operating system contains special tools that help developers 
make their programs more uniform in appearance and operation. This 
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ultimately helps users because almost all Macintosh programs look similar. For 
instance, basic operations, like pulling down menus, mouse selections, 
manipulating windows, and even some of the menu commands themselves, 
behave the same way from one program to another. 

The standardization of the Macintosh interface benefits users who must learn 
new programs or move from one program to another. There are fewer things to 
remember, and the same techniques work throughout a computer session. In 
contrast, moving from one PC program to another may entail a complete 
change of procedures and methods-not to mention commands and structures. 

Businesses benefit from the standard interface. Employees learn more quickly 
in a standardized environment, thereby reducing training expenses. Once a 
user has established Mac literacy, or a familiarity with basic Macintosh 
techniques and structures, he or she can move easily from one application to 
another. On the PC, such migration from one product to another often requires 
much more retraining and adjustment. Because the Mac provides a standard 
software interface, it is possible to make some general statements about 
Macintosh programs: 

• They use a graphical interface. 

• They operate in windows. 

• They use pull-down menus. 

• They use the mouse extensively. 

• They interact with the user through dialog and alert boxes. 

• They all contain certain File and Edit menu items. 

• They all use identical file-saving and retrieving methods (though there are 
different file types). 

• They all use the Clipboard to cut, copy, and paste text and graphics. 

• They all share the same graphic formats. 

• Text can be moved from any application to any other via the Clipboard 
(without formatting). 

• They all contain internal information that ties documents to the application 
that developed them, and they are displayed as identifiable icons on the 
Desktop. 

You'll notice that all these features are consistent parts of the graphical 
interface described in detail in Chapters Two, Three, and Four. 
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In addition to these almost-universal similarities, there are some additional 
features that are found more often than not: 

• Memory permitting, most Macintosh applications allow you to open more 
than one document at a time, each in its own window. 

• The features of Macintosh windows are almost always the same, including 
the scroll bars and the size and zoom boxes. 

Contrast these features with those of the average PC application: 

• PC programs use a variety of interfaces, including menu-driven structures, 
command-driven structures, graphical interfaces, and combinations of 
these. 

• PC programs seldom use windows. 

• Most PC programs do not support the mouse. Those that do rarely depend 
on it to any great degree, although there are some exceptions. 

• PC programs rarely share any similarity of structure or commands, except 
by accident. Even products from the same publisher may differ greatly. 

• There is no standard for cutting and pasting information between 
programs, though many products provide ways to cut and paste internally, 
and others provide ways to import and export text and (sometimes) 
graphics; some products offer an internal Clipboard substitute. 

• Generally, PC programs will load only one document at a time, although 
some can load more than one. 

• PC documents and files are often identifiable by their three-letter extensions 
(.com, .doc, .txt, and so on), but, from the operating system's point of view, 
they are not otherwise tied to the application that created them. 

Some of the key differences are discussed in greater detail in the following 
sections. 

Windows 
Many PC users will be unfamiliar with the concept of windows on a computer 
because windows are not used universally in PC applications, whereas 
Macintosh users tend to take windows for granted. 

As stated in Chapter Two, windows are separate, independent areas of the 
screen, each devoted to its own document and/ or application. For instance, 
you can have several different documents, each in its own window, or you can 
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have several applications (with a multitasking operating system), each 
occupying a separate window. It is also possible to have several applications 
open, each of which has several active documents in separate windows. 

DOS programs like Microsoft Windows and IBM's Presentation Manager are 
window-based programs. So are Sidekick Plus and Framework III (which was 
one of the first window-oriented products for the PC). 

Nearly all software for the Macintosh operates in one or more windows. There are a 
few exceptions, but these do not conform to the Macintosh interface standards. 

Because there are many different kinds of monitors available for the Mac, espe­
cially for the Mac II series, ranging in size from 11 inches to more than 25 inch­
es, windows have become even more useful. The original Mac screen can feel 
cramped with more than a few windows, but large monitors can provide a 
virtual kaleidoscope of active documents and applications. 

Since windows can be moved, resized, and even zoomed to fill the whole 
screen, they offer a very flexible way to work. 

On the PC, you can have one monochrome and one color system on the same 
machine, though their uses are very limited. On the Macintosh 11 series of 
machines, you can attach several monitors and actually use them as if they 
were one single screen. You can move windows from one monitor to another. 
Although this is a very costly kind of system, it does allow you to display many 
more windows than could fit on a single screen. 

Dialog and Alert Boxes 
Throughout all Macintosh applications, you will see dialog and alert boxes 
similar to those you've seen in the Finder. Dialog boxes generally require input 
from you, while alert boxes serve to warn you of a current situation. 

Dialog and alert boxes are so common in Macintosh operations that you 
probably can't use any Mac application without encountering at least one of 
them. Examples of common dialog boxes are the Open (file) and Save As dialog 
boxes. The alert that appears when you try to close a document or quit an 
application before saving any changes is standard. 
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Figure 5·1 . Open (file) dialog box and Save alert box 

PC applications usually use some kind of message line to alert you to 
conditions, or they may use modal menus to present choices (for instance, 
Microsoft Word on the PC). Lotus-style menus (see Menus in the next section) 
use a combination of prompts on the menu line with messages on a special 
message line. Examples of programs that use this type of menu are 1-2-3 and 
Paradox. A few PC applications use dialog boxes. For instance, Microsoft's 
Bookshelf, Reflex, and others have incorporated basic aspects of the graphical 
interface. 

145 



Chapter Five 

On the Macintosh, dialog boxes can contain many different elements, including 
list boxes, buttons, radio buttons, and pop-up menus. A good example of how 
complex a dialog box can get can be seen in the following figure. 
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Figure 5·2. dBASE Mac Preferences dialog box with labels 

List boxes, buttons, radio buttons, and the other elements of dialog boxes are 
explained in more detail in Chapter Two. 

Menus 
Many applications use menus. On the PC, menus are often lists of choices that 
appear on the screen from time to time. By following these menus, often 
through several levels, you can accomplish tasks. Some menu systems require 
the whole screen and take over the operation of the application at that time. 
These systems are sometimes referred to as modal systems. Other menu systems 
are available within the application and consist of several levels of 
interconnected choices. This kind of menu was popularized by Lotus' 1-2-3 and 
is often called a Lotus-style or 1-2-3-style menu. 

More and more popular on the PC these days are the so-called pull-down 
menus. Programs like Framework from Ashton-Tate and Borland's Reflex were 
among the early adopters of this system of menus, but today many programs 
feature this type of interface. Lotus-style menus are structurally similar to pull­
down menus. The differences are largely cosmetic, though pull-down menus 
offer more flexibility in labeling the options available. 
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DESOview IJ~t~base file 

+Open Window 0 
S~o~itch Uindo~o~s 

ForMat for Screen 
Query 

Close Uindo~o~ 
Catalog 

Rearrange R Uie~o~ 

Zoo" 
Ouit dBASE III PLUS 

11ark 
Transfer 
Scissors 

Help for DESQule~o~ 1 
Quit DESQule~o~ Q 

Figure 5·3. A dBASE IV menu and a DESOview menu example 

On the Mac, menus are almost exclusively pull-down, but the Mac version has 
undergone some refinement. Today, the basic pull-down menu may offer one 
of several different types of options. When you select a menu command from a 
Mac menu, it may: 

• Have an immediate effect (such as Paste, to paste text or graphics 
from the Clipboard) 

• Open a dialog box 

• Open a temporary (hierarchical) submenu-one that disappears 
when you release the mouse 

• Open a sticky submenu or a tear-off menu 
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TYPES OF MENU COMMANDS. Menu commands that lead to a dialog box end in 
an ellipsis ( ... ). For instance, selecting the Open or the Save As menu 
commands, found on the Edit menu of almost every Macintosh application, 
will present an appropriate dialog box for you to name the file to load or to 
save. The Goodies Box of a drawing package will have options that are indicat­
ed by an ellipsis. 

Goodies 
Rulers 
MouseSpot 
Grid XG 
FotBits XF 

Show Pages .. . 
Edit Pattern .. . 
Brush Shope .. . 
Brush Mirrors .. . 
Ruler Units ... 

Preferences ... 

Figure 5·4. Goodies box showing ellipsis choices 

Menu commands that have submenus show a right-facing arrow. Clicking the 
menu command causes another menu to open to the side of the current 
command. Choose the submenu command by holding down the mouse button, 
moving the pointer onto an item in the other menu, and then releasing the 
mouse button. 
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figure 5·5. The submenu operation 
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There are two kinds of submenus. The difference between them has to do with 
what happens if you open one and then release the mouse button without 
moving the mouse cursor inside it. In some cases, both menus will simply close 
and nothing will happen. Another type of submenu replaces the currently 
opened menu and appears just below the menu bar. You can then select a 
command from that menu in the usual way. This kind of submenu is 
sometimes called a sticky menu. 

Tear-off menus are relatively new to the Mac. They are especially useful in 
graphics programs because they allow you to place a menu of options or tools 
anywhere on the screen. To grab a tear-off menu, drag the mouse through the 
menu without releasing the button. An outline of the menu then appears; drag 
the menu where you want it on the screen. Tear-off menus are found in more 
and more applications-HyperCard, and Electronic Arts' Studio 8, for instance. 
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Icon Bars 
Icon bars are uniquely Mac-like replacements for commands and menus. Most 
icon bars display one or more columns of icons vertically along the left edge of 
the Mac screen. 

Icon bars were first introduced with MacPaint-one of the original Macintosh 
applications. Icon bars are used most often by graphics programs, in which the 
icons represent different draw and paint tools. For instance, clicking a circle 
icon turns the mouse cursor into a circle-making tool. Clicking a text icon 
allows you to type words on a graphics screen. 

Other icon bars are used to replace menus or procedures. For instance, in 
HyperCard, icons on the Tools menu change the operating mode for 
HyperCard. In programs like Full Impact and dBASE Mac, icon bars may 
replace menus or even represent user-created macros. 

There is no exact PC equivalent for icon bars. 

Mouse Techniques 
Mouse techniques are clicking, double-clicking, dragging, Shift-clicking, and 
marqueeing. If a PC application uses the mouse, it will use some combination 
of these techniques, though often it won't use all of them. These are explained 
in greater detail in Chapter Two. 

The mouse techniques available in an application depend entirely on that 
application, but there are some general rules. For instance, text-oriented 
applications are less likely to use the marquee technique for multiple selections 
but instead will extend a selection by letter, word, or paragraph. Graphic 
programs like MacPaint, Claris CAD, Super Paint, or Pixel Paint (to name just a 
few) generally use all available mouse techniques. 

PRODUCTIVITY SOFTWARE 
The basic applications available on any personal computer system consist of so­
called productivity software-notably spreadsheets, word processors, databases, 
and telecommunications tools. Though there are other types of applications, 
these are by far the most commonly used. 

Mac programmers and developers have attempted to redefine these 
applications to fit the graphical interface. In doing so, they have expanded the 
utility of many Mac products and, in many cases, have inspired PC 
programmers to match their efforts. 

PC applications now feature interfaces similar to the Mac standard. Thus, as 
time passes, it should become easier to switch between the two machines. 
Many industry leaders expect the PC to look more and more like the Mac. 
OS/2 Presentation Manager is evidence of that. 
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PC and Mac applications-spreadsheets, word processors, databases, and so 
forth-differ from each other in several respects. Many, perhaps most, of the 
differences can be attributed directly to the contrasting interface standards. De­
spite these, there are some tips that may help you move from PC to Mac appli­
cations. 

In the following sections, you will learn something about specific types of 
software on the Mac and how they compare with similar software on the PC. 
Each section contains a partial list of the main products in that type followed by 
a brief discussion of history and product contrasts. Some sections contain a few 
specific tips and statements that summarize general differences between PC 
products and Mac products. The purpose is to help you make the transition 
from PC to Mac-not to provide you with either a buyer's guide or a 
comprehensive list of options available on either system. 

NOTE: The discussions that follow vary in length and content primarily 
because some kinds of programs on the PC contain substantial differences 
from their Mac counterparts. Other types of programs are not different from 
each other simply because of their respective operating environments, but 
only because they have different design implementations or features. For 
instance, Ventura Publisher works directly with word processor files, but 
PageMaker must import files before working with them. This is a valid 
distinction, but it is not a PC/Mac issue. It is a difference in design-not a 
feature that exists on one machine and is absent on the other. The goal is to 
provide an overview of productivity software, not to review or contrast spe­
cific products. 

Spreadsheets 

SIGNIFICANT PRODUCTS. 

PC Spreadsheets 

1-2-3 
Quattro 
Excel 
SuperCalc V 

Mac Spreadsheets 

Excel 
Full Impact 
Trapeze 

HISTORY. Spreadsheets are simple number-crunching machines, and after 
1-2-3 there can be no progress. True or false? 

Although it's true that 1-2-3 almost single-handedly elevated the PC to the 
position in business it now occupies, competition is still alive and the art of the 
spreadsheet continues to evolve. 

The graphical interface of Excel on the PC is no surprise because Excel on the 
Mac has been the best-selling Mac spreadsheet since its introduction. Excel's 
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success on the Mac points out a difference between Mac users and PC users. 
Where the PC user still swore by 1-2-3, Mac users pointed out the superiority of 
Excel. 

Excel uses pull-down menus and the mouse plays an active role during 
ordinary operations. In 1-2-3, to define a range, you would enter a starting cell 
value, press the period key, then enter the ending cell location. In Excel, to 
define a range, you can use the mouse to select a block of cells. 

Cut, copy, and paste features work in Excel the way they work in other Mac 
applications, so it is very easy to work with the contents of cells. In 1-2-3, it is 
also easy but requires many keystrokes. The difference may be minor to some, 
but it points to the whole philosophical difference between the two systems. 

One of the features that frequently appears on the Mac is the integration of 
different types of information-text and graphics, for instance. Spreadsheets 
are evolving in that direction, too. One spreadsheet, Full Impact from Ashton­
Tate, allows the incorporation of text and graphics with spreadsheet data to 
create a presentation spreadsheet. 

Full Impact further exemplifies the contrast between accepted PC spreadsheets 
and what is happening on the Mac. Full Impact uses traditional pull-down 
menus, along with icon bars that can be customized by the user and even 
attached to user-created macros. 

GENERAL TIPS. 

• PC spreadsheets use various interfaces, including the familiar 1-2-3-
style menus. Some PC spreadsheets (such as Quattro) offer pull-down 
menus (like the Mac) but otherwise operate like a PC application. 
Excel, which works under Microsoft Windows, has the most Mac-like 
interface among PC spreadsheets. 

• Mac spreadsheets take full advantage of the Mac interface and use the 
mouse for selecting ranges; they cut, copy, and paste while defining 
formulas. 

• Mac spreadsheets allow you to open more than one worksheet at the 
same time. PC spreadsheets have traditionally limited you to one open 
sheet at a time. 

• Mac spreadsheets can usually read 1-2-3 worksheet data, though they 
will not translate 1-2-3 macros. Since all popular PC spreadsheets write 
to the 1-2-3 format, Mac Epreadsheets can share data with them. Also, 
Excel on the Mac can also read and write files compatible with Excel 
on the PC. 
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Word Processors 

SIGNIFICANT PRODUCTS. 

PC Word Processors 

WordPerfect 
Microsoft Word 
MultiMate Advantage II 
Sprint 
WordS tar 
Samna 
DisplayWrite 

Mac Word Processors 

Microsoft Word 
WordPerfect 
FullWrite Professional 
Mind Write 
Write Now 
Nisus 
MacWrite II 

HISTORY. PC word processors have evolved from the command-driven CP/M 
products like WordStar to today's powerhouse programs like WordPerfect and 
Microsoft Word. In a continuing battle of features, however, the basic user 
interfaces of these products have changed little. WordStar has come out with 
more friendly approaches, but WordPerfect and Microsoft Word-the two 
leading word processors-have hardly changed their approaches over the past 
several years. They have added lots of features to the same basic product. 

When the Mac was first released, it had only two applications-a word 
processor and a paint program. The word processor was MacWrite, and it set 
the standard for all Mac word processors to follow. 

In contrast to the diversity on the PC, word processors on the Mac all contain a 
few of the same features: 

• They use the graphical interface, specifically, sizable and scrollable 
windows; mouse techniques; and standard menu commands like Save, 
Save As, Cut, Copy, Paste, and so on. 

• They support multiple fonts, font sizes, and typestyles (bold, underlined, 
outlined, and so on). 

• They use visible, editable ruler bars. 

• They are almost entirely WYSIWYG (What You See Is What You Get). 

• They can interchange text easily through the Clipboard. 

The uniformity of Mac word-processor interfaces contrasts with the diversity of 
PC word-processor interfaces. Some may have a menu-driven interface; others 
may use commands. Each word processor uses its own commands for cut, 
copy, and paste (and usually its own terminology, too). Some word processors, 
like DisplayWrite, for instance, use modal menus. Others use pull-down menus 
(like Sprint or New York Word Processor). Still others, like WordPerfect, rely 
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on massive collections of commands that make extensive use of the PC's 
function keys in different combinations with the Alt, Shift, and Control keys. 
Some use combinations of commands and menus, like Microsoft Word for the 
PC. 

PC word processors are just beginning to work effectively with multiple fonts 
and font sizes, though they have always had special effects like boldface and 
underline. However, PC word processors are usually not completely 
WYSIWYG to the extent that Mac word processors are. Though special effects 
may display in different colors or with different video attributes on a PC, they 
rarely display exactly as they will print. On the Mac, indentations, multiple 
columns, graphics, specific fonts, sizes, and special effects are all displayed 
graphically on the screen, exactly the way you will see them on the printed 
page. 

One of the key differences between PC and Mac word processors is text 
selection. On the PC, you usually use a combination of keystrokes to mark the 
beginning and the end of a block of text to be selected, and then you perform 
an operation on it. On the Mac, you use standard mouse techniques. Generally, 
double-clicking selects a whole word and other mouse techniques may be 
available (depending on the word processor) for selecting an entire sentence, 
paragraph, page, or document. Today, most Mac word processors offer key­
board text selection as well. 

Many people who touch type have trouble adapting to using the mouse with a 
word processor because they have to remove their hands from the keyboard. 
However, people who work with the Mac long enough begin to appreciate the 
added convenience of mouse techniques which can become second nature. 
Most Mac word processors also include a full complement of keyboard 
techniques to access menu operations. For instance, Microsoft Word and 
Ashton-Tate's FullWrite Professional both have many key combinations using 
the Command and Option keys along with other alphanumeric keys. Standard 
combinations like Command-X for Cut, Command-C for Copy, and Command­
V for Paste are found in almost all Mac applications. Others may vary from one 
application to the next. 

Various word processors on the Mac offer subtle improvements to the interface. 
For instance, FullWrite offers special Command-keys to open and select 
commands from menus. WordPerfect for the Mac uses sticky menus (discussed 
earlier in this chapter). 

Furthermore, both Microsoft Word Version 4 and WordPerfect provide ways 
for you to customize the interface. Word lets you redefine the menus and the 
shortcut keys assigned to each menu command, and WordPerfect lets you 
create keyboard-activated macros that can emulate any combination of menu 
commands. On the PC side, WordPerfect and Sprint allow the same kind of 
flexibility. 
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GENERAL TIPS. 

• Use the mouse as a selection tool in Macintosh word processors. Double­
clicking to select a word is almost universal. 

• Learn the keyboard equivalents for the menus you use most often. 

• Use the Clipboard or the Scrapbook whenever necessary to bring in 
graphics or text information from other applications. 

• In addition to the Clipboard, most Mac word processors can import and 
export ASCII text files (including those created on PCs). Sometimes, they 
can read and write formats for other products. 

• When working with PC text files on a Macintosh, you will want to eliminate 
gremlins that appear. These gremlins are often the line feed characters used 
on the PC but eliminated on the Macintosh. Line feeds show up as empty 
boxes on the Macintosh screen. There are several utilities, such as Apple File 
Exchange, which will eliminate line feed characters. 

Page Layout 
SIGNIFICANT PRODUCTS. 

PC Page Layout 

PageMaker 
Ventura Publisher 
Byline 

Mac Page Layout 

PageMaker 
Quark Express 
Ready, Set, Go 
Ragtime 
FullWrite Professional 

HISTORY. Page layout software, also called desktop publishing, though a 
relative newcomer to the personal computer, has quickly become widely used. 
PageMaker on the Mac was the first significant page layout product. Page­
Maker defined the standards that have since been followed almost entirely by 
other desktop publishing products on both the PC and the Mac. Most desktop 
publishing programs (DTP) all feature windows, mouse techniques, and pull­
down menus-in short, they are all Mac-like regardless of the system for which 
they were written. 

More and more frequently, DTP functions can also be found in some word 
processors and even in some spreadsheets, like Full Impact. 

Page layout programs allow you to combine text and graphics visually and to 
control the details of each page. Page layout programs have become popular at 
all levels of publishing, from company and local newsletters to professionally 
produced books. In fact, this book was completely formatted with FullWrite 
Professional. Since all of the high-end page layout programs can work directly 

156 



Software Guidelines 

with laser printers, professional typesetting equipment, and other printing 
resources, their range is not limited to one group of users. All Macintosh DTP 
programs use the mouse and windows to facilitate page layout, while not every 
PC application incorporates them. Byline, for example, does not require the use 
of a mouse to operate, instead it r~lies on the cursor keys to move text and 
graphics. 

The good news is that, because it was a Mac product that set the standards for 
this software genre, it is pretty easy to migrate from the PC products to their 
Mac counterparts. At least as far as DTP software is concerned, transition from 
PC to Mac should not be a great shock, and, if you use PageMaker, you can 
even bring your documents along with you. 

Databases 
SIGNIFICANT PRODUCTS. 

PC Databases 

dBASE III, III PLUS, IV 
RBase 
Paradox 
Reflex 
Rapid File 
Fox base 

Mac Databases 

dBASEMac 
4th Dimension 
Double Helix 
Reflex for the Mac 
FoxbaseMac 
Filemaker II 

HISTORY. Databases on the PC evolved from mainframe data processing 
solutions, and most early database products were, in fact, programming 
languages with almost no supporting structure. Over time, databases evolved, 
and now there are many different solutions featuring a variety of approaches. 

On the PC, most databases are either command- or menu-driven. Command­
driven databases include dBASE II, dBASE III, Knowledgeman, and GURU. 
Menu-driven products include Paradox, RapidFile, and Alpha Three. Some 
products include combinations of menu-driven and command-driven 
interfaces, including dBASE IV, RBase, and others. 

There are flat file (non-relational) databases on the PC, which can manage 
mailing lists and other simple database tasks, and there are hefty relational 
databases, like dBASE IV, which feature powerful fourth-generation 
programming languages. This same diversity exists in the world of Macintosh 
database products. 

Although databases on the PC and the Mac are different, the same basic 
principles of data management apply, whatever the interface. However, 
Macintosh databases have experimented consistently with graphical interfaces 
in processing data. 
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Many Mac databases use a visual model to define files and fields. dBASE Mac, 
4th Dimension, and Reflex for the Mac all feature graphic file representations 
with visual markers to represent relations. Instead of creating relational models 
by defining relationships or issuing complex queries, programs like dBASE 
Mac and 4th Dimension let you use the mouse to draw a relationship from one 
file structure to another. At the top of the visual spectrum Double Helix uses 
icons to represent all the elements of a procedural database application. 

Another example of the visual model includes the use of icons to represent 
commands and menu options. dBASE Mac uses such icon bars. 

People dB/Dotobose Structure 

tiD Number 
LasLName 

F;rst~ame ~ s~hries 

Bus._phone tEmployee 
Business Date started 
Bus.-Address 
Bus . ....City 

Bus . ....Zip 
p. ~Annual Salary 

+People() 

Home _phone 
Home_Address 

Home-City 

Home ....Zip 
+Salaries() 

Pay Rate 

~Pay Rate() 

Figure 5·7. dBASE Mac structure window showing related files 

Another feature common to Mac database products is the graphic report 
layout, which uses standard Macintosh object-manipulation techniques. 
Creating reports within Macintosh databases often involves using the mouse to 
move and manipulate objects that represent fields and other data. In addition, 
reports can be WYSIWYG and you can view fonts, field positioning, headers, 
footers, and graphics just as they will print. 
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Some Mac databases include menus that contain the commands for their 
programming languages. By selecting from the menus, users can build simple 
or complex programs without typing. One advantage of this method is that fill­
in-the-blank constructions are automatically added in one step. For instance, 
selecting IF from the dBASE Mac menus adds the construction for 
IF .. THEN .. ELSE .. END. You simply fill in the conditions. With multiple IF 
statements, you don't end up with as many syntax errors-leaving off an END 
statement, for example. 

Mac databases also provide the same standard menu options that other Mac 
applications provide-making it easier to know how to manipulate files and to 
cut and paste data. 

Despite some useful innovations, Macintosh databases have not caught up with 
data processing software on the PC. Speed is the main reason. Even on faster 
Macs, the database software tends to be slower than a database on a 
PC-perhaps because of the graphic overhead. You will almost certainly notice 
a difference, especially if you work with very large databases. 
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Graphics Software 
SIGNIFICANT PRODUCTS. 

PC Graphics 

AutoCAD 
Versa CAD 
PC Paint 
PC Paintbrush 
Deluxe Paint 
CHART-MASTER 
Paintworks Gold 
Lumena 
Render Man 
DRAW APPLAUSE 
GRASP 
Art and Film Director 
Harvard Graphics 

Mac Graphics 

AutoCAD (soon) 
Versa CAD 
MGMStation 
Claris CAD 
Mac Draw II 
Mac Paint 2.0 
Illustrator 88 
Lumena (coming) 
RenderMan (coming) 
Freehand 
Superpaint 
SuperCard 
Super3D 
Digital Darkroom 
Image Studio 
HyperCard 
FullPaint 
Studio 8 
Photon Paint 

HISTORY. It should come as no surprise that graphics programs on the Mac are 
both numerous and varied. They range from simple paint programs like the 
original, MacPaint, to very sophisticated photo-touchup programs like Digital 
Darkroom and Image Studio. In between are powerful paint programs, draw 
programs, and CAD systems. With the advent of the color Macintoshes, 
graphics options have expanded rapidly. 

Graphics programs on the PC and Macintosh have very little in common, 
though most graphics programs on the PC look a lot like the early Macintosh 
paint programs, and a few of the newer ones (like Deluxe Paint) are becoming 
as sophisticated as many of the Mac paint programs. Of course, some of the 
draw and CAD programs are direct imports from the PC to the Mac (AutoCAD 
and VersaCAD, for example), but they are different on the Mac. In at least one 
case (Adobe Illustrator), a graphics program is migrating from Mac to PC. 

The PC has had high-resolution graphics display capability for only a relatively 
short time, while the Macintosh has had exceptional graphics capability since 
its inception. Typically, graphics software in the DOS world has been targeted 
to specific tasks such as charting data into various presentation styles like pie­
charting and bar-charting. Products like SIGN-MASTER and CHART-MASTER 
are used frequently in the DOS world to prepare graphic presentation material. 
There is no truly accepted standard for graphics on the PC, although there are 
several formats that are gaining acceptance. 
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Newer programs, like Deluxe Paint and Paintworks Gold, have begun to gain a 
following and offer much of the same power and functionality on the PC that 
powerful Mac programs, like Pixel Paint, Studio 8, and others, can offer on the 
Mac. At the high end of the spectrum are programs like Lumena and Pixar's 
RenderMan, which offer exceptional color processing power on the PC and are 
being ported to the Mac. 

Figure 5·9. Full Paint screen 

Mac graphics are much more tightly integrated into everyday operations than 
they are on the PC. Presentation software has been less necessary on the Mac, 
since most software packages designed for the system make some use of the 
graphics capability inherent in the machine. Software packages such as 
MacDraw and FullPaint introduced Mac users to freehand drawing years ago. 
In contrast, freehand packages (such as DRAW APPLAUSE) have only recently 
been available in the DOS world and will run only on high-end systems. 
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It is worthy of note that many of the most powerful Macintosh paint and draw 
programs work in color, but that only a few Macintosh models (the Macintosh 
II and the Macintosh Ilx, for example) support color. Thus, though graphics 
have been a mainstay of Mac applications from day one, the most sophisticated 
systems are used by a few. In contrast, almost any PC can use high-end color 
graphics, given enough memory and the addition of a graphics board that sup­
ports EGA, VGA, or MCGA. 
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Figure 5·10. CHART-MASTER screen 

The Macintosh graphics software environment is moving toward more profes­
sional-level graphics output exemplified by products such as Adobe Illustrator. 
These products address some of the more mathematical issues required by 
technical drawing, such as Bezier curves and other precise drawing require­
ments. Illustrator is also being introduced on the PC. Other titles of note are 
MacDraw II, SuperPaint, Pixel Paint, Studio 8, Photon Paint, Dreams, 
AutoCAD, VersaCAD, Claris CAD, MGMStation, Pegasus, and a host of other 
drawing, paint, and CAD programs. You'll notice that AutoCAD and 
VersaCAD (and, soon, Illustrator) are the only graphics programs that current­
ly support both PC and Mac versions, though PageMaker can also use graphics 
from both systems. 
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The lack of compatible graphics standards has acted as a barrier between 
Macintosh and PC graphics programs, but standards are beginning to appear. 
Many Macintosh and PC graphics programs will read and write TIFF files, a 
format used by many FAX machines and scanners. 

' : File Edit Arrange Ulew Style Window 

0 

Figure 5·11. Adobe Illustrator screen 

Scorpion Rrt:Scorplon Template I 

There are also several animation programs available for each system. On the 
Mac, the leader is VideoWorks, though Silicon Beach's SuperCard (when re­
leased) will be able to produce sophisticated animation as well. On the PC, 
animation products range from Paul Mace Software's GRASP to Art and Film 
Director from Epyx. Each can produce highly pleasing and sophisticated 
animation. 

Image and photo retouching is another growing field . High-end PC products 
(like Lumena) have been able to perform graphic miracles. Recently, relatively 
low-cost programs like Digital Darkroom and ImageStudio allow sophisticated 
image modification on gray-scale images; color retouching on the Mac is not far 
away. 

When switching from a PC-based graphics program to a Mac program, the key 
benefit you will immediately notice is the ease of moving the graphics image to 
other document types (such as word processing programs and spreadsheets). 
Most PC applications require exporting and importing the graphics to incorpo­
rate the image in another document type. The Mac allows normal cut-and-paste 
procedures, as in any other Mac application. 
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Integrated Software 
SIGNIFICANT PRODUCTS. 

Integrated PC Programs 

Framework II 
Framework III 
Microsoft Works 
Enable 

Integrated Mac Programs 

Jazz 
~crosoftWorks 

HISTORY. The degree of difficulty in moving from one type of application to 
another, as well as the high cost involved in buying several different packages, 
spurred the growth of the integrated software market in the DOS world. Pack­
ages such as Framework II, Framework III, and Enable allow users to have 
word processing, database, communications, and spreadsheet capabilities in 
one package. These packages also allow for simple transfer of data from one 
package to another. The cut-and-paste facilities in Framework III, for instance, 
are simple and quick. 

Create Edit Locate 
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Uidth <n Cols/ Fields) 
Height <n Reus/ Records) 
ColuMns/Fields: Add 
Rous / Re c ords: Add 

Create a fraMe fo r uord processing or fo r containing other fraMes 

Figure 5·12. Framework Ill screen 

The Macintosh community has demonstrated less need for this type of a pack­
age, largely due to the cut-and-paste capabilities inherent in the desktop. 
Therefore, sharing data between products does not require data reformatting. 
Lately, however, demand appears to be increasing for integrated packages, and 
they have begun to appear on dealers' shelves. ~crosoft Works is an excellent 
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integrated package now available in most stores. Works is available on both the 
PC and the Mac and represents the only viable integrated package on the Mac 
at this time. 

Integrated packages vary a great deal in their design and interface 
philosophies. Framework was one of the first PC products to use a graphic 
interface very similar to that of the Mac. With multiple, sizable windows and 
pull-down menus, Framework featured a somewhat Mac-like approach. Other 
integrated PC packages vary and cover the whole spectrum of presentations 
and interfaces. However, if you have been using an integrated package on the 
PC, you will probably find less need for such a package on the Mac, 
particularly if you have enough memory to use MultiFinder effectively. With 
MultiFinder and the Clipboard, you can choose your own software 
environment and make it work almost as smoothly as the best integrated 
package. With Lotus' dwindling support of Jazz, Microsoft Works is just about 
your only choice for an integrated package for the Mac. 
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Telecommunications Software 
SIGNIFICANT PRODUCTS. 

PC Com Programs 

Smartcom 
CrossTalk 
Procomm Plus 
Lotus Express 
Relay Gold 
QModem 
GTPowercom 
Boyan 

Mac Com Programs 

Smartcom 
Red Ryder 
Microphone 
Desktop Express 
In talk 

HISTORY. Telecommunications is the use of telephone lines to send data 
between computers at different locations. Telecommunications ultimately boils 
down to modems, baud rates, protocols, and the other buzz-words of the genre. 
Although the interfaces may be different, technically, Mac and PC 
telecommunications products work more or less the same. 

Perhaps the most significant difference between the two systems is the 
MacBinary protocol. Because PC files do not contain the same resource 
information as Mac files (specifically the file type and creator information 
presented in Chapter Three), file transfer protocols like Xmodem and its 
derivatives (Ymodem, Zmodem, and so on) have been adequate to send and 
receive all kinds of files. 

MacBinary is an Xmodem derivative also, but one that reads the file resource 
information and can therefore transfer a Mac file intact. Generally, when you 
use MacBinary, the filename, its type and creator are all included in the transfer 
so the resulting file is identical to the one sent, right down to its icon. 

Other than MacBinary, differences between communications programs are 
largely cosmetic and follow the general differences between PC and Mac 
programs. There are two kinds of PC telecommunications programs-menu- or 
command-driven. Popular programs like Procomm and Qmodem follow the 
command format with various menu screens. However, these same products 
also use pop-up information windows to display upload and download 
progress information, baud rate options, protocols, and other information. 
Many PC telecommunications programs also include sophisticated Pascal-like 
programming languages. 
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Figure 5·13. Qmodem screens 

167 



Chapter Five 

Mac programs use the pull-down menus, dialog boxes, and other typical 
features of the graphical interface. Products like Red Ryder contain complex 
programming languages that allow you to customize many aspects of your 
telecommuncations sessions. Another Mac program, Microphone, lets you 
define Macintosh button icons to represent your scripts. 

Hayes Smartcom Il lets two connected Macintoshes communicate via graphic 
screens. A very simple set of drawing tools could allow two artists to share 
ideas for a drawing, or allow story editors to rough out story boards over the 
phone lines. It might also allow people to share ideas for a newsletter layout, 
and even cut and paste information from other applications via the Clipboard, 
then transmit the images directly to the screen of the remote Mac, where it can 
be copied and pasted via the Clipboard into a graphics program or into the 
Scrapbook for storage. 

In addition to general-purpose telecommunications products, there are some 
specialized programs as well. For instance, AppleLink software allows users to 
access the AppleLink network run by Apple, and special software is used to 
connect with another Macintosh bulletin board, MacNet. 

MCI Mail supports two specific telecommunications products-one for the PC 
and one for the Mac. Lotus Express works with MCI to automate message and 
file transfers through the E-mail service. Similarly, Desktop Express on the Mac 
does the same. With either of these products, you can send text or binary files 
to other subscribers of the E-mail system. Currently, Lotus Express will work in 
the background on a PC and will also poll MCI at preset intervals. Desktop 
Express, though more Mac-like in its interface, currently lacks the ability to 
function in the background and also does not do any automatic polling. 

There are some other interesting telecommunications utilities like Backdown, a 
desk accessory that performs file downloading in the background, even on an 
ordinary Macintosh without MultiFinder. A similar product called IL.COM 
will download in the background on a PC. Both products are shareware 
utilities. 

See Chapter Seven, "Connections," for more information on telecommunica­
tions and networking. 

UTILITIES 
Some favorite software doesn' t come under any of the aforementioned catego­
ries, but, instead, could be called "utility software." 

There are so many utilities available for both systems that they can't all be list­
ed here. There are literally hundreds of valuable utility programs, in both 
commercial and shareware. They are used for a variety of purposes. This 
section provides a brief overview of some of the types of useful utilities you 
may encounter. 
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Most Mac desk accessories come under the heading of utilities, as do many 
tools available for the PC. Think of utilities as small programs that become 
indispensable parts of your daily life. 

Utilities help you do things better. They are often an extension of the operating 
system, or a replacement for its lesser features. 

Some typical utilities on the PC include Whereis and Sfind, two shareware 
programs that help you locate lost files on a hard disk. Menu programs like 
Automenu or shell programs like Directory Scanner are very useful additions 
to the typical PC system. There are also various directory programs like HDIR, 
which displays a directory with each different file extension in a different color, 
and Xtree, which displays your file directories in a graphic format. 

Archiving 
Some of the most useful kinds of utilities are the file squeezing and library 
utilities. They combine several files into a single smaller file and can be used in 
telecommunications and for archiving information. 

On the PC, archiving/ file squeezing utilities include ARC, PKARC, and ZOO. 
On the Mac, the original library utility was called Packlt, and the most recent 
favorite is called Stufflt! The main difference between Mac and PC library files 
is the interface. As usual, the PC programs use a command line interface with 
special switches entered at the command line. 

There are some fine shareware utilities that can help you work with PC library 
files in a menu-oriented application. These include programs like Arc Master, 
LARC, and NARC. 

The Macintosh programs use windows, menus, list boxes, and dialog boxes. 
Also, double-clicking a Packlt or Stufflt! library will automatically invoke the 
appropriate program. 

The operation of Stufflt! is typical of Mac applications. You can archive files by 
selecting them from the standard file list box. You can also unarchive files by 
selecting appropriate files from a list. If you have ever used one of the PC 
programs, you'll find Stufflt! easier to use and understand. 

More CDEVs 
In Chapter Four, you learned about the Control Panel resources called CDEVs. 
The ones mentioned in that chapter come with the Macintosh System files. 
However, some CDEVs are available from other developers. For instance, 
Vaccine and GuardDog are anti-virus utilities that use the Control Panel. Pyro 
is an excellent screen saver program that can be controlled from the Control 
Panel, and SoundMaster is a versatile program for attaching special sounds to 
different Macintosh II activities (like ejecting a disk, startup and shutdown, and 
so on). 
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Another CDEV is used by the Apple and 3Com network software to switch 
between LocalTalk and Ethernet operation. 

Other MacFavorites 
On the Mac, one favorite utility is Disktop, a desk accessory that contains a 
great many useful features like sophisticated file searching (more 
comprehensive than Find File) and a host of other file and disk maintenance 
features. You can use Disktop to find a DOS file that was brought into the Mac 
system, then modify its file type or creator. 

Another fine utility is On Cue, a quick and easy application-launching system 
that lets you open an application or document from anywhere without having 
to open its window or even look for it. With the press of a couple of keys and 
the mouse button, you can open a pop-up window of applications from which 
to choose. Under MultiFinder, you can switch between active applications 
quickly and easily. 
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Figure 5·14. On Cue screen 
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Another powerful program is QuickKeys, a macro creator for the Mac. 
QuickKeys takes the place of the DOS. bat file by letting you program a series of 
actions and assign it to a keyboard command or menu choice. QuickKeys al­
lows you to assign frequently used tasks (such as getting into a calendar or a 
calculator) to easy-to-access keystrokes. 

There are also desk accessory databases like Retriever, DAtabase, and 
Quickdex for handy database management; text retrieval like GOfer; and vari­
ous other kinds of DAs like HyperCard readers, mini paint programs, and 
many more. 

One product of possible interest to people who use PCs and Macs or who 
regularly download text files from other sources is McSink. This desk accessory 
is a very fine text editor with the ability to add or strip line feed characters 
instantly from text files. This is significant because most text files created on 
PCs and other systems use a special invisible character to indicate a new line of 
text. On the Macintosh, these line feed characters display as empty boxes. 

With McSink, you can instantly strip those line feeds from a file you want to 
use on a Mac, or, if you are going in the other direction, add them. McSink will 
also reformat a text file to fit into any window size and can create paragraphs 
from text that has carriage returns and line feeds at the end of each line (which 
is how most text files are received). By creating paragraphs, McSink makes 
these files more suitable for editing in a word processor or for sending to a 
page layout program. 

Other indispensable programs are Suitcase and Font/ DA Juggler Plus. One of 
these programs should be on your Mac hard disk because they allow you to use 
a virtually unlimited number of desk accessories and fonts. Ordinarily, you can 
have no more than 15 desk accessories in your system. With Suitcase or 
Font/ DA Juggler Plus, you can truly make use of the many utilities that are 
available in this form. 

Here are a few more of our favorite Macintosh utilities-ones that we have 
found to be stable and useful. Many of them are !NITs; some are DAs or 
CDEVs. Look for them: 

• Findswell. Helps locate files from the Open file dialog box inside an 
application 

• Aask. Select CDEVs to load at boot time 

• HireDA. Used to display menus associated with desk accessories­
especially useful for opening the Control Panel to a particular CDEV 

• Sound Master. Lets you select sounds to associate with different 
Macintosh events (startup, restart, eject disk, and so on) 
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• SuperClock. An excellent on-screen clock/ alarm utility with lots of 
options 

• Moire. A very entertaining screen saver utility 

• Apfont. Redefine the default font used by the system or within 
applications 

• Laser Status. Monitors the status of the print queue 

• Screener. Select different screen display sizes with non-standard 
monitors 

VERTICAL SOFTWARE PACKAGES 
OOS-based vertical software systems were known as solutions systems; that is, 
they were usually sold by systems integrators or small computer stores to solve 
specific computing needs. Accounting packages are typical of the vertical mar­
ket (as well as medical packages, legal packages, and so on). The DOS world 
has had an advantage over the Macintosh in the vertical market arena because 
more development tools have been readily available on the PC than on the 
Mac. Only recently have high-level development tools been available to users. 
dBASE Mac, 4th Dimension, and FoxBase Mac are all products that bring de­
velopment capabilities to the Macintosh. Typical application development on 
the Macintosh using the Macintosh Programmer's Workshop (MPW) can be 
very time consuming. However, several powerful programming languages are 
available for Macintosh developers, including several versions of C and Pascal. 
More and more, vertical market applications are finding their way onto the 
Mac. 
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A Tale of Two Machines 
The Macintosh and the PC-based systems feature distinct hardware configu­
rations. Because hardware is the platform on which operating systems evolve, 
understanding the differences between these two systems can facilitate 
switching between the PC and the Mac environments. This chapter will discuss 
the following hardware topics: 

• Design issues (memory management, system design) 

• Hardware components 

• Peripherals 

• Miscellaneous devices 

IBM introduced the forerunner of today's PC standard in 1981. Two years later, 
Apple introduced the Lisa, the forerunner of the Macintosh and Apple's first 
computer to feature the graphical interface. 

The first Macintosh was introduced in 1984. The evolution of the Macintosh 
family of computers closely parallels that of the PC family. This evolution has 
come about as major advances in technology have become cost-efficient. 

This chapter outlines the major differences between the PC's hardware envi­
ronment and that of the Mac-from the "closed" architecture of the early Mac 
systems to the "Semi-open" architecture of the Macintosh II. 

Both the Mac and PC-based systems are sold in a standard configuration con­
sisting of the central processing unit (CPU), some configuration of temporary 
memory known as random access memory (RAM), disk drives of some type, a 
monitor and adapter card, and a keyboard. While both systems contain these 
components, vast differences exist between components and options available 
for the different systems. 
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HARDWARE OVERVIEW 
The most significant difference between the chip sets-one which affects most 
users-is the way the CPUs address the memory needed for program opera­
tion. For a discussion of memory see Central Processing Unit (CPU) below. For 
more information on memory usage, see The Multitasking Dilemma in Chapter 
Three. 

Central Processing Unit (CPU) 
The most significant difference between the PC and the Mac starts at the core of 
the systems, the CPU. 

The CPU is the brains of the computer-responsible for processing all of the 
instructions for the system. The CPU receives an instruction sent to it, executes 
the instruction, directs the result, and fetches the next instruction. 

The speed with which the CPU processes depends on two factors: how much 
data can be received and transmitted to and from the system bus and how 
much data the CPU can process internally. 

The PC family is based on the Intel 8080/8088 family of CPUs. The Mac is 
based on the Motorola 68000 family of CPUs. 

The 68000 can receive or transmit 16 bits of data at one time externally, but can 
internally process 32 bits at one time. The 68020 CPU, the chip in the Macintosh 
II, supports both internal and external 32-bit processing. The 8088 CPU of the 
PC is also a 16-bit processing chip, while the 80286 and 80386 are 32-bit chips. 
However, the PC and PC/XT architecture only supports 8-bit data flow while 
the PC/ AT and most 386 boxes only support 16-bit data flow. 

In 1988 and early in 1989, Apple introduced the Macintosh IIx and the 
Macintosh SE/30, the first Apple products to feature the 68030 CPU. The 68030 
runs Mac applications approximately 15 percent faster than the 68020. The CPU 
also has a built-in Paged Memory Management Unit (PMMU) which provides 
the necessary memory management facilities for multitasking operating 
systems such as A/UX. 

Read Only Memory (ROM) 
If the CPU is the "brains" of the system, the system ROM (read only memory) 
is the "heart" of the machine. ROM stores information required by the CPU to 
control systems operations. The ROM chip is permanent memory and cannot 
be changed or altered without replacing the chip with a new ROM. 

The information stored in the Mac's ROM includes programs that control the 
user interface, the mouse, the different I/0 devices, and other key components 
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of the Mac. The Macintosh 128 was delivered with a 64K ROM chip which had 
limited storage capacity, thus limiting the functionality of the system. 
Advanced ROM technology and the increased sophistication of the Mac 
opened the way for the 128K ROM available in the Macintosh 512K and also 
the Mac Plus. The trend toward greater sophistication has led to the present 
256K ROMs found in the Mac SE and Mac II series. These higher-capacity ROM 
chips have done much to increase the rapid growth of Mac capabilities. 

In contrast, the PC ROM is fairly straightforward. It handles certain portions of 
the 1/0 handling and (on IBM machines) part of the native Basic language. 
Most of the PC ROM information deals with the actual controlling of data to 
and from the hardware components, rather than setting specific guidelines for 
what to do with that data as the Mac ROMs do (in the case of the desktop tool­
box). 

Random Access Memory (RAM) 
RAM is an area of temporary memory storage which is referred to as volatile 
memory. When the system is turned off, any information in RAM is lost. RAM is 
a temporary work area for running applications and processing data. 

When starting a program, the program instructions and related data are 
shuttled from the disk device to RAM by the CPU. The size of available RAM 
directly affects the potential size of any programs that may be run on a system. 

ABOUT RANDOM ACCESS MEMORY. On DOS machines, the software controls 
most memory management instructions. Those machines which contain the 
80386 chip are exceptions, because this chip has a built-in Memory Manage­
ment Unit (MMU). What this means is that memory addressing on the PC sys­
tems was left up to the operating system software, MS-DOS and PC-DOS, and 
they allow the CPU to address only 640K directly as operating space. 

Additional memory may be added to the PC, PC/XT, or PC/ AT; however, it 
must be identified to the CPU as either expanded or extended memory. This 
memory is marked as available to the CPU by the use of device drivers loaded 
into the operating system stack space on boot up. The device drivers allow the 
operating system to use the extra memory, which is usually reserved for stor­
ing data or special routines for quick access by the CPU. Most programs can­
not run directly in extended or expanded memory; therefore, programs must 
take up less than 640K of memory to run (allowing for operating system size, 
most programs that specify 640K may take up between 512K and 560K of mem­
ory space). 

The Mac is a different sort of computer and requires a different approach to 
memory. Reproducing graphics requires more memory than reproducing text. 
To operate, large graphic-based applications generally need a large amount of 
memory. It is imperative that a graphical system like the Mac have freer access 
to memory than the text-based PC. 
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The Motorola 68030 used in the Mac has a built-in MMU that allows it to ad­
dress all memory present in the system. A system that has 4MB of RAM has the 
entire memory area available for program usage. 

Even though the PC, PC/XT, or PC/ AT could only address 640K of RAM di­
rectly, it held a distinct advantage over the early Mac systems in that up to 
15MB of memory could be added to the system as extended or expanded mem­
ory. The early Macs were restricted to a configuration of 128K or 512K, unless 
the user wanted to risk voiding the warranty with the addition of third-party 
memory boards. 

The introduction of the Mac SE allowed users to add up to 4MB of memory to 
their systems. Additionally, the introduction of the Mac IT allowed users to add 
up to 8MB to their system with the use of single in-line memory modules 
(SIMMs); up to 2 gigabytes of memory may be added by using the expansion 
slots (NuBus). The Mac Ilx will support up to 4 gigabytes of RAM through the 
NuBus-more than 30,000 times the capacity of the original Mac! 

Since the CPU can directly address any memory on the system board, adding 
more memory (up to the maximum allowed) is a simple matter of seating the 
SIMMs in the appropriate slots on the system board-a task that requires no 
skill or dexterity. 

In contrast, adding memory to the PC is (at least) a two-step process: 1) the 
purchase of special memory boards or the tedious addition of memory chips 
into their sockets on the motherboard; and 2) the addition of special software 
drivers. 
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Bus Stop 
PC and Mac systems process and communicate information between the inter­
nal devices in the chassis very differently. The PC-based systems are designed 
with a chassis technology known as S-BUS architecture or industry standard 
architecture (ISA). In an S-BUS chassis, the CPU not only controls the process­
ing of information, but also acts as ''bus-master," directing data to and from the 
various devices in the system. 
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Figure 6·1 . S-Bus architecture 

Under this arrangement, the CPU must pause from processing information to 
direct the data to the devices. While this may not be the most efficient method 
of managing the data stream, it creates fewer compatibility problems for add­
on board manufacturers. 
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The Mac, (with the exception of the Mac II), uses a method of communicating 
internally known as memory-mapped 1/0. In this method, each device on the 
system reads and writes data from a specific location in memory. 

Figure 6·2. Memory mapping 
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Each device on the system must contain special logic to recognize where to 
read and write data and to define its specific address on the chassis. This need 
for special logic is why third-party add-on components are not easy for a nov­
ice to install and why Apple voids their service warranty for tampered systems. 
These restrictions are why the Mac is described as a closed system. 

The Mac II utilizes a method known proprietarily as NuBus architecture. With 
the NuBus, each device has an intelligent processor on-board and searches the 
data stream for data that is specifically addressed to it. This frees the CPU from 
having to interrupt important processing tasks to address routing requests 
from internal devices. The inclusion of intelligent boards allows for quick data 
traffic along the bus lines. 

178 



A Tale of Two Machines 

DATA LI NES 

All All All A .. All 

.... .... .... .,, .... 
DISK VIDEO SERIAL PARALLEL 
DRIVE 1/0 1/0 1/0 CPU 

' ..I ' ./ 
PORTS PORTS 

figure 6·3. NuB us architecture 

While the components in the NuBus also require special logic to recognize data 
addressed to them, the ability to poll a stream of data greatly increases the 
performance of the system, and the ability to build intelligent boards that 
reduce the dependence on a single bus-master has made it easier for vendors to 
develop add-on boards and open the Mac architecture. 

Disk Drives 
All PCs come with at least one floppy disk drive. The early floppy drives for 
the PC used 5 1/ 4-inch double-sided diskettes with a storage capacity of 360K. 
At the time these were introduced, they compared favorably with the single­
sided 5 l/4-inch drives used on the Apple II. The first PCs had room to house 
two full-height floppy disk drives or one floppy drive and one hard drive. 

Eventually, other kinds of floppy disk drives appeared on the PC. For instance, 
the high-density drive which has a capacity of 1.2 megabytes was introduced 
with the IBM PC/ AT. The 1.2-megabyte floppy also uses a 5 l /4-inch diskette. 
Recently, with the introduction of the PS/ 2 line of computers, IBM PCs are 
moving toward 3 1 /2-inch floppy disks with a capacity of 1.44 megabytes each. 
Most laptop PCs use 3 1 /2-inch disks as well. 

The PC/XT was the first to offer a hard disk drive as a standard feature. Even 
the IBM PC could use a hard disk with the addition of an appropriate drive 
controller, but the XT's beefed-up power supply made hard disk usage feasible, 
whereas the underpowered IBM PC sometimes balked at the extra load a hard 
disk imposed. Although some PCs come with the drive controller built in, most 
use one of the peripheral slots to house it. 

Most common drive controllers can handle up to two floppy drives and two 
hard disks, but in practice, few systems will contain more than two floppies 
and one hard drive. 

The DOS world has always been forced to operate under the limitations of a 
maximum of 32MB of data addressable by the CPU. This forced users to 
partition their hard drives into multiple logical drives (for example, drive C and 
drive D), if the hard drive was larger than 32MB (a 40MB drive, for example, 
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would be partitioned into two 20MB logical drives). Changes to DOS version 
3.31 and higher allow the PC user partitions greater than 32MB; however, the 
partitioning is still not automatic and the user must specify the size of the 
partition desired. Additionally, many PC software packages were designed 
with the 32MB limitation in mind and have had compatibility problems with 
the larger logical drives. 

Like the first PCs, the early Macintosh models also came with a single floppy 
drive and no hard drive. Unlike the PC, however, the disk controller was built 
into the Mac, and there was a second, external port designed to accommodate a 
second floppy drive. The first Mac had room for only one internal floppy drive 
and no hard drive. 

The early Macs (Macintosh 12BK and 512K) were shipped with single-sided 
400K micro-floppy drives. The diskettes for the Mac are a hard shell media 
with a metal shutter door to protect the sensitive magnetic disk in the case. The 
single-sided drives were replaced by double-sided BOOK drives in the Mac Plus 
and subsequent machines. The Mac llx, Mac Ilcx, and the Mac SE30 now have 
1.44-MB floppy disks. The double-sided drives have proven to be very popular 
with Mac users and developers and will most likely be the micro-floppy device 
in the future. 

The micro-floppy 3 1 /2-inch disks are the same disks gaining popularity on the 
newer PCs and on laptop PCs. They are smaller and more durable than the 
5 1 I 4-inch floppies; however, they have a greater tendency to get lodged in the 
drive if the hard shell jams in the disk slot. Apple's engineers foresaw that 
possibility and provided an opening for manual ejection of disks. You can 
insert a thin, strong item (like a straightened paperclip) into the hole to the 
right of the disk slot and press to eject the disk. 

Unlike DOS, the Mac operating system was designed without any practical 
limit to the size of storage media; therefore, an entire drive is recognized by the 
system and available to the user-regardless of its size. No partitioning is 
needed with larger hard disks. 

Hard-disk options are plentiful for the Mac, although the Mac SE was the first 
system to support internal hard drives without voiding the Apple warranty. 
Apple supplies internal or external hard drives of 20MB, 40MB, BOMB, or 
160MB capacity. Third-party drives of more than 300MB capacity are also 
available. 

Hard drives may be connected to the Mac by two different methods, bus 
connection or port connection. 

Bus connection is the method most commonly used by internal hard drives as 
they are connected directly into the system's bus lines for faster communication 
with other devices. The bus-connected hard drive is recognized internally as an 
independent device; however, any interruption of the physical drive 
connection results in an inoperable system. 
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Hard drives that do not talk directly to other devices but require the use of an 
external port are treated by the system as external devices (much as printers are 
regarded). The disk speaks with the other devices on the bus by 
communicating through the I/0 port which translates and passes the data into 
the bus stream. Disconnecting a port-connected device will still allow the user 
to operate the system with micro-floppies. 

Hard drives can be externally connected through the serial port or the external 
floppy drive port. However, the most common method of connecting external 
hard drives is the SCSI (Small Computer System Interface) expansion port 
which became standard on the Mac beginning with the Mac Plus. The SCSI in­
terface was one of the first methods for connecting hard and floppy drives to 
various systems. It established a standard set of port connections and protocols 
for drive connections. 

The SCSI port allows drives to connect directly to bus lines. While serial-port 
hard drives were the only option of the early Mac, poor performance and speed 
have proven to be major obstacles to the continued use of these drives. Because 
SCSI-port drives tap directly into the bus line, they achieve better performance. 

Getting the Picture 
A major advantage of early PCs over the Mac was the availability of numerous 
monitor configurations. The PC offers many different monitor and graphic so­
lutions. These range from the basic TTL monochrome monitor to IBM's new 
Video Graphics Array (VGA). In addition, PCs can support up to two monitors 
on a single system-one monochrome and one color. Very few PC programs 
make use of this dual monitor approach, but it is an option. 

Such variety offers a PC user more options; however, inconsistencies and in­
compatibilities between graphics processors have proven a nightmare for users 
looking for graphics-dependent software. 

A video display is made up of thousands of dots or elements known as pixels. 
The Mac began life with a standard 9-inch high-resolution monochrome moni­
tor with a count of 512 x 342 pixels-per-screen. The Mac II offers a 12-inch high­
resolution 640 x 480 pixels per-screen-monochrome monitor or a 13-inch 640 x 
480 RGB color monitor. In contrast, various PC graphics modes offer pixel 
counts of 320 x 200 in CGA mode, 640 x 350 in EGA mode, and 640 x 480 in 
VGAmode. 

The Mac uses a method of video display known as bitmapping. Each pixel is 
directly mapped to a bit which is stored in Video RAM-a section of memory 
that is isolated and reserved for video mapping. A 0 bit in memory represents a 
white pixel on the screen and a 1 bit represents a black pixel. The system 
recomputes the pixel status more than 60 times per second. This standard 
bitmapping scheme allows for extremely sharp graphics imaging and allows 
graphics compatibility in the Mac environment. 
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The Mac ROM contains a set of tools known as QuickDraw which manages the 
complex graphics of the Mac bitmapped screen. QuickDraw is used by the Font 
Manager to create typefaces on the screen and draw graphic images fairly 
quickly. The majority of the time-consuming work of actually determining 
which pixels are on or off is controlled by Quickdraw. 

The early Macs were somewhat limited by the size of their screens. In spite of 
the fact that the text and graphics on the Mac's monitor were clearer and sharp­
er than those on all but the most advanced PC, many people thought it looked 
too small. 

With the advent of MultiFinder and the possibility of running several 
applications concurrently in separate windows, the 9-inch screen seemed 
cramped. And with the rapid growth of desktop publishing, the ability to see 
an entire page (or two) at a time became imperative. 

Many third-party manufacturers introduced larger screens for the Mac Plus 
and the Mac SE. However, the introduction of the Mac IT and its open 
architecture spurred the development of different kinds of video 
displays-both color and monochrome. At 12 inches, the Mac IT's own standard 
monitors were larger than that of the original Mac, but many third-party 
developers introduced monitors of 16, 19, and even 26 inches. On larger 
screens, it became much easier to display several windows, or full pages of text. 
It also became easier to work with larger graphics in paint, draw, and CAD 
programs. 

With the revolution in desktop publishing, there came a growing demand for 
print-quality graphics. Along with color imaging, there was a need to produce 
gray-scale images such as those found in newspaper and magazine 
photographs. The Mac IT introduced true gray-scale processing on-screen, 
along with color. With the ability to display up to 256 colors or scales of gray, 
came new technologies. 

Higher-resolution images became possible with the addition of 24-bit video 
cards, direct video links, and high quality scanners. Like the PC using a VGA 
adaptor, today' s Mac can support nearly photographic-quality images. 

Another Mac II innovation was the ability to use multiple monitors 
concurrently-as if they were all one screen. By adding video adaptor cards to 
the Mac II NuBus and attaching a separate monitor to each card, you can 
actually treat a bank of monitors as if they were one screen. You can move 
windows freely from one monitor to another without any noticeable change. 
Applications capable of running in the background under MultiFinder can 
continue to process on one monitor while you work on the active window on 
another. At the beginning of this section, we mentioned that the PC could 
support both a monochrome and a color monitor in the same system. However, 
they can't work as one screen, and only rarely are they used concurrently. Peo­
ple who have both usually use only one at a time. 
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There are many third-party monitors available for the Mac Plus, Mac SE, and 
the Mac II. Mega Graphics offers 19-inch displays for color, grayscale, and 
black and white output. The Mega Graphics Monitors and controllers have a 
resolution of 1024 x 826 pixels. Both Apple and Radius offer a 19-inch display, 
known as the two-page display, that has special programs for select item 
magnification, side-by-side display capability, screen blanking, and tear-off 
menus. Other fine third-party monitors are available from SuperMac, Jasmine, 
and others. These third-party products are great options for the serious Mac 
user. 

Sounds 
Nobody has ever accused the PC of providing symphonic sounds. The tinny 
speaker common to all PCs delivers its messages in the most succinct and 
rudimentary way-its usual comment consists of a single beep. 

In contrast, the sound generator is an integral part of the Mac system, and, 
though the Mac speakers are not going to blow down the roof, they are more 
melodic than their PC cousins. Moreover, every Mac has a method for sending 
sound output to external speakers. 

Early Mac systems had a four-voice sound generator. This generator converted 
a digital signal to analog wave which was output to the speaker or speaker jack 
for amazing clarity. The Mac II, Mac Ilx, Mac Ilcx, and Mac SE/30 all have a 
much more sophisticated sound generator known as the Apple Custom Sound 
Chip (ASC) that does four-voice wave table synthesis and is capable of driving 
stereophonic mini-phone-jack headphones or stereo equipment. This improved 
sound technology makes the Mac a logical machine for tying sound and images 
together through applications or specialized musical interface devices, called 
Musical Instrument Data Interface or MIDI. 

Keyboards 
PC keyboards have undergone some changes over the years, though the basic 
components remain-function keys, modification keys (Control, Alt, and Shift), 
basic typewriter keys, and the numeric keypad which doubles as a cursor 
control pad. Some keys have been added and other keys moved, but the basic 
functions remain. 

The Mac keyboard has undergone more considerable change. The early Macs 
were delivered with a 58-key keyboard that closely resembled a standard 
typewriter keyboard and lacked the numeric keypad. Later Macs were 
available with 78-key keyboards-adding the keypad and eventually slimming 
down the design. Finally, the so-called extended keyboard mimics the popular 
AT-style keyboard used on PCs-right down to the function keys. 

Although the function keys are almost entirely ignored by Mac applications, 
they can serve a purpose during the operation of DOS software, which may be 
run on the Mac II using a DOS coprocessor. 
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Mac and PC keyboards are similar, with the exception of the Option key (simi­
lar to the Alt key on a PC keyboard) and the Command key. The Option key is 
used to get an optional or accented character set. You can view the optional key 
sets by choosing Key Caps on the Apple menu, holding down the Option key 
and pressing keys on the keyboard. The optional characters will display in the 
Key Caps window. 

The Command key, when used with another character key, is a shortcut to a 
menu command. Menu options that support shortcuts list the appropriate 
Command-character next to them. PC users will discover that the Command 
key is the Mac's functional equivalent of the PC's Control key. The Mac II 
extended keyboard also features a true Control key for use with DOS software. 

The Command key is also used as a Break key on the Mac to stop long opera­
tions. To break a process, press the Command and Period keys at the same 
time. 

The Mac can also support the qwerty or Dvorak keyboards; however, not all 
programs support the Dvorak key layout, and special drivers are normally 
necessary for its operation. 

Pointing Devices 
Although the mouse is an option on today's PCs, it is hardly an integral part of 
the machine's environment. 

The Mac uses the mouse and other pointing devices as integral parts of the user 
interface. The mouse is used to navigate through menus as well as mark areas 
of text or graphics for cut/paste operations or for deletion. The integration of 
the mouse into the user interface has made the Mac an excellent machine for 
graphics manipulation, text manipulation, and just plain fun-the mouse is 
also used for the many games that are available for the Mac. 

There are several pointing devices used by the Mac. These devices are the 
standard Apple tracking mouse, infrared mouse, trackball, fingerpad mouse, 
and graphics tablet. 

STANDARD APPLE TRACKING MOUSE. The standard Apple tracking mouse 
uses a ball in a socket to determine motion and speed of the mouse movement. 
The ball spins against rollers, which trigger photoelectric devices to help 
determine movement. These photoelectric devices transmit the relative codes to 
the system which in tum moves the cursor on the screen. Most PC mouse 
devices use similar systems. 

INFRARED MOUSE. The infrared mouse uses a light-emitting diode (LED) 
which is positioned on a grid plate. Moving the mouse over the grid allows the 
diode to differentiate the distance, speed, and direction of the mouse's move­
ment by bouncing light off of the grid into a photo-sensitive cell. 
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TRACKBALL DEVICE. At first, the trackball device appears to be an upside­
down tracking mouse! The trackball works on a principal similar to the 
standard tracking mouse. 

FINGERPAD MOUSE. The fingerpad mouse is a small device that allows the user 
to guide the cursor by the movement of a single finger. Selections are made 
(button-up/button-down events) by pressing the finger into the pad. 

GRAPHICS TABLET. A graphics tablet (also known as a stylus pad) is a flat pad 
that serves as a drawing surface. A pen-like apparatus allows the user to draw 
on a paper residing on the pad. The motions of the pen are duplicated on 
screen by the cursor. Graphics tablets are excellent for tracing artwork or 
inputting data by hand. 

Printers 
When selecting a printer, PC users have been continually faced with 
monumental decisions. Should they choose a serial or parallel printer? Is there 
a port available to support the new printer? Will the printer require a special 
driver and, if so, will it be compatible with existing software? 

There have always been many different printer models available for the PC. 
Most early printers were either dot matrix or daisy wheel printers. Although 
this wide selection gave users many choices of styles and features, it also had 
the same effect that the diversity of video display options had-a compatibility 
conflict. 

It became the job of each PC program to supply appropriate software that 
would allow communication with each different printer model and type. 
Because not all programs include printer drivers for all models, many printer 
owners found their printers either useless or only partly functional with certain 
software. 

In its design of the Mac, Apple went to great lengths to ensure these would not 
become issues for Mac users. Selecting and installing a printer is fairly easy and 
straightforward on the Mac. 

The Mac computer uses the LocalTalk connector as the printer port during 
cable installation. This port is also used on the AppleTalk network. Generally, 
any printer that is connected through the LocalTalk port becomes available on 
the AppleTalk network. Most Macs use a simple print device driver installed 
with the system. The user selects which printer to use by selecting the 
appropriate driver in the Chooser window (see Chapter Four for more about 
the Chooser). After selecting the printer driver and directing the software 
package to print, the Mac uses the Printing Manager to manage printing 
resources. 
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Apple selected the QuickDraw language as the standard output language for 
printing. QuickDraw was the standard printer language until the introduction 
of the LaserWriter, which used a new page display language called PostScript 
from Adobe Systems. The Mac can translate QuickDraw into PostScript. 

Apple designed the printing scheme to simplify installation and use; however, 
many printers still don't conform to the Apple cabling requirements, or have 
print drivers unusable on the Mac. The next section will provide a brief over­
view of third-party solutions that can bring these printers to your Mac 
environment. 

DOT MATRix PRINTERS. The most common printers are dot matrix printers. 
These printers use tiny pins that impact the paper in a vertical array, pressing 
on inked ribbon as the pins strike the paper. Dot matrix printers form images 
and letters by printing these dots in a pattern. The most common brands are the 
Epson FX series, C. Itoh printers, Citizen printers, the ffiM ProPrinter series, 
and the Apple Image Writer series. 

lmageWriter. The standard Apple dot matrix printers are the Apple 
ImageWriters. ImageWriters print all of the Mac screen fonts and graphics and 
will work with almost all programs that work on the Mac. They support draft, 
standard, and near-letter-quality (NLQ) modes. 

The ImageWriter operates by printing the bitmapped image in bands. The 
image printed on paper will not look exactly like the screen image, since the 
system adds additional dots to the paper to do high-resolution printing. 

ImageWriter II. The ImageWriter II is the entry-level printer. It supports three 
different modes: draft, mid-speed correspondence, and near-letter-quality. The 
Image Writer II also can also be equipped with a one-bin, cut-sheet feeder or can 
use tractor-fed paper. It supports color printing with the use of the 
ImageWriter II color ribbon. 

ImageWriter LQ. The ImageWriter LQ is a higher quality dot matrix printer 
designed for high-end processing such as office print work. The ImageWriter 
LQ prints letter-quality correspondence. Like its counterpart, the ImageWriter 
II, the ImageWriter LQ supports color printing. It also supports printing on 
multi-part forms as well as labels. A key peripheral attachment is the cut sheet 
feeder with up to three bins to handle different letterheads and an envelope 
attachment. 

LASER PRINTERS· The first really popular laser printer was the Apple 
LaserWriter. Many more PC users also have discovered laser printing. Many 
actually use the LaserWriter, which is compatible with computers other than 
the Mac. Also popular is the Hewlett-Packard LaserJet. Though it started with 
the Mac, laser printing has become a standard and has solidified the Mac's po­
sition as an industry leader. 
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The Mac supports laser printers in a very different way from the PC 
environment. PC printers often require the addition of a special board to 
support anything but basic text printing, or they require the specific application 
to generate output in a way that is acceptable to the printer. The Mac uses a 
single laser printer driver (specified by an icon in the Chooser) to convert 
Macintosh QuickDraw output to PostScript output. This frees the user from 
having to specify a printer-support driver each time the application is 
launched. 

The LaserWriter, LaserWriter Plus, LaserWriter IISC, LaserWriter liNT, and 
LaserWriter IINTX are Apple's current offerings. The LaserWriters will work 
with other computers, either through the serial port or over the AppleTalk 
network. 

LaserWriter and LaserWriter Plus. The LaserWriter and LaserWriter Plus are 
based on the Canon LPB-CX engine. Both of these printers have a Motorola 
68000 CPU operating at 12 megahertz (MHz). These printers come with 2MB of 
RAM for image printing and processing and up to 160K of RAM for font 
caching. These printers were originally designed for light printing tasks. 

The LaserWriter is a PostScript printer, which means it relies on the printer 
driver to convert the QuickDraw output into PostScript to print. This printer 
can also act as an ASCII text printer. Its default font (Courier) emulates the 
Diablo 630 daisy wheel printer. 

LaserWriter IISC. The LaserWriter IISC is a major departure from the rest of 
the Apple LaserWriter family in that this printer uses QuickDraw rather than 
PostScript. The LaserWriter IISC is based on Motorola's 68000 CPU operating 
at 7.45 MHz. The LaserWriter IISC is totally dependent on QuickDraw output 
because there are no built-in fonts. The LaserWriter IISC has only 1MB of RAM 
internally. It is operated from the SCSI port. 

LaserWriter liNT. The LaserWriter liNT is PostScript printer based on the 
Canon SX engine. This printer also has a Motorola 68000 CPU that operates at 
12 MHz. This printer has 2MB of RAM for processing and printing including 
200K for font caching. The LaserWriter liNT has a distinct advantage over the 
LaserWriter Plus in that it can interface with the Apple Desktop Bus (ADB) as 
well as the AppleTalk or serial port. Also, it is considerably lighter and smaller 
than the Plus and has advanced paper-handling capacity. The LaserWriter 
IINTX supports envelope printing as well as standard 81/2-inch x 14 paper. 
The LaserWriter liNT can be upgraded to a LaserWriter IINTX. 

LaserWriter IINTX. The LaserWriter IINTX is the top-of-the-line Apple laser 
printer as of this writing. This printer comes with a Motorola 68020 CPU 
operating at 16.67 MHz. The LaserWriter IINTX is a PostScript printer that also 
supports Diablo 630 daisy wheel and HP LaserJet Plus emulation. The printer is 
delivered with 2MB RAM installed, which can be expanded to 12MB. This 
printer operates from the Apple Desktop Bus (ADB), the SCSI port, serial port, 
or LocalTalk port. In addition, the IINTX has a special SCSI port available to 
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interface with a hard disk designed to store fonts. This is especially useful in 
high-volume professional printing situations in which a very large number of 
fonts must be made available (such as in printing houses or publishing 
companies). 

Other Laser Printers. The Mac can support many other laser printers on the 
market today. Almost any laser printer that supports PostScript may be 
connected to a Mac. The price varies greatly, but deciding factors for the user 
should be ease of use and compatibility. There are too many third-party laser 
printers that interface with the Mac without modification to settle for one that 
requires special hardware or converters. Be aware of hidden requirements for 
non-standard components when you shop for a laser printer. 

Other Printing Solutions 
It is possible to use other kinds of printers with the Mac. If you are a PC user, 
there is a good chance that you already have invested in another printer for 
your PC. You may have a daisy wheel printer or even a thermal transfer printer 
or plotter-all types of hardware that Apple doesn' t manufacture. In most 
cases, there are ways to get your device to work with the Mac. 

Most of the printer conversion software and/ or hardware packages require the 
printer to be a serial-connected device. Parallel printers need a parallel-to-serial 
conversion device even to begin using the Mac printer converters. These 
converters supply either new device drivers that take the place of the 
ImageWriter device drivers or new cards for the printers to allow direct 
ImageWriter printing. 

While printer conversion kits are readily available, it is recommended that they 
be considered only for utilizing an already existing-printer. If you don' t already 
have a printer, the differences in print quality, speed, and ease of use offered by 
Apple's line outweigh any cost benefits the user might get by buying a third­
party printer not specifically designed for the Mac systems. 

Other Devices 
The Mac supports numerous other devices that are not standard or essential to 
most users' operations. These devices run the gamut from new input devices 
(scanners and MIDI devices), to backup devices (Tape Backup Units). While 
most users will want to explore these items, there are too many of them to 
cover in this book. 

The following devices are Apple equipment we feel are significant additions to 
the Mac line. However, there are many excellent third-party scanners and FAX 
machines available for use with the PC as well as the Mac. 

APPLE SCANNER. With the increased importance of computerized graphics, 
especially in desktop publishing applications, scanners have become widely 
used. Scanners are used to read both text and graphic information into a 
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computer file format for incorporation in applications. With the addition of 
optical character recognition software (OCR), many scanners can read text from 
a printed page and put it into a word processor format. 

The Apple Scanner is an optical image scanner for inputting high-quality 
images and text into the Mac system. The scanner supports line art, gray scale, 
and half-tone modes. The scanner works with any Mac application that sup­
ports Picture File Format (PICT), Tagged Image Format (TIFF), or MacPaint file 
formats. These three formats are the most common graphic formats used on the 
Mac, and both PICT and TIFF can be used by some PC applications. 

The Apple Scanner comes with its own application which allows complete 
control over imaging, brightness control, scan area, and pattern control. It also 
allows you to reduce or enlarge the scanned image, and lets you scan at 
variable dots per inch (dpi) so images can be accessible to the AppleFax modem 
and Apple printers. The scanner is connected to the computer through the SCSI 
interface. 

APPLEFAX MODEM. The fax has become a necessity in business almost 
overnight. The convenience of being able to transfer hardcopy information at 
electronic speed has caused a revolution in information sharing. 

The AppleFax Modem allows for convenient sending and receiving of facsimile 
files and performs high-rate Mac file transfers (9600 bps). The AppleFax 
Modem supports facsimile transmissions to Group 2 and Group 3 facsimile 
machines (which equal more than 90 percent of the installed base). 

The AppleFax Modem is delivered with two pieces of software, the AppleFax 
Resource file and the AppleFax Application Program. The resource file acts like 
a standard printer resource and is accessed through the Chooser. The 
application is an easy-to-use program that allows users to send and receive fac­
similes and Mac data files. 

FuTuRE COMrATIBILITY. There are many, many hardware options available for 
the PC and the Mac-again, too many to discuss in just one chapter. The single 
most impressive thing about the Mac is the upward and downward 
compatibilty of both hardware and software. Apple has gone to great lengths to 
ensure that your hardware is not made obsolete by the addition of new 
components or systems. The introduction of the Mac ll and Mac llx brings the 
power of many minicomputers to the desktop. 

PC users who have struggled with incompatible boards and drivers often find 
the Mac a welcome relief. Users who have come to expect application 
incompatibilities due to device settings or variances in drivers between 
applications embrace the Mac's ingenious approach to peripherals. 

This ease of use, speed, and ongoing compatibility have made Mac systems 
among the most user-friendly in the world. 
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GOING FORWARD 
The Mac and the PC differ in many ways, yet they perform the same basic 
functions. They use different CPUs, different bus architectures, different video 
technology, and even different sound. But they both help us with our 
information and communication needs. 

It is possible to connect these diverse systems, both by telephone (via modem), 
by direct wire connections, by installing a coprocessor or other compatible 
equipment, or by networking. 

The next chapter covers connectivity issues-both Mac to Mac and PC to Mac. 
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Connections 
When the Macintosh was first introduced, it was very much a machine in 
isolation. Even though the important structures were in place that would link 
Macs to each other, there was no network software to provide that link. 

Like its predecessors at Apple-the Lisa and the Apple 11-the Mac had no 
imitators, and its operating system and environment were unique. There was 
almost no way for the Mac to communicate with other machines. This was in 
marked contrast with the IBM PC, which had already spawned a booming 
industry of imitators and already had ways of linking with other PCs and 
mainframes. 

Until 1986, the primary interest in Mac connectivity was in linking with other 
Macintosh systems and peripherals. As the Mac grew in popularity and utility, 
it became increasingly desirable to be able to link it with other systems-most 
notably DOS machines, which predorninanted in the business community. 
Viable connectivity and data-sharing solutions would help the Mac penetrate 
PC-dominated work environments. However, three factors made this 
challenging: 

• The operating systems were so different--one text-based, linear, and 
command-oriented and the other graphic and process-oriented-that there 
was too little common ground for an easy solution. 

• Many businesses had already invested heavily in IBM mainframes and PCs. 
Bringing in an incompatible new machine did not make good business 
sense. 

• The majority of users had become accustomed to the PC way of working 
and were skeptical of the Mac. 
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The first two factors could be met by providing greater compatibility or linking 
between the Mac and the PC worlds. The third began to be overcome when 
individual Macintosh users brought their personal Macs to work and other 
users saw how easy they were to use. 

The Mac got a definite boost with the introduction and widespread acceptance 
of desktop publishing and laser printing. As more and more Macintoshes 
appeared in businesses, so d id the ways to connect them with other machines. 

In the past few years, many solutions have been developed to bring the Mac 
closer to the PC. These solutions fall into several categories: 

• Add-on disk drives 
• Coprocessors 
• File translators 
• Telecommunications 
• Direct cable connections 
• Networks 

Each of these methods has one or more appropriate uses. In this chapter, we'll 
take a look at the pros and cons of each. 

First, we' ll introduce some of the ways you can use Macs and PCs to translate 
and share information on a single workstation. These solutions include 
specialized disk drives, coprocessors, and file translation software. In the 
second part of the chapter, we'll introduce solutions that require two 
workstations-direct cable connections and telecommunications. Finally, we'll 
look at multi-system solutions and discuss network basics and some of the 
specific network solutions available to connect Macs and PCs. 

SINGLE-SYSTEM SOLUTIONS 
There are several ways to translate information to and from the PC and the 
Mac-disk drive add-ons, coprocessors, and file translation software. Each of 
these solutions has specific advantages and disadvantages. For instance, 
though an add-on disk drive may offer a relatively low-cost method of moving 
files between two machines, this method requires you to copy data onto a disk 
on one machine, and hand-carry the disk to the second machine. 

In each of the following discussions, you'll see a list of advantages and 
disadvantages. This list should give you a quick guide to the kind of solution 
being discussed. If you find solutions that meet your needs, we recommend 
you look into them further by contacting the companies listed at the end of this 
book. 
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Disk Drives 
For low-volume file transfer and conversion, disk drive add-ons offer a 
combination of ease-of-use and low cost. Special disk drives may be added to 
the Mac or the PC to read and write across formats. 

There are several add-on solutions available for sharing files between the PC 
and the Mac. Two devices attach to the Macintosh, one to the PC. In addition, 
Apple has introduced a new drive featured in the Macintosh Ilx, Ilcx, and 
SE/30-a 1.44MB 3 l,l.l-inch floppy drive that can read and write PC formats. 

PROS AND CONS. 

Add-on drive advantages: 

• Disk drives are very easy to use and to set up. 

• In some cases, disk drives can be moved easily from one system to 
another. 

• Compared with network and co-processor solutions, drives are 
relatively inexpensive. Disk drive options tend to be in the middle of 
the price spectrum. 

• Disk drives are very convenient to use because they generally fit in as 
an integral part of the operating enviroment. 

Add-on drive disadvantages: 

• Disk drives can only handle a limited volume-the amount that will 
fit on one floppy disk at a time. 

• Files must be hand carried between machines (on floppy disks). 

• Drives require additional desk space, which can be a problem in 
crowded work environments. 

• Using a disk drive requires that you use a copy of a file. In contrast, 
PC and Mac users could share the same file on a network. 

SOLUTIONS. 

Apple 5 l t4-inch PC drive. The Apple PC 5 1 /4-inch drive is a simple 360K PC 
drive that can be attached to a Macintosh SE or Mac II using a special add-on 
board supplied by Apple. This drive has limited usefulness-working with 
Apple File Exchange (AFE) and with AST's Mac286 co-processor boards (see 
below) for the Mac II. The Apple PC drive is housed in beige plastic to match 
the Mac design. It is heavier than the average PC drive and slower in operation. 
In addition, its drive door lacks an indentation to facilitate removal of disks. If 
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the spring inside the drive does not eject the disk far enough, it is difficult to 
remove. However, at this time, this drive is required to load the software for 
theMac286. 

DaynaFile. A more complete disk drive solution is the DaynaFile--a dual drive 
add-on device that can work with any Mac that has a SCSI port. 

The DaynaFile is an elegant solution for several reasons. First, it works with 
any Mac that has a SCSI port, while many other file-sharing solutions are 
limited to certain models. Second, it can be configured with any combination of 
PC drive types-3 1 /2-inch as well as 5 1 I 4-inch. Third, it is fully usable from 
the Mac desktop; although the drive reads and writes in the PC format, it can 
be opened by any Mac application. In contrast, the Apple drive can only work 
directly with AFE. 

What this last point means is that files can be transferred directly, even from 
within a program. Suppose, for example, you have a Word or WordPerfect 
document on the PC and you want to process it on the Mac. Simply copy it to a 
floppy disk, then take the disk to the DaynaFile and insert it. Open Word or 
WordPerfect, and open the file directly from the PC disk. The file will open 
without problems. 

DaynaFile works very well, although it is slower than the ordinary PC drive. Its 
main advantages are convenience, simplicity, and relatively low cost when 
compared with network solutions. Because it doesn't require any dedicated 
cabling, it can work in remote locations as well as office environments. 

One unique use of the DaynaFile is not specific to the Mac, however. By 
configuring the DaynaFile with one 51/4-inch drive and one 3 1f2-inch drive, it 
becomes a convenient and quick method for converting PC files between the 
two standards. This is especially helpful when moving between IBM PS/2 
machines or laptops using 3 1 /2-inch diskettes and the standard PCs which use 
51/4-inch formats. To copy the contents of one type to the other, you just insert 
the source and destination disks, then drag the disk icon of the source disk over 
the icon of the destination disk. That's all there is to it. 

MatchMaker. MatchMaker takes another approach. MatchMaker is actually a 
PC plug-in card and software that will read and write to and from a standard 
Mac floppy drive. Using the MatchMaker card and one of Apple's disk drives 
allows file sharing between the Mac and the PC. MatchMaker software includes 
a superset of DOS commands to manage the files on the Mac drive, even 
allowing control over file type and creator type (see Chapter Three for an 
explanation of these unique Macintosh resources). MatchMaker is a good 
alternative for people who prefer the DOS interface, but it lacks some of 
DaynaFile's convenience-especially when it comes to opening files directly 
from within applications. 

MatchMaker is the least expensive disk drive solution (if you don't count the 
cost of the required Mac drive that attaches to the MatchMaker card). The cost 
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of a Mac BOOK floppy drive can add several hundred dollars, but many people 
will be able to use a Mac floppy purchased with their original systems. 

Coprocessors 
The PC and the Macintosh use completely separate central processors (see 
Chapter Six for more information about CPUs). These two distinct CPUs 
require different instructions and process information in different ways-partly 
explaining why you can't simply use software from one machine directly on 
another. 

One way to get around the problem of these CPU differences is to place the 
processor chip of one machine directly inside the other. Though this is a 
simplistic explanation, it is essentially what a coprocessor does. 

There are currently three coprocessing solutions for the Mac-MacCharlie, 
Mac286 (and Mac86 for the Mac SE), and SoftPC. Two feature hardware add-on 
equipment that contains an 8080-family chip and other circuitry to mimic a PC 
inside a Mac; the other does virtually the same thing but entirely in software. 

PROS AND CONS. 

Coprocessor Advantages: 

• Coprocessors allow you to integrate information very smoothly between PC 
and Macintosh applications. 

• Coprocessors let you use the same file in both environments (depending on 
the file's format and the applications used, of course). 

• Coprocessors let you transfer information from a PC program to a Mac 
program (or vice versa) by cut-and-paste using the Macintosh Clipboard. 
This makes the direct sharing of information within files both easy and 
convenient. 

• Coprocessors allow you to view and work with both DOS software and 
Macintosh software on the same screen. With MultiFinder, you can switch 
quickly and easily from one environment to the other. 

Coprocessor Disadvantages: 

• Coprocessors support only one user at a time. In contrast, a separate PC 
facilitates data- and file-sharing and also provides two separate machines 
that can accommodate two separate users at any one time. 

• Having one machine double as both PC and Mac may increase the work 
load of that machine and might cause bottlenecks in busy offices. 

• Coprocessors lack some options available with a separate machine; for 
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instance, higher screen resolutions, peripheral connections (1/0), expanded 
and extended memory. 

• Current coprocessor solutions limit the size of the OOS window on the Mac 
screen and don't allow screens as large as an ordinary PC screen. 

SOLUIIONS. 

MacCharlie. MacCharlie is an add-on unit from the makers of DaynaFile that 
emulates a dual-floppy 8088 PC-type computer umbilically attached to a 
Macintosh. It is possible to switch between a PC session and a Mac session at 
will, and the Clipboard is used to transfer data. Otherwise, the two 
environments remain apart. MacCharlie does take up less space than a PC 
because it is a smaller unit and shares the screen and keyboard of the Mac. But 
when you consider the cost, it is probably easier to get a PC clone and use one 
of the direct link solutions mentioned below. 

Mac286. The second coprocessing solution is the Mac286 board for the Mac n. 
Actually consisting of two plug-in NuBus cards, the Mac286 is like having an 
AT clone in a Mac. (NuBus is Apple's proprietary bus structure, Apple's answer 
to IBM's micro channel architecture.) Just about anything the PC can run, the 
Mac286 can run. In fact, the Mac286 even shares a hard disk with the Mac II 
and installation is an exact replica of the standard DOS FDISK process. It is 
uncanny how well the Mac286 emulates a PC while residing in a Mac II. 
Although early versions of the product were plagued with poor screen 
handling and keyboard irregularities, the newer version is highly satisfying. 
Mac286 is a very useful product for people who want both standards under one 
roof, so to speak. 

Mac286 comes with 1 MB of RAM, of which 640K RAM is available for a PC­
compatible operating system. It can emulate monochrome, Hercules, and CGA 
graphics (although the CGA graphics may not be satisfactory when running 
certain highly animated programs). It can create its own subdirectories on the 
portion of the Mac hard disk it shares and can also access a special folder on the 
Mac, which it sees as a D drive. This D drive allows easy file sharing between 
the Mac and the coprocessor. Using MultiFinder, it is easy to switch from PC to 
Mac, and you can use the Clipboard to move data back and forth. 

The Mac286 emulation takes place in a standard Macintosh window that can b~ 
moved anywhere on the screen and resized. 

Soft PC. Soft PC is a remarkable achievement in programming, which 
simulates an 8086 M5-DOS machine on a Macintosh without the use of any 
additional hardware. The entire simulation is programmed. Moreover, the 
resulting coprocessing environment is compatible with the PC, and we haven't 
found any applications software that won't work with it. 
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As remarkable as this product is, SoftPC does have a few drawbacks. For one, it 
requires a lot of memory. An optimal configuration requires 2.4 MB, though the 
product can be installed in a thriftier configuration (1.7MB) with some loss of 
performance. 

SoftPC must be installed using a DOS 5 l f4-inch drive, like the one from Apple; 
however, once installed, it will also work with the DaynaFile, but only as an 
extra drive (E). Like the Mac286, you can use drive E to share files between the 
Mac and Soft PC. 

The Soft PC emulation takes place in a standard Macintosh window that can be 
moved anywhere on the screen. You can display the screen in one of two 
sizes-standard or zoomed. The zoomed image takes up about the space of a 
standard Macintosh 9-inch screen, but it doesn't expand on bigger monitors. 

Soft PC is relatively slow compared with Mac286 or any turbo-charged PC. 
Though it is a satisfying solution technically, its use of memory and its speed 
limit its appeal. With enough memory, it will work on a Mac SE, so it may be 
an alternative solution for SE owners who need a coprocessing solution. 

Conversion Software 
Apple is committed to bringing the Macintosh and the PC closer together. One 
tangible result of that commitment is the Apple File Exchange (AFE) software 
that comes bundled with the Apple system files. AFE is a utility that allows the 
conversion of files to and from the Mac and the PC formats. 

Although Apple doesn't provide much in the way of actual conversion 
software to accompany AFE, the door was left open for third-party vendors to 
add conversions to the system. The major supplier of AFE translators is 
Data Viz, whose Mac Link product was one of the first to offer such translations 
(even before AFE came out). Data Viz offers a set of more than 40 specific 
conversions that can work with AFE to make it easy to move data from one 
format to the other. The DataViz translators are available directly from 
Data Viz, with their Mac Link product (see later in this chapter), or from retail 
outlets. 

These translators are used to convert the file structure of one program or 
machine type to another. For instance, a specific translator might convert 
Macintosh ASCII files (which lack the line feed character at the end of each line) 
to PC ASCII files (which contain a line feed for each carriage return). That is a 
simple example, but more complex translators might convert a MacWrite 
word-processed document into a Word document, or a list of text information 
to a dBASE format, for example. 

Translation software is also available with other products. For instance, many 
word processors, databases, and spreadsheets read and write the files of other 
products. As explained in Chapter Six, some Mac applications can work with 
files from PC products. For instance, dBASE Mac can read and write the 
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dBASE Ill format and Excel and Full Impact can import 1-2-3 files. Word, 
WordPerfect, PageMaker, VersaCAD, and AutoCAD are all examples of 
products that have both PC and Mac versions and allow file sharing without 
separate conversion. 

Neither the AFE solution nor compatible software will help much if there is no 
way to move data from one place to the other. To do that often requires one of 
the other solutions described in this chapter. 

Finally, it is important to remember that translating a file from one format to 
another means that you have created an entirely new file. If the file must return 
to its original system, it will have to be translated back again, creating yet 
another file. 

Converting Graphics 
While ordinary file translators will convert text and specific document formats, 
they do not support graphic formats. However, there are some solutions for 
converting between PC graphics and Mac graphics. 

To view Mac graphics on a PC, there are several shareware and public-domain 
programs that will work. For actual conversion, you may want to try The 
Graphics Link, a product that converts MacPaint-style pictures to various PC 
formats and back to Mac. From Inset, Hijaak converts a variety of different PC 
formats to Mac format, and also converts images to MacPaint format. A 
shareware program called Optiks is also available. Optiks converts a wide 
range of PC formats, and includes MacPaint as one of its many options. 

At present, nothing converts the more detailed PICT formats, which are used in 
drawing programs like MacDraw. 

A more-or-less recent file format, the GIF format for graphic images, is 
becoming popular on both systems. In theory, GIF documents should be 
interchangeable. 

DUAL-SYSTEM SOLUTIONS 
Disk drive add-ons, coprocessors, and file sharing require the resources of one 
computer at a time. However, some file sharing solutions directly involve two 
computers simultaneously. One solution-the direct cable connection-is 
useful almost exclusively for file sharing. The other dual-system 
solution- telecommunications-can be used for many other purposes, in 
addition to file sharing. For more information about PC/ Mac 
telecommunications, see Chapter Five. 

198 



Connections 

Direct Connection 
One of the easiest ways to connect a PC and a Mac is the direct cable 
connection. This is generally accomplished by hooking a serial cable from the 
Macintosh modem port to a serial port on the PC. Special software then drives 
the file transfers. 

PROS AND CONS. 

Direct connect advantages: 

• Because they require no significant hardware additions, direct cable 
connections are relatively inexpensive-typically under $200. 

• Direct cable connections operate at very fast file transfer speeds-typically 
many times faster than modems-comparable to network transfer speeds. 

• Direct cable connections can quickly transfer several files at a time. 

Direct connect disadvantages: 

• Like disk drives, direct connections don't allow users to work with the same 
file but only to transfer a copy of the file from one machine to the other. 

• Direct cable connections require the machines to be in close proximity 
(about 10 or 20 feet apart). 

• Direct cable connections generally require dedicating both machines to file 
transfer operations during transfers. 

• Direct cable connections occupy one port on the Mac and one serial port on 
the PC. Since these ports are often needed by other devices, users may have 
to disconnect and reconnect the cables frequently. 

SOLUTIONS. 

MacLink Plus. MacLink Plus is a direct-connect file transfer system from 
Data Viz. This was the first solution of its kind offered. It comes with 
appropriate cabling to connect the Mac's modem port to a serial port on a PC. 
Files are transferred at up to 56,000 baud. The MacLink Plus system includes a 
full set of file translators to convert files between PC and Mac formats. These 
translators work with MacLink Plus or Apple File Exchange software 
distributed with the Macintosh System files. 

LAP-LINK Mac. The makers of LAP-LINK (PC Magazine's 1987 Product of the 
Year), now have LAP-LINK Mac, offering file exchanges at up to 56,000 bits per 
second, supporting multiple file transfers. It comes with a universal cable for 
connecting between a variety of Macs and PCs. LAP-LINK has various ver­
sions, which allow transfer of data from desktop PCs to laptop computers as 

199 



Chapter Seven 

well as desktop PCs to Macs. Many users find LAP-LINK an excellent tool for 
moving data where a network or disk transfer is not sufficient. 

QuickShare. Falling somewhere between the disk drive solution and the 
dedicated cable link is QuickShare from Compatible Systems. QuickShare 
consists of a SCSI board for the PC, along with special dedicated cabling that 
connects from the PC board to a SCSI port on the Mac. The QuickShare solution 
lets you dedicate a portion of a PC disk to look and act just like a SCSI drive 
does to a Macintosh. From the PC's perspective, the dedicated portion of the 
disk looks like one large file. From the Mac's perspective, it looks just like any 
SCSI drive. 

Using QuickShare, the two machines can share files quickly (at up to 1.4 million 
bits per second). In addition, the QuickShare drive can even be used as a boot 
drive for the Mac. Since PC hard disks are less expensive than Mac hard disks, 
this may be an economical way to add storage capacity to the Mac. The PC 
drive can also act as a file server for an AppleShare network. 

QuickShare does require a dedicated cable from the Mac SCSI to the PC card; 
therefore, the machines should be close to each other. 

Telecommunications 
PROS AND CONS. 

Telecommunications Advantages: 

• Telecommunicating is most useful and convenient for occasional file 
transfers. However, because the telecommunications link must be 
established each time you want to share data, this method is not preferable 
where constant access is required. In such cases, a network is preferred. 

• Telecommunications uses standard 1/0 ports, modems, and telephone 
lines-all ordinary equipment used in other everyday operations. In 
contrast, most other solutions require the addition of specialized 
equipment. 

Telecommunications Disadvantages: 

• Telecommunications solutions, like disk drives and direct connections, 
require that you work with copies of files, not the files themselves. You 
can't work directly on the same file in both the PC and the Mac 
environments. 
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• When compared with other solutions, telecommunications is relatively 
slow. For instance, the highest practical telecommunication speed is current­
ly around 56,000 bits per second (although higher transfer rates are 
possible). Direct cable connections can operate at 56,000 bits per second and 
above, while networks and disk drives may be even faster. 

• Telecommunications can tie up two computers for some time-depending 
on the size and number of files to transfer. Some exceptions may exist 
where the telecommunications software is capable of working in the 
background or during non-working hours. 

SOLUTIONS. 

Telecommunications is a good alternative for occasional data sharing. Using a 
simple setup of modems on each machine, data can be transferred at rates up to 
19,200 bits per second (with today's high-speed modems and ideal conditions), 
although, typically, transfer rates closer to 2400 baud are financially more 
feasible. Telecommunicating is not, however, a very useful alternative where 
sharing must be frequent, unless each machine has a line that can be dedicated 
to telecommunications on a regular basis. It becomes more feasible in conjunc­
tion with telecommunications programs on the Macintosh such as Red Ryder 
10 or Smartcom II, Version 3.0, or programs like the brand new TSR collection, 
Sidekick Plus on the PC. All can be set either to run automatically at a specific 
time or to operate in the background. 

Another telecommunications solution is the remote access program. Programs 
like Carbon Copy, PC Anywhere, and CloseUp have been popular on the PC 
for years. Now, the people who make PC Anywhere have developed PC 
MacTerm, a companion product that allows a Mac user to operate a PC 
remotely. 

One of the fastest-growing areas in Macintosh connectivity involves remote 
access to computers and networks. This method of connectivity allows a single 
user or group of users to connect to Macintosh systems or networks at remote 
facilities or locations. 

Remote data access is split into two areas: remote data access and remote bridging. 
Remote data access allows a single user with a modem access to a remote 
AppleTalk network. Remote bridging lets one AppleTalk network connect via 
modem to another network. Remote services include disk access, file sharing, 
mail services, and printer sharing. 
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NETWORKS 
Perhaps the most powerful solution available is a network that can link 
multiple PCs and Macs. Although more complicated to set up and maintain 
and more expensive than other solutions, networks offer several important 
advantages. 

PROS AND CONS. 

Network Advantages: 

• Networks offer simultaneous file sharing and don't require copying files 
before using them on different systems. 

• Most networks include security options to impose restrictions on file 
access-something that other solutions don't include. 

• Networks offer the added advantages of inter-system mail options, which 
can be used to distribute copies of files to different systems. 

• On a network, access to files is usually immediate and requires no copying 
or conversion between compatible types. 

• Network file access and transfers are generally fast (at least when compared 
with telecommunications). 

Network Disadvantages: 

• Networks require more expertise to set up than other solutions. 

• Networks require maintenance. 

• Networks often use more memory overhead on host systems, thereby 
limiting the availability of memory for running programs. 

• In some cases, network drivers and software may be incompatible with 
other programs and applications, causing problems that must be traced. 

• Network hardware and software generally costs more than any other 
connectivity solution. 

• Wiring a network from one location to another may be difficult. 

Network technology has grown more sophisticated over the years, and 
networks have become increasingly common and accepted. As people use 
networks more and more frequently to connect PCs to PCs and Macs to Macs, 
the desire to connect to a multitude of different environments has become 
stronger. While simple PC-to-PC solutions abound, the average microcomputer 
user has become more sophisticated and is no longer satisfied with 
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communicating only with other network nodes. Many users now connect to 
mainframe, mini, and super microcomputers through a variety of methods. 

This chapter outlines the basic methods of communication for the Macintosh. 
Separated into three main categories, they are: communications facilities, 
networking, and asynchronous communications. 

The Macintosh Communication Facility 
Unlike the PC, which has no built-in connections other than serial or parallel 
ports, the Macintosh has been designed to communicate via an internal stan­
dard method known as LocalTalk. By setting a standard interface, LocalTalk 
simplifies the connectivity issue on the Mac. 

The Macintosh is equipped with two serial ports. The modem port is more 
suitable for high-speed communications, while the printer port is specifically 
designed for printer or AppleTalk use only. These ports can support a variety 
of communication devices. On the Mac II, add-in communication cards can also 
be added to allow additional connectivity solutions. 

The serial ports on the Macintosh systems vary from one model to another (see 
Appendix B). The earlier Macintosh systems, the Macintosh 128 and Macintosh 
512, were equipped with nine-pin serial connections. The later Macintosh sys­
tems, the Macintosh Plus, Macintosh SE, and Macintosh II, employ the newer 
round serial connector-the Mini-8 connector. These ports are controlled by an 
internal chip known as the Serial Communications Controller (SCC) chip and 
support both the RS-422 and the earlier (RS-232C) protocols. 

The terms LocalTalk, AppleTalk, and AppleShare are frequently thrown 
around when discussing the Macintosh printer port and some users may find 
the terms confusing. Additional confusion was created when, in 1988, Apple 
announced that, henceforth, AppleTalk and LocalTalk would have distinct 
meanings. 

• LocalTalk is actually the twisted pair cabling that connects the Mac printer 
and modem ports with other Macs, peripherals, and network equipment. 

• AppleTalk is the Apple communication protocol used with this port. 
AppleTalk is a protocol that may be used by non-Apple networks and 
cabling other than LocalTalk cables- for instance, PhoneNet and 
ETHERNET cabling. 

• AppleShare is Apple's file serving software usually used with the AppleTalk 
and LocalTalk system. 
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Network Topologies 
Networks come in two basic types: LANs (local area networks) and W ANs 
(wide area networks). LANs are the most prevalent type of network 
configuration implemented by microcomputer users. A LAN is made up of 
computers linked together by using a similar layout or hardware protocol. A 
WAN consists of several different network types spread across various 
locations and linked together via a similar connectivity method known as a 
backbone. This chapter deals mainly with LAN setups. 

Figure 7-1. Wide area network 
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The basic network configurations are known as network topologies. These 
topologies are industry-specific not computer-specific; that is, each topology 
could be implemented for a network of PC systems, Macintoshes, or DEC VAX 
systems. 

The main LAN topologies in use today are bus, star, and ring configurations. 

Bus Configuration. A bus configuration consists of a single line connecting all 
the nodes together. The line does not loop continuously. On the network each 
node is dependent only on itself and is not integral to the remainder of the 
network. In a bus configuration, the node continually checks the data line for 
network communications addressed to itself. If a node is disconnected or 
hangs, the network continues to operate and simply ignores the missing node. 
ETHERNET, LocalTalk, and IBM's PCnet broadband system are examples of a 
bus configuration. 

Figure 7·2. Bus configuration 

Star Configuration. This configuration depends on a central hub to handle all 
network data. The hub is critical to the operation of the network. If the hub 
fails, the network ceases operation. A mainframe serving PCs and Macs is an 
excellent example of a star configuration. 

0 0 

Figure 7·3. Star configuration 
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Ring Configuration. A ring configuration consists of a single closed line of 
data that depends on repeaters for each node to direct information to and from 
the node to the network data line. If a repeater on the line fails, the network 
stops. Because the repeater can regenerate the signal, the ring network can be 
spread over a large area. This configuration is used for very high performance 
network processing. IBM's Token Ring Network is an example of ring 
configuration. 

Figure 7·4. Ring configuration 

MACINTOSH-TO-MACINTOSH NETWORKING. Basic networking capability is 
built into the Macintosh through the AppleTalk protocol. Only the addition of 
LocalTalk cabling is needed to connect Macintosh printers together. Network 
software that accesses the AppleTalk protocol completes the installation of the 
network. 

The Macintosh System and Finder are equipped to allow users to do various 
low-level networking tasks such as print sharing, communication resource 
sharing (sharing modems), and a limited amount of file sharing, without extra 
software. 

Adding AppleShare software to a Macintosh configuration linked by LocalTalk 
cables adds a higher level of capability such as electronic mail services, file 
sharing, and application serving. AppleShare depends on the AppleTalk Filing 
Protocol (AFP) to handle file storage structures and expects all nodes on the 
network to be AFP-capable. While AppleTalk components are currently 
available to allow PCs to access the AppleTalk network, the solutions are slow 
and generally not preferable. 
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MACINTQSH-TO-PC NEIWORKING. Fortunately, manufacturers of popular PC­
based network systems have begun offering acceptable options that allow the 
Macintosh to coexist in the mainstream PC network world. Unfortunately, 
connecting to the existing network does not guarantee the user the ability to 
share files, since file structures and application differences between the 
Macintosh and PC may be markedly different. Therefore, connecting a 
Macintosh to a PC network faces two challenges: physically connecting the 
Macintosh to the PC-based network, and accessing and transferring data 
between the different devices on the network. As we saw earlier in this chapter, 
there are several solutions for translating file types. 

THE PHYSICAL CONNEOJON. There are two generally accepted methods for 
connecting Macintoshes and PCs for networking. The first method consists of 
adding an AppleTalk plug-in board to the PC, which effectively makes the PC a 
node connected to the rest of the Mac system via LocalTalk cabling. This 
method is used by networks such as Tops, TangentShare, and AppleShare PC. 
The main disadvantage to this method is its speed-LocalTalk is relatively 
slow. 

The other physical connection option for the Macintosh consists of bridging an 
AppleTalk network configuration to an ETHERNET backbone. Using 
ETHERNET speeds up the communications over the network and allows the 
direct integration of the Macintosh into the network bus lines. Using 
ETHERNET, you can still keep the AppleTalk configuration, which allows the 
system to tap into the built-in capabilities of the AppleTalk protocols. 

There are several devices available to bridge AppleTalk to ETHERNET, 
including several special gateways like Fastpath from Kinectics. Another 
option is the EtherTalk card for the Macintosh IT, available both from Apple 
and 3Com. In addition, both Tops and Dayna Communications have 
announced speed-up peripherals for LocalTalk networks. 

Several large PC network vendors offer software packages that allow the 
Macintosh to be recognized as a native node by the server. Besides allowing 
access to the server, these software drivers give the Macintosh access to higher­
level network services such as transparent file accessing between PC and 
Macintosh nodes, high-performance server based print services, and electronic 
mail services. 

There are several specific network solutions used to connect PCs and 
Macs-AppleShare and AppleShare PC, TangentShare, TOPS, 3Com's 3Plus 
and 3Plus for the Mac, and Novell networks. 
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AppleShare and AppleShare PC. AppleShare requires a dedicated Mac (or, 
using QuickShare, a dedicated PC) to act as a file server. A special AppleTalk 
card is required on each PC that is included in the network using the 
AppleShare PC software. Users on the network can share files residing on the 
server, and have access to various security options available at the folder level. 

AppleShare nodes can be linked to speed up network communications and 
data traffic via EtherLink gateways like the Kinectics Fastpath. However, 
without the use of EtherLink gateways, AppleShare is relatively slow. 

TangentShare. Tangent Technologies released their PC version of AppleShare 
in the fall of 1987. It does virtually the same things that AppleShare does. It 
works with either Apple's PC board (which Tangent developed) or a similar 
board from Tangent. TangentShare works well and, like AppleShare PC, offers 
full AppleShare networking to PC users. 

TOPS. TOPS is possibly the most transparent and easy-to-use network 
available for linking Macs and PCs. And it is the only major network solution 
that does not require a dedicated file server. Each machine on the TOPS 
network will work equally with the drives, files, and AppleTalk peripherals 
(like ImageWriter or LaserWriter) on each others machine. Although TOPS is 
only as fast at the LocalTalk network (which is pretty slow), it uses the TOPS 
FlashCard to run significantly faster from PC to PC than it does from Mac to 
Mac or Mac to PC. TOPS' FlashCard speeds the network communications of 
AppleTalk-based networks to three times the normal speed of AppleTalk 
communications. 

TOPS includes print spooling and network messaging, plus easy links to SUN 
Microsystems' UNIX workstations. TOPS is also more intuitive and requires 
less administration than any of the other PC to Mac network alternatives. 

3Plus for the Mac. The first major network manufacturer to support the Mac 
was 3Com. 3Plus networks can also include several PC systems running off one 
or more dedicated servers. 3Com offers full-service networks for larger 
installations, and includes full network mail, peripheral sharing, and much 
more. 

Unlike the PC side of 3Com, 3Plus for the Mac is very intuitive and easy to 
grasp. It is even possible to use the 3Com server to boot the Mac. 3Plus for the 
Mac is expensive to install when there is no existing 3Com network, but it 
makes a lot of sense if such a network is already in place. 

Novell. Novell has recently introduced a Macintosh version of its network. 
Novell's Netware for the Macintosh provides transparent access to the Novell 
network which may be configured to include OS/2- or 005-based servers or 
nodes. Novell provides users with a strong networking system that incorpo­
rates special features to ensure data security and data protection. 
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Asynchronous Communication 
MACINTOSH TO VAX AND BEYOND. In early 1988, Apple announced a relation­
ship with Digital Equipment Corporation (DEC) that paved the way for devel­
opers to open solutions for Mac-to-mini connections including the Mac to 
DEC's VAX mini. These solutions range from merely using the host systems as 
file servers, to actually "massaging" and downloading data from remote data 
files located on the mini. 

Connectivity. There are several ways to connect the Macintosh to the DEC 
VAX environment, but the most notable way is through an ETHERNET gate­
way. Kinectic's Fastpath allows AppleTalk-to-ETHERNET bridging to give the 
Macintosh access to the DECNET backbone. This access method allows the Mac 
to act either as a mere terminal (a dumb terminal) operating off the VAX or as a 
full computer using connectivity software to implement the VAX. These two 
connectivity methods are called remote file services (when the Mac acts as a 
dumb terminal) and remote file accessing (when the Mac acts as a computer 
connected to the VAX). 

Remote File Services. Remote file services use an external system as a remote 
file server. For example, a Mac can connect to the VAX operating system (VMS) 
via DEC's AppleTalk for VMS service. This partitions the VMS drive so that the 
Mac recognizes it as a Mac drive. This also gives other Macs that have access to 
the VAX host the ability to share and store files in the same place on the host. 
However, it does not give the Mac access to the other Vax files (for instance, the 
Mac can't access or understand QDBMS files. 

Remote File Access. Several new products use the ETHERNET connectivity 
solution to allow the Mac to become intelligent terminals to the host system. 
This gives the Mac user the ability to connect to a host system, select a host­
native data file, pass a select or search criterion, and download the information 
to the Mac for further processing or reporting. Additionally, this capability is 
bidirectional; that is, the user may enter data from his Mac to the host, or from 
the host to the Mac. This capability gives the Mac user access to a wider range 
and greater amount of data than ever before and gives the host system user 
access to the Mac's excellent graphics capabilities. 

GOING FORWARD 
Networking solutions are constantly in development, as are all aspects of the 
personal computer industry. In the future, we can expect to see new kinds of 
PCs as well as new kinds of Macintoshes. In addition, we will probably see new 
peripherals and new ideas that will be as revolutionary as desktop publishing 
and laser printing have been to personal computing. 

In Chapter Eight, you'll see some of the trends for the Macintosh. 
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Where to Go from Here 
Now that you have begun to explore a new path and have made the 
transition from the PC to the Mac, you may want to know what the future 
holds. PC systems and the different Macintosh models vary in several ways. 
The command-driven linear model of the PC contrasts sharply with the 
graphic-, object-, and process-oriented Macintosh environment. In Chapters 
Two, Three, and Four, you learned how to apply Macintosh techniques and 
how they compare with equivalent DOS operations. 

In Chapter Five, you learned how the graphical interface of the Macintosh can 
affect the way software products work, and how that may differ from products 
you have used on the PC. 

PCs and Macs also have different hardware, as you saw in Chapter Six. The 
Mac started out as a closed system and the PC began with an open system. 
They use different central processors, which has led to some very significant 
effects on software and memory. Their different video displays helped to shape 
the development of contrasting product lines. 

The two systems have even approached peripheral equipment in different 
ways. IBM never dominated the market for printers and other peripherals in 
the way that Apple has. Apple's design philosophy was tailored to help them 
control that market. Only recently have third-party peripherals begun to 
appear in number and variety approaching those available for the PC. 

As more and more Macs enter our homes and workplaces, the need to connect 
them with PCs and other systems grows. Information is best when shared, and 
a world with two incompatible standards is a poorer one for the lack of 
communication. Happily, there are signs of reconciliation between the warring 
factions in the PC and the Mac camps. In Chapter Seven you learned of several 
ways to connect Macs with PCs, as well as the hint of some other connectivity 
solutions. 
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One of the pleasant surprises in following the development of the Mac is the 
discovery of Apple's firm commitment to upward compatibility of their 
systems. Users who started with the Macintosh 128 were offered smooth 
migration paths to the Macintosh 512. Similarly, the Macintosh 512 users were 
offered solutions to the Macintosh Plus. The consistent thread for the 
Macintosh faithful has been the ability to move the Macintosh applications 
from system to system with virtually no changes to the software. This has been 
a cornerstone to the Macintosh's continued success. 

That brings us to this chapter. We've covered the major information, and we 
have begun to draw close to the end of our journey. However, we would like to 
leave you with some further thoughts about the future and with some 
resources to help you continue on your way from the PC to the Mac. 

FUTURE TRENDS 
The computer industry is in transition, as always, and some of the major 
changes are already beginning to influence everyday operation. Other changes 
can only be hinted at, and, at the outer limits of imagination, the changes will 
be so revolutionary as to obviate the need for books like this one. However, in 
the immediate future, certain trends and developments are fairly certain. 

Changes in technology are opening vast new horizons for computer users. PC 
users who have mastered single-tasking applications now look to OS/2 to 
provide multi-tasking capabilities at a single keystroke. Macintosh users also 
are moving to the multi-tasking/multi-user environments with both 
MultiFinder and A/UX. Additionally, personal computing is evolving rapidly. 
As the PC world migrates closer to the Macintosh world with products like 
Windows and OS/2 Presentation Manager, the Macintosh world is moving still 
farther from the PC spectrum with greatly improved sound and video imaging. 
Regardless, all these changes bode well for both the PC user and the Mac user. 

In this section, we'll go on a small side excursion. For the moment we'd like to 
take you away from the issue of today's PCs and Macs and on a short journey 
of possibilities. The future always starts with the present, and any good 
prognosticator has a pretty good idea of current events along with a sprinkling 
of knowledge about what is happening behind the scenes. In this journey of 
speculation, we'll start with a look at two current developments-OS/2 
Presentation Manager and A/UX. 

OS/2 and Presentation Manager 
IBM's commitment to OS/2 and Presentation Manager is a very direct 
statement, and one that will be hard to ignore. For Macintosh users, it 
represents a vindication. More than one person will be saying, "I told you so." 
However, DOS will continue for some time, and many people may prefer to 
work with DOS or a command-oriented OS/2 as time passes. Regardless of 
personal choice, the graphical interface is going to be a standard feature of 
nearly every computer system before long. The planned implementations of 

212 



Where to Go from Here 

OS/2 are Standard Edition and Extended Edition with either a command-line 
interface or a graphical interface (Presentation Manager). 

OS/2 Standard Edition is a multitasking operating system for PCs which use 
the 80286 or 80386 Processor. It will not work on the older PC and XT models. 
OS/ 2 allows applications to run concurrently with other applications and does 
not limit the application to 640K of memory. Applications running under OS/ 2 
mode use what is known as Protect Mode to ensure that one application does 
not run over another application. Software must be written specifically for 
OS/2 mode; therefore, most applications currently on the market for the PC are 
not OS/ 2-based. For existing DOS applications OS/2 hosts a special session 
known as Compatibility Box to allow applications to run unprotected under 
OS/ 2. A possible setback to running under the Compatibility Box is that an ap­
plication that hangs in DOS Mode may crash the entire system while an appli­
cation that hangs under Protect Mode will probably allow the system to 
continue running. 

The Extended Edition of OS/2 includes all of the features of Standard Edition 
plus the inclusion of three significant modules, the Data Manager, Communica­
tions Manager, and the Local Area Network Requestor. These modules provide 
significant services to applications to allow the system to handle multi-tasking 
requests from various applications at the same time. OS/2 Extended Edition is 
a significant step toward moving the mini computer power and multitasking 
capabilities down to the desktop level. 

Both editions of OS/2 come in either command-line interface mode or Presen­
tation Manager. Users familiar with Microsoft Windows will probably have lit­
tle problem getting familiar with the PM interface, as it is strikingly similar to 
the iconic references of Windows. As PM becomes more and more prevalent in 
the PC world, we expect to see a tighter convergence to the Macintosh Interface 
(hence the Apple-Microsoft lawsuit on the issue of "look and feel"). 

AJUX 
In mid-1988, Apple formally introduced its implementation of UNIX known as 
A/UX. Based on an implementation of AT&T's UNIX System V, A / UX incor­
porates many of the Mac interface features into the UNIX environment and al­
lows the intermixing of data from the Mac environment into the UNIX environ­
ment. A/UX is billed as an alternative to the Mac operating system and is only 
available on the Macintosh II family of computers. As well as providing UNIX 
applications with a "Mac-like" look and feel, many command-line interfaces 
are available for A/ UX to accommodate the hardcore UNIX fans for whom the 
graphical interface is a no-no. 

The true task of the operating systems of the future will not be in the ability to 
multitask alone-that is available now in both the PC and the Macintosh. 
DESQVIEW from Quarterdeck has offered multitasking to the DOS world for 
several years. MultiFinder is now coming into its own as developers begin to 
work out the kinks inherent in multiple-application processing. 
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The real promise to be realized in the future multitasking operating systems 
will be the ability to communcate between the various processes running in the 
system. This inter-process communications (!PC) capability will be the cornerstone 
to developing more complete and complex products. Imagine being able to add 
a customer's name and address to your database while the system automatical­
ly generates a letter in the background through the word processor welcoming 
their business. At the same time, the Accounts Receivable accounting system 
opens a new account and adds the customer to the system automatically-all 
activated by your initial entry into the database. It sounds unrealistic but that is 
the direction in which operating systems are going. Developers are already 
designing software to have just that capability! In fact, as you continue on this 
journey of speculation, you'll see that some people are already expanding on 
ideas like this one. 

Chips of the Future 
Advances in CPU development are rapidly changing the face of personal com­
puting as mini-computer power is quickly being overshadowed by the perfor­
mance of the 68030 and 80386 CPU chips (see Chapter Six). As faster processors 
become available, higher-resolution imaging and image manipulation also 
become possible. Sound handling is improved. 

Video-quality animation becomes more viable as the processor becomes able to 
handle the sophisticated algorithms necessary to give true real-time imaging. 
Already, people are using computers to retouch images, capture live video, and 
perform sophisticated animation. By mixing input from the computer and the 
world, information can be presented in new ways. 

Limitations in memory management, operating system design, and processing 
power of the CPU have reduced the ability to implement significantly ad­
vanced applications. However, this is no longer the case. 

In 1988, advances in system engineering and design broke through previously 
existing commercial limitations to micro systems. Parallel processing (as in 
Levco's Transputer) opened the door for applications previously thought to be 
too intense for the micro platform. Progress in CD-ROM and disk technologies 
has expanded storage and retrieval capabilities ten-fold. MultiMedia advances 
such as sound synthesis, voice recognition, and image processing are rapidly 
moving personal computing into the twenty-first century. Instead of 2001, we 
may expect to meet a real-life counterpart to HAL the computer in the 1990s. 

Connecting to Bigger Systems 
IBM's Standard Applications Architecture (SAA) concept provides inter­
connectability between IBM platforms and standard IBM communication 
protocols by controlling the flow of information between the devices. This 
dimension gives users the flexibility of the wide range of IBM products and 
computing power. Corporate users who had felt alienated by the separation of 
the micros from the mini- and mainframe world have looked forward to seeing 
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SAA implemented. Thus far, however, SAA has not lived up to its early 
promises. 

Apple's approach to the mini- and mainframe world has been substantially 
different. Apple has encouraged third-party developer solutions as the answer 
to the connectivity questions. The opening of the Macintosh architecture aided 
development of third-party solutions such as emulation boards, coprocessor 
boards, and connectivity boards (the Kinectics ETHERNET board, for 
example). 

Apple's landmark deal with Digital Equipment Corp. opened the way for 
Macintosh users to tap into a powerful network of high-performance-process­
ing minis. The solutions that have been developed (remote access systems 
such as Alisashare) are becoming the models for connectivity solutions with 
other computing targets. 

Language development has also taken radical new directions under the Macin­
tosh as Object-Oriented Languages (OOL) or Object-Oriented Programming 
(OOP) have begun to emerge and evolve. OOLs are considered to be the pro­
gramming environments of the future. 

Current and Future Mac Development 
Changes in the way people use computers have helped define the future 
Macintosh. The incorporation of the Mac in everyday use, as well as the 
anticipated need to support the users' current investment in software, helped 
initiate the releases of the Mac Ilx, Ilcx, and SE/30. 

This new technology makes a strong statement about Apple's commitment to 
coexist with the DOS world, and to remove the shroud of isolation that once 
hung over the Mac. With continued development in this direction, the 
Macintosh will no longer be considered as a fringe option or a machine for only 
specialized image processing purposes, and will be able to function easily in a 
world of DOS machines, minis, and mainframes. 

There have long been rumors of a Macintosh portable or laptop. The absence of 
a portable machine has been a hindrance to the Macintosh's growth because 
users have found it difficult to transport the Macintosh. While Apple has 
denied any plans to develop a laptop for production due to the lack of 
acceptable video devices, recent breakthroughs in video technology have made 
the portable Mac a possibility, and the demand from corporate users may push 
Apple to produce it. As of this writing, rumors are strong that such a product 
does indeed exist. 

KNOWLEDGE NAVIGATOR. At the time we write this, the introduction of 
several new machines from Apple and the expectation of the first 80486-based 
PC both point to positive advances in technology and future processing power. 
In 1988, in a short video called "Knowledge Navigator," Apple set forth its vi­
sion of the future of personal computing. 

215 



Chapter Eight 

In the video, a college professor comes home and walks up to his desk. On the 
desk is a computer roughly the size and shape of two legal-sized pads placed 
side by side. It has no keyboard and virtually no visible controls. A small video 
camera lens pokes out of the top, and it has a flat screen hinged in the middle. 

Some icons are still present on the screen-notably a movie projector, a book, 
and the familiar trashcan. Along the top of the screen are menus, though they 
are different from those on today' s Mac. The Knowledge Navigator's menus 
are Files, Network, Tools, Schedule, and Agent. 

Noticeably absent, however, is the mouse, which has been replaced by a touch 
pad. Although there seems to be some small storage-type media, they look 
nothing like floppy disks. No disk drive is visible. Incredibly, the whole system 
looks completely portable; no wires show anywhere. 

The professor speaks to the computer. The computer answers. A small image of 
a man (he's called the Agent) appears to speak, repeating the professor's tele­
phone messages. The professor asks the Agent to display some research 
information. Later, he asks the Agent to call a colleague. He talks to his 
colleague through the computer while viewing her image and asks to see some 
data she's collected. Almost immediately, graphs and maps representing the 
data appear on the screen. 

At other points during the video, the Agent makes some correlations between 
different facts and data, and displays graphs as well as geographical maps. In 
short, the Knowledge Navigator talks, listens, and responds to complex 
commands. From time to time, the professor touches the screen with his finger 
to indicate a particular fact or image he wants to work with. 

The video is, in fact, science fiction suggesting several technological advances. 
It postulates a completely portable computer incorporating a video telephone; a 
sophisticated (world-wide) network; and artificial intelligence in a graphic­
based, voice-activated system. Although some may disagree with this image, it 
is at least one vision of where we may be heading. 

mM hasn't released any speculative science fiction about its future vision, but, 
no doubt, it would seem equally far-fetched if they did. But, far-fetched or not, 
we've included a visit with the Knowledge Navigator because you, a PC user 
who is becoming acquainted with the Mac, might like some insight into 
Apple's thinking about the future. 

That ends our sidetrip down a possible future road. We'll return you now to 
the present and give you a little information about joining the community of 
Mac users, and about other resources at your disposal. 
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JOINING THE MACINTOSH COMMUNITY 
One of the strongest factors in the Mac's explosive growth is the availability of 
organized support and assistance for the everyday user. Unlike the PC 
environment, which is largely made up of dissimilar user types (corporate, 
small business, pleasure), the Mac seems to foster a fraternity of followers 
constituting a powerful voice in the direction and growth of the Macintosh line. 
Mac users are famous for being supportive, and most are anxious to advance 
both the Macintosh successes and the Macintosh philosophy. 

The organization of available Mac support is divided into three groups: bulletin 
boards, on-line services, and user groups. 

Bulletin Boards and On·Line Services 
There are numerous bulletin boards and on-line services that offer excellent 
support facilities. These services are extremely helpful as support forums and 
conferences are generally available to all users. On-line services provide a great 
way to trade tips and solve problems with other users in a "live" conference 
setting. Bulletin boards tend to be geared more towards communicating via 
electronic mail. Bulletin boards are excellent locations to get free software 
utilities and programs. 

Among the most popular on-line services are the following: 

AppleLink Personal Edition. AppleLink Personal Edition is offered by Apple 
to all users willing to pay the service charges. This service allows users to talk 
to each other and access both Apple-specific and general on-line information. 
Personal Edition can be used to exchange electronic mail, check stock quotes, 
sample software, or participate in on-line forums with other users. 

CompuServe. One of the most popular services for both PC and Macintosh 
users, CompuServe offers electronic mail and conferencing as well as on-line 
reference systems, and software and hardware support forums. (Ashton-Tate 
maintains an active on-line service through CompuServe.) 

Macnet. Macnet is very similar to AppleLink, with the exception that it is a pri­
vate on-line service not supported by Apple. Like Compuserve, Macnet also 
has on-line support forums as well as an excellent stock retrieval system and 
mail system. 

Other On-Line Systems. There are other excellent on-line systems as well. 
GEnie is an on-line service similar to CompuServe at a lower price. MCIMail is 
an electronic mail service which supports Desktop Express, a Macintosh front 
end, and Lotus Express, its PC counterpart. 
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The Macintosh User Groups 
The Macintosh user groups constitute one of the strongest conglomerates of 
computer users in the industry. User groups serve to inform members of new 
products, techniques, and news of events in the Macintosh world. Most user 
groups are community- or business-oriented. This helps maintain the level of 
participation, as the support group is local rather than remote. Many user 
groups have special interest groups (SIGs) that concentrate on specific products 
or needs (for example, some user groups have dBASE Mac SIGs). These special 
interest groups with similar needs meet and discuss problems and 
workarounds in a forum-like setting. Apple has a toll-free number (800-538-
9696) to get user group referrals. The referral service is available every day of 
the year, 24 hours a day. 

CONCLUSION 
Well, you've gotten through it! You now have a feel for the Macintosh 
mystique. We have attempted to lead you through the Mac in the most natural 
progression-from the beginnings of personal computing to one vision of the 
future. While this may have answered some questions, it probably whetted 
your appetite for more information. Not wishing to leave you hanging, we 
would like to suggest several books that pick up where we leave off: 

The Apple Macintosh Book 
CaryLu 
Microsoft Press 

The Macintosh Advisor- Essential Techniques for Experienced Users 
Cynthia Harriman and Bencion Calica 
Hayden Books 

The Macintosh Bible (book and HyperCard stack from STAX!) 
Edited by Arthur Naiman 
Goldstein & Blair 

Basic Tips and Techniques for the Macintosh (This is a must-have book after you 
have finished this one.) 

And when you really want some answers .... 

The Technical Introduction to the Macintosh Family 
Addison Wesley Publications 

We hope that this book leaves you with an understanding of the Macintosh and 
a more comfortable feeling in a new environment. The journey continues for us 
all, and we wish you much success in your adventures to come. 
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Functional Reference 
Chapter Three introduced the Macintosh graphical interface in a procedural 
manner, concentrating on Mac techniques. In this appendix, we focus on how 
to do things from a functional point of view. You should be somewhat familiar 
with 005 commands and techniques, as most of Appendix A is an alphabetical 
listing of 005 commands with the equivalent Macintosh procedures (if any). 

Some commands have no Macintosh equivalent; others are duplicated on the 
Mac in very different ways. For most commands, we have tried to indicate not 
only how the Mac equivalent (if any) works, but a little about why. 

COMMAND REFERENCE 
APPEND 
APPEND is used to set a search path for data files. It can set the path for 
executable files an option. (See also, PATH.) 

Mac Equivalent: None 

The Macintosh does not use a search path. However, if you double-click any 
document on any disk, the appropriate application will load if it is present on 
one of the active drives. In a sense, then, the Mac doesn't need a path 
statement. However, sometimes, especially on large hard disks, a particular 
document or application may be located in a special window and it may be 
easier to launch that application through the use of one of the third-party 
utilities like Power Station or On Cue. HyperCard can also be used as a 
program launcher. 

When you use one of these other programs to launch documents, the program 
itself takes care of remembering the path. 

It is important to note that the Macintosh does have a syntax for designating 
disks and directories (folders), and therefore, does have a definable path, 
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though no path statement. One difference between the Mac system and the 
PC's is that the colon (:) is used to separate parts of the path. Another is that 
Mac drive, folder, and file names can contain more than one word, as well as 
backward slashes and other characters that would be considered illegal on the 
PC. They cannot, however, contain a colon. 

A typical PC path might read: 

C: \DBASE\FILES\SALES.DB 

A similar hypothetical path on the Mac might read: 

My Disk Drive:dBase Mac:Files:Sales List (1987) 

ASSIGN 
ASSIGN is used to make temporary changes to a disk drive's designation. For 
instance, if a program customarily looks for data on drive B, but you want the 
data files to be used on the C drive, you can reASSIGN B to C using: 

ASSIGNB=C 

All commands for drive B will then be executed on C until you change the 
assignment again, or turn off, or reboot the computer. 

Mac Equivalent: None 

Mac programs generally read and write data files to the active disk and folder, 
which can be changed from within the standard file listing dialog box. There is 
no way to reassign a drive, because there is no need to. Some programs allow 
you to predefine folders for special files. For instance, FullWrite Professional 
lets you predefine a special folder for handling stationery documents 
(templates). 

ATTRIB 
A TIRIB is used to set special file attributes-notably read-only status and the 
archive bit (read by some programs to determine whether a file has been 
backed up or not). 

Mac Equivalent: Get Info 

There is no exact equivalent for the archive bit, but any file can be made read­
only by selecting it and opening Get Info from the File menu. At the top of the 
Get Info dialog box is a small box labeled Locked. Clicking this box is the 
equivalent of the DOS command: 

A TIRIB + R <filename.ext> 
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BREAK 
BREAK is used to tell DOS whether to scan for the Ctrl-Break or Ctrl-C 
keyboard entries. The syntax is: 

BREAK = [ON I OFF] 

Mac Equivalent: None 

The most common method for interrupting a Mac procedure during execution 
is the Command-Period keystroke combination (sg-.). Although this is anal­
most-universal function, it is not a built-in Mac procedure, and there are no 
user commands for turning it on or off. 

BACKUP 
BACKUP is the DOS command for backing up files from a hard drive to floppy 
disks. Various command-line options allow you to back up specific files, 
groups of files, files modified since the last backup was performed, and so on. 

Mac Equivalent: HDBackup 

Apple supplies a program called HDBackup with the system. This program 
will back up all files, one designated file, or all files that have been modified 
since the last backup. HDBackup also contains the file recovery functions that 
are equivalent to the RECOVER command (discussed later in this section). 

CHOIR 
CHDIR (abbreviated CD) is used to move from one directory to another. The 
syntax is: 

CD [d:][path] 

where d: is the optional drive name, and path is the optional destination. CD 
alone will return the name of the current directory. 

Mac Equivalent: Finder 

To move from one directory to another on the Mac, you simply open and close 
folders. To open a folder, double-click its icon. To close the folder, click the 
close box at the upper left comer of the folder window. The active folder 
window is a typical Mac window complete with title bar, close box, scroll bars 
(if necessary), size box, zoom box, and varying information on the title bar. (See 
DIR for more information about the way folders display their contents on a 
Mac.) 

Several folders may be open at once. To switch between open folders, you 
simply click in the window of the desired folder, bringing it to the front. If the 
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folder is hidden behind another window, double-click its icon again to bring it 
to the front. 

CHKDSK 
CHKDSK is used to check a disk for errors and, if instructed, correct them; also 
the status of your files and directories. It also returns information about the 
memory usage on your PC. 

Mac Equivalents: Finder, About the Finder, Disk First Aid, Get Info 

CHKDSK has no single equivalent on the Mac, but each of its functions is 
echoed in different aspects of the system. To correct disk errors, use the Disk 
First Aid program, provided with the Mac system. 

To view the status of the Mac's memory, beginning with Finder version 6.0, 
you can open the About the Finder desk accessory. This DA will only be 
available when the Finder is the active application. Under MultiFinder, About 
the Finder displays the memory usage of each active application on its own 
meter graph so you can see the total amount of memory that application is 
using, and how much of that memory has been allocated. 

Finally, you can see total disk space as well as space remaining by selecting the 
disk, opening its window, and displaying the files and folders By Icon (use the 
View menu to choose the display method). 

In addition, you can see the size of any individual folder by selecting it and 
choosing Get Info from the File menu. If you select several files or folders and 
then choose Get Info, a separate information box opens for each one. A typical 
Get Info box for a folder displays the size of the folder in bytes, how much disk 
space it uses, how many files it contains, its location, the date it was created, 
and the date its contents were last modified. 

CLS 
CLS is the DOS command to clear the screen. This works only from the DOS 
command line. 

Mac Equivalent: Close windows 

You can close any window, one at a time, by clicking its close box, by selecting 
Close from the File menu, or by pressing Command-W (this works in the 
Finder and also in some applications). Or you can press Option-Command-W 
to close all active Finder windows. You can close windows from within 
applications using the close box. However, the Command-key combination for 
closing a window within an application varies. 
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COMMAND 
COMMAND is used to load a secondary DOS processor or shell. 

Mac Equivalent: None 

Although you can't load a secondary processor on the Macintosh, with 
MultiFinder you don't need to. However, the Macintosh can allow you to 
switch the active System by using a process called switch launching. Switch 
launching is not the same as the DOS shell, and you are not often likely to need 
to do this. 

COMP (COMPARE) 
COMP is used to compare a file or set of files with another file or set of files. 
Basically, COMP tells you if the files being compared are identical or not, and 
pinpoints the differences by their hexadecimal locations. After finding ten 
unequal comparisons, DOS considers the two files to be too different to com­
pare and ends the process. 

Mac Equivalent: None 

COPY 
COPY is the DOS command used to copy a file from its present location to 
another disk or directory. You can copy a file by giving it another name: 

COPY <filename.ext> <newfile.ext> 

COPY does not affect the file being copied. 

You can also use COPY with wildcards to select files with similar names. You 
can use it to concatenate files and also to send files to a printer. 

Mac Equivalent: Drag, Option-drag 

Normally, when you move a file from one location to another on a Mac, you 
simply highlight the icon or icons you want to move and drag to the new 
location. 

When you drag an icon to another disk window or icon, the dragged icon is 
copied and the original is left intact. This functions the same way the COPY 
command does on the PC. 

However, when you drag an icon to a new location on the same disk, the 
process actually moves the icon, removing it from the original location. To 
perform a file copy from one folder to another, press and hold the Option key 
while you drag the icon. This leaves the original file or folder in place and 
creates a new copy in the new location. 
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If you want to create a duplicate of a file or folder (or a group of them) in the 
same folder, select the icons to copy and select Duplicate from the File menu (or 
press Command-D). A new file or folder is created for each selected file or 
folder with the title Copy of... followed by the original title of the icon. This is 
the Mac Equivalent of the DOS syntax example shown earlier in which the file 
was copied to a new name. 

You can use the Marquee and Shift-clicking to select multiple icons, though you 
can't use any wildcard methods on the Mac. 

When you copy or move files on the Mac, a window opens to show you how 
many files remain to be copied. A bar gauge shows you the progress 
graphically, and the names of all files being read and written flash across the 
screen. The speed of this display depends on the speed of the drive(s) being 
used. On floppies, the files will pass by quite slowly; when copying between 
fast hard drives, the file names will pass by in a blur. 

Unlike DOS COPY, Mac copy procedures can not be used to concatenate files, 
or send them to a printer. 

DATE 
DATE is used to set and display the current system date. In most PCs, there is a 
battery that keeps the current date and time. This command displays the 
current setting and allows you to change it. 

Mac Equivalent: Control Panel, Alarm Clock DA 

On the Macintosh, the system date is also kept current by a battery. To set the 
date, open the Control Panel and select the date. Either type in a new value, or 
use the arrow keys that appear when you highlight the date. You can also 
change the current system date by opening the Alarm Clock, clicking the date 
icon and changing it there. Because both methods use desk accessories, you can 
change the system date at any time. (For more on the Control Panel and the 
Alarm Clock DAs, see Chapter Four, under System DAs.) 

DELETE 
DELETE is commonly abbreviated DEL. This command is used to erase a file 
on the PC by changing the first character in the file's name to a special deletion 
character. Using one of the commercial or shareware undelete programs, you 
can often recover deleted files, though they will be written over in time. 

Mac Equivalent: Drag to the Trashcan 

On the Macintosh, when you want to delete a file, a folder or groups of files or 
folders, highlight the icons and drag them to the Trashcan. When the Trash­
can icon changes color, release the mouse button. 
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If you attempt to drag any applications or folders containing applications into 
the trash, an alert box warns you and give you the opportunity to change your 
mind. To bypass the warning altogether, press the Option key while you drag 
the files or folders into the trash. 

At this point, the files and folders will be removed from their current window, 
but will not be removed from the disk until you: 

• Select Empty Trash from the Special menu. 

• Leave the Finder by launching another application. 

• Shutdown or Restart the Mac. 

You can tell if the Trashcan contains any files because it bulges when full. If 
files have not already been removed from the disk, you can retrieve them by 
double-clicking the Trashcan. An ordinary Macintosh window opens, display­
ing the contents of the trash. Sometimes, however, if the Finder needs memory 
for some purpose, it may empty the trash; so it isn't a good idea to leave 
anything in the trash if you think you may change your mind. 

You may also eject a disk from a floppy drive by dragging its icon to the 
Trashcan. The disk ejects and the icon disappears from the desktop. 

DIR 
DIR shows the contents of a directory. It shows the filename and extension, any 
subdirectory names, the size, and the creation date of the file. 

Mac Equivalent: Various views of windows 

On the Macintosh, files are automatically listed when you open a disk or folder 
icon. How they are listed depends on the current setting of the View menu 
options. If the View menu is set to display by Icon, or by Small leon, then you 
will see all the contents of the current folder as icons. Only their names will 
display, though each icon clearly identifies what kind of file it is (the equivalent 
of the DOS file extension, but more accurate). 

If you select by Name, by Size, by Date, by Kind, or by Color, the listing is 
sorted appropriately, and you will see a miniature file icon, the file name, the 
file size, file type, and most recent modification date and time. 

You can also find out more about a file by selecting Get Info from the File 
menu. 

In DOS, you can show the contents of another folder by executing the 
command DIR <foldemame>. On the Mac, you must open a folder to display 
its contents (though most applications use the standard Open File dialog box 
which also lists the contents of any folder or disk). 
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DISKCOMP 
DISKCOMP is used to compare the contents of two disks. 

Mac Equivalent: None 

DISKCOPY 
DISKCOPY is the DOS command that copies the contents of one entire disk to 
another, formatting the disk if necessary. 

Mac Equivalent: Drag icons 

To copy a disk from one to another, simply drag the source disk icon to the 
destination disk icon. Since the Mac asks you to initialize (format) any 
uninitialized disk when you place it in the drive, the disk is assumed to be 
formatted. 

If you want to copy the entire contents of a floppy drive onto a hard disk, 
simply drag the floppy icon to the hard disk icon (or into a disk window). You 
will be prompted that the two are different types of disks. The Macintosh will 
create a folder for the floppy disk, using the same name, and copy all the 
contents of the floppy into that new folder. 

If you try to copy the contents of an BOOK disk onto a 400K disk, for example, 
you will receive an error message saying there isn' t enough room. This is one of 
the advantages of the Macintosh system. 

EDLIN 
EDLIN is the built-in DOS line editor. It can be used to create simple text files, 
batch files, and the like. 

Mac Equivalent: TeachText 

With later Mac systems comes a small application called TeachText that allows 
you to create simple text documents. The advantage of using it is that any other 
Macintosh will recognize the files it creates. Both EDLIN and TeachText files 
are ASCII files, and can be read by most word processors and other 
applications that use text. 

ERASE 
ERASE is functionally the same as DELETE. 
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EXIT 
EXIT is used to leave a DOS shell. 

Mac Equivalent: None 

There is no shell used by the Mac. To leave any application or window in 
MultiFinder, you simply close the window. To leave temporarily, you can click 
in another window, click the MultiFinder icon at the upper right comer of the 
screen, or select another application from the bottom of the desk accessories 
menu. 

FDISK 
FDISK is used to partition a hard disk before formatting. 

Mac Equivalent: HD Setup 

Depending on the hard disk you are using, you will probably use the HD Setup 
program to set up your drive; however, it is not generally necessary to partition 
Mac hard drives since the Mac can recognize much larger drives than the PC 
(which, up until DOS 4.0, was limited to 32 megabytes). On the Mac, a single 
drive of 300 megabytes or larger is no problem. 

FIND 
FIND is the DOS command for searching one or more files for specified text 
strings. 

Mac Equivalent: None 

There is no built-in equivalent for the DOS FIND command, though third-party 
programs like GOfer and Sonar will perform wonders with text retrieval. The 
DOS FIND command is not the equivalent of the Mac Find File DA, which 
searches for a file by name. On the other hand, DOS has no built-in file locator 
command, though several fine shareware applications will perform that 
function. 

FORMAT 
FORMAT is used to prepare a disk to receive information. FORMAT can also 
label a disk and automatically create a system disk. 

Mac Equivalent: Erase Disk 

The Macintosh will not accept a disk that has not been properly initialized. 
When you place a blank floppy disk in the drive, a dialog box will ask you if 
you want to format it. You will receive the option of initializing as a single- or 
double-sided disk. Single-sided disks are 400K; double-sided disks are BOOK. 
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After the disk has been successfully initialized, give it a name. You can rename 
a disk any time by simply placing the cursor on the disk title, highlighting the 
title, and then typing a new name. 

If you want to reinitialize a disk that has already been used, select its icon on 
the desktop, then choose Erase Disk from the Special menu. You will receive 
the usual initialization options. 

To create a system disk, first initialize it, then drag a System folder onto it. A 
system disk must have at least the System icon and either Finder or Mini­
Finder. You can only start the Macintosh with a system disk (either a floppy or 
a hard disk). 

GRAPHICS 
The GRAPHICS command is used to dump an image to a compatible printer. 

Mac Equivalent: Command-Shift-4 

On the Mac, you can use the built-in key commands to dump screens and 
windows. Command-Shift-4 dumps the current window to the current printer. 
Command-Shift-Caps Lock-4 dumps the entire screen. Command-Shift-3 will 
dump the window to a MacPaint file on the desktop. These key combinations, 
however, do not work properly on the Macintosh ll. 

There are also various commercial products available for both systems that you 
can use to capture screen images to file or disk. 

JOIN 
JOIN is used to artificially create a directory (or assign an existing directory) to 
represent the files from another drive. For instance, entering: 

JOIN A: C: \temp 

will cause all files on the disk in drive A to be accessed through a subdirectory 
on C called \temp. 

Mac Equivalent: None 

KEYBXX 

Use KEYBX:X to define the current keyboard driver. DOS supports drivers for 
several foreign and domestic keyboard types. 

Mac Equivalent: Various 

You can order the Mac with a foreign keyboard, but many foreign characters 
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are available by using the Option key in combination with a letter key. Which 
characters are available varies from one font to another. To see what characters 
your fonts contain, select the Key Caps DA and look at the fonts on your sys­
tem. With Key Caps active, press the Option key to see the alternate character 
set for any font. 

LABEL 
LABEL lets you add, modify, or view the label on a disk. The PC lets you have 
up to 11 characters to define a disk label. 

Mac Equivalent: Type a name 

On a Macintosh disk, you can change the label simply by highlighting the 
existing title under the disk's icon and retyping it. If you want to edit the label, 
simply place the cursor in the position from where you want to begin editing. 
The cursor should change to the vertical bar (the text cursor). Click and begin 
editing. If the disk's window is open, you' ll see the new name echoed at the top 
of the window in the title bar. 

MKDIR 
MKDIR is often abbreviated MD. This command creates a new directory on the 
PC drive. The syntax is: 

MD [d:]<path> 

For instance, to create a new directory called newdir on the C drive, you would 
type: 

MD C: \ newdir 

Mac Equivalent: New Folder 

To create a new folder on the Mac, select New Folder from the File menu or 
press Command-N. A folder called Empty Folder will be placed on the 
desktop. It will still be highlighted, and you can give it a new name. You can 
also move it to a new location if you are displaying by icon. 

MODE 
MODE sets printer and screen parameters. 

MODE also has other uses on other machines. For instance, on a Compaq 
machine, MODE is used to set several system-level parameters. 

Mac Equivalent: Chooser, Control Panel 

The closest equivalent to MODE can be found in the Chooser desk accessory 
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which lets you set the current printer, set baud rates for serial devices, choose 
the output port (modem or printer) for a device, and so forth. However, the 
screen setting side of the MODE command is best compared to the Monitors 
CDEV (control device) found in the Control Panel. This is found on the color 
Macs only, and allows you to set different video modes more or less the way 
MODE does in DOS. 

MORE 
MORE is actually a filter command that stops a listing of information after one 
full screen and waits for a keypress. It is usually used with the pipe symbol, for 
example: 

TYPE <filename.txt> I MORE 

Mac Equivalent: Scroll Bars 

The Mac usually doesn't force you to try to read something as it scrolls by. Al­
most always, any listing that is too long (or too wide) to fit into one screen will 
be in a window with scroll bars that allow you to look at any part of the 
listing. 

PATH 
The PATH command sets the search path for DOS. For instance, if you issue the 
command: 

PATH=C: \;C: \DOS 

DOS will search first in the current directory, then in the root directory (C:\), 
and finally in the \DOS directory. PATH works with command and executable 
files (.com and .exe) as well as batch files (.bat). It does not search for data files. 
For that, you would use APPEND (see APPEND). 

Mac Equivalent: Internal file handling 

Though the Mac does not have a PATH command, it does know where 
everything is, and every file and folder has a path designation. For a more 
complete discussion of Macintosh path structures, see the listing for APPEND 
at the beginning of this section. 

PRINT 
PRINT sends the contents of a designated file to a printer. PRINT has quite a 
few command line options which can affect the meaning of the command. The 
PRINT command will print to a buffer to allow printing in the background. 

Mac Equivalent: Print command on the File menu 
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The closest Mac equivalent of the PRINT command is the Print command on 
the File menu of the Finder. When you select Print from the File menu, it 
automatically opens the application for the selected file or files and initiates the 
print sequence. You can, therefore, highlight several files to print one after 
another. However, unless you have placed some specific spooler on your 
system, the printing will take place in the foreground. If your application is 
MultiFinder-friendly, it may print in the background if MultiFinder is active. 

RECOVER 
RECOVER is used to retrieve files from disks that have gone bad. You can 
RECOVER all files or selected ones from the disk. 

Mac Equivalent: Disk First Aid and others 

File recovery on the Mac can be a matter of using the correct tool. Disk First 
Aid may be able to repair a damaged disk and recover the files. If not, various 
third-party programs like MacTools, MacZap, Symantec's Utilities, and FEdit 
are all handy for such situations. 

RENAME 
RENAME is often abbreviated REN. It is used to RENAME a file or group of 
files (using wildcards). For instance, to RENAME aU files with the .BAK 
extension to the same name with .DOC you would issue the command: 

REN *.BAK *.DOC 

If you attempt to rename a file to a name already taken in the current directory, 
you receive a DOS error message and the procedure is canceled. 

Mac Equivalent: Type the new name 

The Macintosh lets you name any file, folder, or disk icon simply by typing 
beneath the icon, or in the name portion of a text listing. Like DOS, if you 
attempt to use a name already in use in the current folder, the Mac will warn 
you and cancel the procedure. However, you can't rename more than one file at 
a time, as you can in DOS. 

REPLACE 
REPLACE is generally used to write new files over previous files of the same 
name. At any rate, the source files of a particular name will completely 
REPLACE the destination files of the same name in the designated directory. 

Mac Equivalent: Drag 

The DOS Replace command contains several command line options that make 
it able to do various things like prompt you before each replacement. The 
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Macintosh equivalent of this command is simply the icon dragging procedure. 
If you attempt to drag a file or group of files into another folder or onto another 
drive, the Macintosh first checks to see if there are any duplicated file names. If 
there are, an Alert box appears informing you that there are duplications and 
asking your permission to replace them. If you click OK, any duplicates will be 
replaced. Click Cancel to back out of the procedure. 

RESTORE 
RESTORE is used to transfer files than have been archived with the Backup 
command. You can designate specific files to recover, or do a full recovery. 

Mac Equivalent: HDBackup 

HDBackup lets you recover a single file or all files from archived disks. See 
BACKUP earlier in this section. 

RMDIR 
RMDIR is often abbreviated RD. It is used to remove a directory from a disk. 
You cannot remove a directory that still contains files or subdirectories. 

Mac Equivalent: Trashcan 

On the Mac, you drag a folder icon into the Trashcan to remove a directory. 
You can throw away any folder, empty or not, but if the folder contains any 
applications, an alert box will ask if you really want to throw away the 
applications in that folder. Click OK to continue, or Cancel to replace the folder 
on the desktop. Holding down the Option key while you drag the folder into 
the trash will bypass the warning message. Remember, you can remove folders 
containing only documents without getting a warning message. 

SET 
SET is used to equate one string with another in the background. 

For instance, if an application usually looks for a file called Appsfile in the 
C:\Apps directory, and you have renamed that file Myfile, and moved it to 
0: \Mydir, you could use the SET command as follows: 

SET C: \ Apps \ Appsfile=D: \Mydir\Myfile 

Mac Equivalent: Internal file handling 

On the Macintosh, there is no need to worry about environmental strings like 
those created by the SET command. The Mac takes care of all file searches and 
automatically recognizes files that belong to an application, wherever it is. 
Most applications also take care of placing and tracking their own temporary 
and special settings files (most often they are placed in the System Folder). 
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SORT 
SORT can be used to reorder text information as well as directories. For 
instance, to sort the contents of a text file, Mixed.txt, and send the results to a 
file named Order.txt, you would issue the command: 

SORT<Mixed.txt>Order.txt 

To sort a directory listing, use: 

DIR I SORT 

Mac Equivalent: View by Name 

The only function that is available on the Mac system that is analogous to the 
DOS SORT command is the View by Name function which will sort a listing of 
files alphabetically by name. This is the equivalent of the second command 
example given above. All other uses of the SORT command are not duplicated 
by the Mac system, though they may be available in specific applications. 

SUBST 
SUBST is used to assign a drive letter to a path. For instance, suppose you often 
refer to the directory C:\Mail\Incoming. Using the SUBST command, you 
could refer to it simply as F:, by entering the following command: 

SUBST F: C:\Mail\Incoming 

Mac Equivalent: None 

There is no such path substitution available on the Mac, nor is one needed. See 
the discussions of APPEND and PATH, earlier in this section. 

SYS 
SYS is used to place the DOS hidden system files on a disk. You can then copy 
the Command.com file to complete the creation of a system disk. 

Mac Equivalent: Copy System Folder 

Generally, when you want to create a boot disk or system disk, you simply 
copy the System Folder to the desired location. However, if the System Folder 
is too large, you can create a system disk by simply copying the System icon 
and the Finder or Mini-Finder. 
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TIME 
TIME displays and sets the internal time on a DOS machine. If the machine has 
an internal battery, the time remains set. If it does not, you will have to reset 
the time each time you reboot the computer. 

Mac Equivalent: Control Panel, Alarm Clock 

You can set the internal system time and date from the Control Panel DA or the 
Alarm Clock DA. To do so, click the appropriate display and then either type 
the new time, or use the arrows to move the entry up or down. You set each 
portion of the time (hours, minutes, seconds) separately. (See also, DATE.) 

TREE 
The TREE command displays a visual image of the directory structure of a DOS 
disk. 

Mac Equivalent: None 

There is no built-in hierarchical tree display for the Macintosh, though there 
have been some third-party programs that display such a tree structure. 

TYPE 
The TYPE command is used to display a scrolling listing of a text file on the PC. 

Mac Equivalent: None 

On the Mac, when you double-click a file, the application associated with it will 
open and display its contents. The closest equivalent to the TYPE command 
may be text editing desk accessories which can be used at any time to display 
the contents of text files. A very good one is McSink. 

VER 
VER is used to display the current DOS version being used. 

Mac Equivalent: About the Finder 

The About the Finder box will always display the current version number of 
the System and the Finder. In addition, the About box of almost any 
application will show its version number. Sometimes version numbers are 
found in the Get Info box. 
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VERIFY 
VERIFY is used to always be sure that information written to a disk is accurate. 
It is turned on or off during a DOS session using the VERIFY ON and VERIFY 
OFF commands. 

Mac Equivalent: None 

VOL 
VOL displays the current volume name (if any). 

Mac Equivalent: Disk Icon 

The volume name of any disk mounted on a Mac is displayed beneath its icon. 

XCOPY 
XCOPY copies all files and also all subdirectories and their contents, in the 
source path specified in the command. COPY does not copy subdirectories. 

Mac Equivalent: Drag folder 

When you drag a folder to copy it on a Mac, all sub-folders and their contents 
are automatically copied along with it. 

OTHER FUNCTIONS 
Warm Boot (RESET) 
On the PC, to reboot the computer, either tum the computer off and then on 
again, or press Ctrl-Alt-Del. 

Mac Equivalent: On the Macintosh, you must always select Shutdown from the 
Special menu to turn the computer off. On most Macintoshes, you can turn the 
computer off after the Shutdown process is complete and the message reads: 

You may now switch off your Macintosh safely. 

Click Restart to reboot; otherwise switch the computer off. 

On the Macintosh II series, selecting Shutdown also turns the computer off. 

To perform the equivalent of the PC's Ctrl-Alt-Del series, select Restart from 
the Special menu. 
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However, what happens if something goes wrong and your computer is 
locked? In that event, you have two choices: 

• Tum the computer off, wait ten or fifteen seconds, then tum it on 
again. 

If you have to tum off the computer without using Shutdown, the 
Desktop file on any mounted drives (especially hard drives) must be 
rebuilt, so you will have to wait while the Mac attempts to rebuild the 
Desktop file for each mounted drive. 

• Use the front part of the Programmer's Switch to reboot. 

The Programmer's Switch is located on the side of the machine (your 
left on most Macs; right on Mac lls). The Desktop file for each mounted 
drive will be rebuilt. The Programmer's switch can be used to allow 
code insertion into a debugger window. It is possible to send internal 
codes through the debugger window to return to the Desktop in cases 
of a system lockup. Using the internal code is not highly recommended 
unless you know what you are doing. There is a possibility of 
damaging files under some circumstances. But if you are sure that no 
files will be affected, using this method will sometimes take you back 
to the Desktop without having to reboot. 

Print Screen 
Pressing Shift-PrtSc on a PC dumps the current screen image to an on-line 
printer. Whether the image prints intelligibly depends largely on the kind of 
printer you are using and the kind of screen being dumped. 

On the PC, there are several fine screen capture utilities, too: for instance, 
Imcap, Hijaak, and Hot Shot. 

Mac Equivalent: On a Mac, you can dump the screen image to the printer by 
pressing Command-Shift-4. However, you can also dump a screen or current 
window to a MacPaint file on the Desktop using Command-Shift-3 (current 
window) or (whole screen). The resulting MacPaint files are named ScreenO to 
Screen9. 

These internal commands work on Macs up to the Mac II. On the Mac II, at 
least so far, you must use a third-party screen capture program, like Capture, 
which will let you make a file of any portion of a screen, in color or black and 
white. Capture even works with large screens. 

Another excellent utility for capturing screens on Macs (other than the Mac II) 
is Camera. Camera has two main advantages over the Command-Shift-3 
combination. First, it lets you capture up to 100 screens in a single session (as 
opposed to only 10 for the internal key command) by numbering them 
ScreenOO to Screen99. Second, you can actually place a delay on the screen 
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capture, allowing you to capture processes like open menus and modal dialog 
boxes where you can't press the internal key combinations. This gives you a 
much greater range of choices. 

Help Key 
PC applications usually use the F1 function key to access on-line help subjects. 

Mac Equivalent: The Macintosh Extended keyboard has a key labeled Help. 
This key does not have a function at the Finder level, but some applications use 
it to open help dialog boxes. Ordinarily, help systems for Macintosh 
applications are found in the About box (the About DA); some applications use 
Command-?. 

Function Keys 
The Function keys (F1-F1 0 or F1-F12) on a PC are used for many things, both 
at the DOS command line and within applications. Most Mac keyboards do not 
have function keys, and therefore most Mac applications do not use them. A 
few programs, notably programs with DOS counterparts like WordPerfect for 
the Mac, can use the function keys on the Macintosh Extended Keyboard, 
which is almost identical to a newer ffiM AT keyboard. 

Mac Equivalent: On the Mac, there are special programmable keys, called 
Fkeys. The Command-Shift-4 used to dump the screen to a printer is an Fkey, 
and there is space for up to ten Fkeys concurrently on a Mac. There are two 
other Fkeys that come with the System-Command-Shift-1 and Command­
Shift-2. The former ejects any disk in the first (internal) floppy drive on any 
Mac. The latter ejects a floppy disk from an external, or a second floppy drive. 
The preferred method of ejecting disks, however, is to drag them into the 
Trashcan. 

Normally, Fkeys are installed using special programs, and all are supplied by 
third-party manufacturers. Many of them are shareware products. 

If you are just beginning with the Mac, you probably won't want to get too 
involved with Fkeys. They can be unreliable, and it is also possible that they 
will interfere with the operation of some applications or other System utilities. 
Fkeys are generally safe and easy to use, but it is best to become familiar with 
the Mac before attempting to use them. 
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Macintosh 
Configurations 

MACINTOSH 512K 

1. Mouse connector 
2. External floppy drive controller 
3. LocaiTalk port 
4. Serial port 
5. Sound plug 
6. External SCSI port 
7. Power plug 
8. Power on switch 
9. System battery 
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MACINTOSH PLUS 

1. Sound port 
2. Mouse connector 
3. External floppy drive port 
4. External SCSI port 
5. LocaiTalk port 
6. Serial port 
7. Power plug 
8. Power on switch 
9. System battery 
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MACINTOSH SE 

1. Apple Desktop bus ports (ADB) 
2. External floppy drive connection 
3. External SCSI port 
4. LocaiTalk port 
5. Serial port 
6. Sound jack 
7. Opening for option board 
8. Power plug 
9. Power on switch 
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MACINTOSH II 

0 

1. Sterephonic sound jack 
2. Apple Desktop bus ports (ADB) 
3. LocaiTalk port 
4. Serial port 
5. External SCSI port 
6. NU-BUS expansion slots (6) 
7. Video board 
8. Power plug (in) 
9. Monitor power plug (out) 
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Sources 
The following listing is of products and companies that are referenced, 
discussed or suggested throughout this book. It is not intended to reflect the 
authors' personal preferences. 

Chapter 1 

DeskScene 
PBI Software, Inc. 
1163 Triton Drive, Foster City, CA 94404 
(415) 349-8765 
Desktop screen customization utility 

Chapter 2 
DiskOrder 
Paragon Concepts Inc. 
4954 Sun Valley Road, Del Mar, CA 92014 
(619) 481-1477 
Disk file organizer 

Disk top 
CE Software 
P.O. Box 65580, W. Des Moines, lA 50265 
(515) 224-1995 
File management utility 

HyperCard 
Apple Computer, Inc. 
20525 Mariani Avenue, Cupertino, CA 95014 
(408) 996-1010 
Hypertext application development system to allow customization and 
creation of information cards and stacks 

243 



AppendlxC 

HyperDA 
Symmetry Corporation 
761 East University Drive, Mesa, AR 85203 
(800) 624-2485 
Desk Accessory to access Hypercard stacks 

Mac Tree 
Software Research Technologies 
22901 Mill Creek Rd., Suite B, Laguna Hills, CA 
(714) 472-0474 
Hard disk management program 

ChapterS 
dBASEMac 
Ashton-Tate Corporation 
20101 Hamilton Avenue, Torrance, CA 90502-1319 
(213) 329-8000 
Database system for the Macintosh 

Framework lll 
Ashton-Tate Corporation 
Integrated software package for the DOS environment 

Full Impact 
Ashton-Tate Corporation 
Full-featured spreadsheet with graphics and language capabilities 
for the Macintosh 

FullWrite Professional 
Ashton-Tate Corporation 
WYSIWYG word processor for the Macintosh 

Microsoft Excel 
Microsoft Corporation 
16011 NE 36th Way, Box 97017, Redmond, WA 98073 
(206) 882-8080 
Spreadsheet with graphics for the Macintosh 

Microsoft Word 
Microsoft Corporation 
Word processor for the Macintosh 

MultiMate Advantage ll 
Ashton-Tate Corporation 
Word processor for the DOS environment 
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1-2-3 
Lotus Development Corporation 
161 First Street, Cambridge, MA 02142 
(617) 577-8500 
Spreadsheet for the DOS environment 

WordPerfect 
WordPerfect Corporation 
288 W. Center Street, Orem, UT 84057 
(801) 225-5000 
Word processing package for the PC, Xenix, and the Macintosh 

Chapter6 
Apple MIDI Interface 
Apple Computer, Inc. 
Connection kit to allow MIDI devices to connect to the Macintosh 

Grappler 
Orange Micro Inc. 
1400 N. Lakeview Avenue, Anaheim, CA 92807 
(714) 779-2772 
Serial-to-parallel printer connection kit 

Mega Screen Displays 
Mega Graphics Inc. 
20954 Osborne Street, Canoga Park, CA 91304 
(818) 407-0571 
Extra-large monitors and display capture devices 

Radius Displays 
Radius, Inc. 
404 E. Plumeria Drive, San Jose, CA 95134 
(408) 434-1010 
Full-page, two-page, and gray-scale monitors 

Universal Print Buffer 
Johnathon Freeman Designs 
P.O. Box 880114, San Francisco, CA 94188 
(415) 822-8451 
Printer converter and buffering device 

Chapter7 

Apple PC Drive, AppleShare, AppleShare PC, AFE 
Apple Computer 
Apple communications and data transfer offerings 

Sources 
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DaynaFile, MacCharlie 
Dayna Communications 
50 South Main Street, Suite 530, Salt Lake City, UT 84144-9901 
(801) 531-0600 
Disk drive units to allow PC-to-Mac data sharing 

LAP-LINK Mac 
Traveling Software 
North Creek Corporate Center 
19310 North Creek Parkway, Bothell, WA 98011 
(206) 483-8088 
Connection kit to allow for serial connection between a Mac and a PC 

Mac Link Plus 
AFE Translators 
Data Viz, 16 Winfield St., Norwalk, CT 06855 
(203) 866-4944 
Data conversion software package 

Mac286 
AST Research, Inc. 
Apple Products Division 
2121 Alton Ave., Irvine, CA 92714 
(714) 553-0340 
80286 Co-processor board to allow DOS software to operate on a Macintosh 

MatchMaker 
Micro Solutions, Inc. 
132 West Lincoln Hwy., Dei<alb, IL 60115 
(815) 756-3411 

Netware for Macintosh 
Novell, Inc. 
122 East 1700 South, Provo, UT 84601 
(800) 453-1267 
LAN support software to support Macintosh on Novell-based networks 

RedRyder10 
FreeSoft Company 
150 Hickory Drive, Beaver Falls, PA 15010 
( 412) 846-2700 
Communications package 

Sidekick Plus 
Borland International 
4585 Scotts Valley Drive, Scotts Valley, CA 95066 
(408) 438-8400 
Memory-resident desk accessories for the PC 
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3Plus for the Mac 
3Com Corporation 
3165 Kifer Road, Santa Clara, CA 95052-8145 
(408) 562-6400 
LAN system for PC, Macintosh, and other systems 

TOPS 
A SUN Company 
2560 9th St., Suite 220, Berkeley, CA 94710 
(415) 549-5900 
LAN system for PC and Macintosh systems 

ChapterS 
AppleLink Personal Edition 
Apple Computer, Inc. 
On-line information service 

CompuServe 
CompuServe Information Services, Inc. 
P.O. Box 20212, 5000 Arlington Center Bldg., Columbus, OH 43220 
(614) 457-0802 
On-line information service 

DESQview 
Quarterdeck Systems 
150 Pico Blvd., Santa Monica, CA 
(213) 392-9851 
Window and multitasking system for the DOS environment 

GEnie 
General Electric Information Services 
401 W. Washington Street, Rockville, MD 20850 
(800) 638-9636 
On-line information service 

MacNet 
Connect, Inc. 
10101 Bubb Road, Cupertino, CA 95014 
(408) 973-0110 
On-line information service 

MCIMail 
MCI Telecommunications Corp. 
1150 17th Street NW, Washington DC, 20036 
(800) 444-6245 
On-line information service 

Sources 
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AppendixC 

Source, The 
Source Telecomputing Corporation 
1616 Anderson Road, P.O. Box 1305, McLean, VA 22102 
(800) 336-3366 
On-line information service 
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G 

Glossary 
active window 

alert 

Apple Desktop Bus (ADB) 

Apple Sound Chip (ASC) 

Apple Talk 

asynchronous communicatons 

The window that is in use on the 
desktop. It is identifiable by its 
visible title and scroll bars. 

A warning or report of an error, 
usually in the form of a system 
beep or an alert box with a 
message. 

A low-speed serial port that is used 
on the Macintosh SE, Macintosh II, 
and Macintosh Ilx to connect the 
keyboard, mouse and specially 
designed peripherals. 

A proprietary component used in 
the Macintosh II to support high­
level sound capability. 

The local area network communi­
cations facility built into the Mac­
intosh that allows data exchange 
with other intelligent devices. 

A method of communicating 
between remote devices in which 
the receiving device and the 
sending device don't share a 
common timer. 
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Glossary 

audio port 

A/UX 

baud 

beta software 

bit 

bit-map 

boot up 

bulletin board 

button 

250 

The sound port on the Macintosh 
that makes sound generation possi­
ble; it is connected to the speaker 
or to the 1/s-inch audio jack. 

Apple Computer's implementation 
of UNIX for the Macintosh. 

A unit of measure in communica­
tions. Generally the number of 
signal events per second. 

Software that is being distributed 
for testing, but not yet commercial­
ly available. It has become a more 
accepted practice recently to re­
lease beta software to the general 
public. Be careful, however, as 
system-damaging bugs have been 
known to occur. 

A contraction of binary digit. A unit 
of data, representing either a posi­
tive signal (1) or a negative signal 
(0). One character usually takes up 
eight bits, or one byte. 

A series of bits that represent a 
two-dimensional surface. In the 
case of bit-mapped displays, one 
bit in memory represents one pixel 
on the display. 

Start-up; the initialization sequence 
for the computer. In the case of the 
Macintosh, boot up consists of 
loading specific operating data, 
loading special device drivers and 
INIT files and building the 
Desktop. 

An on-line sysem (usually dialed 
into over modem lines), when 
clicked for the purpose of electron­
ic messaging and file transfers. 

A feature that, when clicked, 
causes some action to occur. 



byte 

c 

Cancel 

character style 

checkbox 

Chooser 

Clean Up 

Clipboard 

close box 

color picker 

Glossary 

A sequence of eight bits which 
generally makes up one character. 

A high-level programming 
language that is easily movable 
between various systems. Software 
companies are quickly standardiz­
ing on C to allow quick 
portability between different 
hardware platforms. 

An option in most dialog boxes 
that allows termination of a task or 
activity and returns the user to the 
prior position. 

A set of type styles, such as bold, 
italic, and underline. Most software 
packages use Command-key 
equivalents for easy access to these 
styles. 

A standard control feature associ­
ated with an option in a dialog box. 
Displays on or off by a check or X 
ina box. 

An Apple desk accessory that 
allows users to select printers. 

An option in the Finder Special 
Menu to reorganize folder entries 
into a more legible format. 

A buffer area to hold objects that 
have been cut or copied in memory 
for pasting into another location; 
used by most applications. 

The box in the upper-left-hand cor­
ner of an active window that is 
used to close the window. If the 
work in the window has not been 
saved, an alert box will usually ap­
pear to prompt the use.r to save. 

A CDEV that allows a Macintosh II 
user to select colors. 
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Glossary 

command key 

command line interface 

Control Panel 

cursor 

Cut 

data-fork 

default 

desk accessory 

Desktop 

252 

A special key to the left of the 
space bar. It is used in conjunction 
with other keys to send command 
shortcuts to the system and also in 
combination with the mouse to 
drag windows. 

The standard interface of the DOS 
environment. The entry point is 
identified by a command line 
prompt such as C>. 

A desk accessory that allows users 
to set general operating conditions 
of their system; such as mouse 
speed, sound level, and cursor 
blink rate. 

The symbol, or flashing point, that 
indicates current working location. 
On the Macintosh, it is generaly 
identifiable as the mouse pointer. 

To remove data from one location 
to be stored for use in another loca­
tion. Not to be confused with 
Clear, which erases the selected 
area. 

The section of the file that contains 
information to be accessed by the 
File Manager. Genrally, this is the 
location for user-generated data. 

A preset choice offered by the soft­
ware. In the case of a default but­
ton, pressing the Enter key initiates 
the action specified. 

An accessory program that can be 
accessed from the Apple menu 
while an application is active. 
Some examples are the Calculator, 
the Alarm Clock, and the Chooser. 

The primary menus and visual in­
terface displayed; the working 
environment. 



dialog box 

dimmed choice 

document 

dot-matrix 

double-clicking 

edit 

enter key 

fat bits 

Finder 

folder 

font 

Glossary 

A window that requests user input, 
generally appearing after a com­
mand is issued. 

Indicates a menu choice is not cur­
rently available for selection. 

Any information or text that is 
stored in a file to be accessed by an 
applicaton. A document may be 
made up of text or graphics. 

A method of printing in which the 
character is formed by several pins 
on the printhead striking the paper 
in a pattern to create the image. 
The Image Writer printers from 
Apple are dot-matrix printers. 

Pointing the mouse pointer at an 
object and clicking the mouse but­
ton twice rapidly to activate a 
choice or initiate an event. 

To change or modify information 
in a document. 

A key that usually confirms a com­
mand or initiates an event. Has the 
same effect as double-clicking. 

A graphic editing option that 
presents sections of the graphic in 
enlarged detail to allow precision 
editing. 

The part of the Macintosh operat­
ing system that manages the desk­
top and the file services. 

A collection of applications and/ or 
documents. Similar to a directory 
in the DOS environment. 

A complete character set in a single 
typeface consisting of different 
styles and sizes. 
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Glossary 

Font/DA Mover 

graphic 

HFS 

highlight 

1-beam 

icon 

initialize 

justification 

keyboard macro 

Local Area Network (LAN) 

locked file 
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An application used for installing 
or removing fonts or desk accesso­
ries from the system file. 

An image or picture type of 
document. 

The Hierarchical File System. A file 
system that allows multiple levels 
of folders. 

To make an object visually distinct 
on the screen to indicate a selec­
tion. Usually identifiable by 
inverting the object image. 

A mouse pointer shaped like the 
capital letter "I"; used with text 
handling to indicate the text 
insertion point. 

A graphic image representing an 
object. The folder, trashcan, and file 
page are all icons. 

To format a disk to allow data 
storage and retrieval. 

The horizontal placement of lines 
of text relative to the vertical 
boundaries of the text insertion 
area. 

A software enhancement in which 
a series of keystrokes, mouse selec­
tions, or text insertions are mapped 
to a command keystroke. 

A series of intelligent devices 
linked together via communica­
tions devices that allow for transfer 
of information from one device to 
another. 

A file whose data may not be 
copied or changed. 



Macintosh Programmer's Workshop 
(MPW) 

menu 

menu bar 

modem 

MultiFinder 

Note Pad 

NuB us 

open 

Option key 

paste 

Glossary 

Apple's software development 
system for the Macintosh 
programmers. 

A listing of choices or items to be 
selected by the user. Dragging a 
mouse over the menu and releas­
ing or clicking the mouse button on 
a menu item chooses the menu 
command. 

The line at the top of the screen 
that lists available menus. 

A peripheral device connected 
through the serial port to allow 
communications between comput­
ers over phone lines. 

A version of Finder that allows 
more than one application to be 
open and active at one time. 

A desk accessory that allows small 
amounts of text to be stored or cut 
and pasted for use in other 
documents. 

The data handling design internal 
to the Macintosh II and Macintosh 
Ilx. NuBus is a trademark of Texas 
Instruments. 

To activate a folder, application, 
icon, window, or document for 
use. 

A special key on the Macintosh 
keyboard. It is used in conjunction 
with other keys or with the mouse 
to produce special characters or 
symbols, or give different mean­
ings to mouse actions. 

To place information that has been 
cut or copied from one marked lo­
cation into another location. 
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Glossary 

pixel 

pointer 

pull-down menu 

Random Access Memory (RAM) 

Scrapbook 

scroll 

select 

Standard In-line Memory Module 
(SIMM) 

256 

An individual dot on a screen. 

The item on the display that marks 
the current position of the mouse. 
The pointer can be shaped like an 
arrow, an 1-beam, a crossbar, or a 
wristwatch. See also cursor. 

On the Mac, a set of menu choices 
that are displayed by positioning 
the mouse pointer on the menu 
name, pressing the mouse button, 
and dragging the mouse to reveal 
menu commands. Items are chosen 
by positioning the pointer on the 
menu command and releasing the 
mouse button. 

Memory that can be written to and 
read from many times. RAM stores 
information only while the user 
works on it. Usually called volatile 
memory, as items in RAM are 
available only as long as the system 
is turned on. 

A desk accessory used to store data 
that is cut or copied for future use. 
Similar to the Clipboard except 
that images in the Scrapbook are 
stored on disk. 

To move the display of information 
within a window to show contents 
that may not be visible. 

To choose an item or event. Gener­
ally, items are selected by double­
clicking the mouse button on the 
item to be activated. 

A memory expansion module used 
in some Macintosh systems and the 
IBM PS/2; consists of memory 
chips on a small printed circuit 
board that installs in special SIMM 
slots on the system board. 



size box 

text 

title bar 

Undo 

windows 

Glossary 

The small overlapping boxes in 
the lower right-hand corner of the 
window. Used for adjusting the 
size of the window. 

Any grouping of characters, 
generally in the form of letters 
or numbers. 

The top bar of a window, which 
displays the title, close box, and 
zoom box. 

Used to reverse the last action 
initiated. Undo is often used for 
recovering accidentally erased 
information. 

The frame used to display a 
document or application. 
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INDEX 

A 
About the Finder, 80, 126-127,222, 

234 
activate, 20 
ADB, see Apple Desktop Bus 
add-on, 193, 203 
Adobe, 160 
AFE, 197 
AFP, 206 
Alarm Clock DA, 10, 128, 224, 234 
alert boxes, 51, 144 
Alpha Three, 157 
ANSI, 131 
Apfont, 172 
APPEND, 219 
APPL, 69 
Apple 

030 Direct Slot, 12 
Desktop Bus (ADB), 11, 187, 249 
File Exchange (AFE), 197, 245 
menu, 80,125 
PC drive, 193 
scanner, 188-189 

Apple Computer, Inc., 243, 245, 247 
vision of future, 215-216 

Applefax, 189 
AppleLink, 168 

Personal Edition, 217, 246 
AppleShare, 203,206-207,245 
AppleTalk, 11, 185, 203, 206, 249 
AppleTalk-ETHERNET bridge, 207 
applications 

applicationlaunching, 69, 170 
applica tion vs. program definitions 

19 I 

APX, 107 
ARC, 169 
architecture, 10-11, 173 
archive, 169 
ASC, 183, 249 
ASCll, 197, 226 
Ashton-Tate, 146, 155,217,244 

AskSam, 120 
ASSIGN, 220 
AST, 193 
asynchronous communication, 209 
ATTRIB, 220 
AutoCAD, 160, 162 
autoexec.bat, 23, 26-27, 31 
A/UX, 213-214, 250 

B 
backbone, 204 
background 

pattern, 131 
printing, 230-231 
processing, 121 
programs, 113 

backgrounder, 121 
BACKUP, 221 
bar 

gauge, 224 
menu, 50 
scroll, 46-48 
title, 45 

.bat, 15, 33-34, 171 
batch files, 226 
battery, 224, 234 
baud, see telecommunications 
beep, see sound 
Bezier curve, 162 
bidirectional, 209 
BIOS, 22 
bit, 250 
bit-map, 181, 250 
Boot-up procedures, comparison of, 

23-31,250 
Borland, 31, 115, 246 
box 

alert, 51 
check, 53 
close, 45 
dialog (components), 51-55 
list, 54 
size, 48 
text, 54 
zoom, 46 

BREAK, 221 
bridging, remote, 201, 207 
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Index 

buffer, 29 
bulletin board, 250 

Macintosh, 217 
Bus 

Apple Desktop, 11, 187 
configuration, 205 
bus-master, 177 

button, 250 
default, 52 
drive, 55 
mouse, 35 
radio, 53, 146 

byte, 251 

c 
cabling, 206 

see also direct connect 
cache, 29, 132 
CAD, 160, 162 
Calculator, 128 
Camera, 236 
CAPTURE, 236 
capture utilities, 236-237 
CDEV, 120,124, 131,169-171,230 

Control Panel, 131-136 
CGA, 181,196 
character style, 251 
CHART -MASTER, 160 
chassis, 7-8, 177 
CHOIR (CH), 19, 221 
check box, 33, 251 
chips, trends in, 214 
CHKDSK, 19,80-81,222 
Chooser, 129-130, 185,229,251 
Claris, 160 
Clean Up, 97-101,251 
clicking, 38, 151 

double-, 39, 253 
Shift-, 41, 151 
triple-, 39 

Clipboard, 15, 64, 89-90, 92, 120, 251 
clock, 10, 128, 224, 234 
clone, 9-10 
close box, 45, 251 
CloseUp, 201 
CloseView, 124 
Close windows, 85, 222 
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Cl.S, 222 
color, 132,134,251 

graphics, 162 
Color menu, 102 
.com, 15, 33-34 
COMMAND, 223 
Command key, 184, 252 

Command-? (Help), 237 
Command-A, 41, 91 
Command-C, 91 
Command-0, 224 
Command-!, 85 
Command-N, 67,83,103,229 
Command-O, 83, 103 
Command-P, 104 
Command-Period, 221 
Command-S, 103 
Command-Shift-1, 237 
Command-Shift-2, 237 
Command-Shift-3, 228, 236 
Command-Shift-4, 228, 236 
Command-W, 85, 103, 222 
Command-X, 91 
equivalents, 50 

Commodore, 7 
communication(s), 166-168 

asynchronous, 209, 191-209 
cards, 203 
inter-process, 214 
Macintosh, facility for, 203 
problems, PC-Mac, 191-192 
solutions 

dual-system, 198-202 
PC-Mac (single system), 192-198 

COMP, 223 
Compaq, 10, 107 
compatibility, 189 

solutions, PC-Mac, 192 
CompuServe, 217, 247 
computer industry history, 7-9 
Config.sys, 23, 26-27, 29 

vs. INITS, 27-30 
configuration, 205,206 
connect, direct, 198-200 
connecting multiple PCs/Macs, 

202-209 
connectivity, 191, 207,209 

dual-system solutions, 198-201 
single system solutions, 192-198 



connector 
VAX-Mac, 209 

Control Panel, 120, 130, 224, 229-230, 
234,252 

conventional memory, 23-24 
conversion software, 197-198 
coprocessors, 195-197 
COPY, 72, 104, 223, 235 
copy, 90,91 
CPUs, 173-174,195-197 
create 

directory, 228-229 
new folder, 82 

Creator, 70 
cursors, 252 

I-beam, 36 
Macintosh, 13-14 

Cut, 90-91, 252 

D 
DA (desk accessories), 115-117, 

121-122,125,169,252 
Handler, 121 

daisy wheel, 185-186 
damaged disk, 231 
data 

access,remote, 201 
organization of, 67 
processing, 157 
remote access, 201 
sharing, 191-207 

databases, 157-159 
DataViz, 197 
DATE (also date), 224 

set, 132 
sort by, 96 

DaynaFile, 194, 246 
dBASE, 157 
dBASE Mac, 157, 159, 172,244 
DEC, 209 
DECNET, 209 
dedicated 

cable, 200 
file server, 208 

default button, 52, 252 
DELETE (DEL), 75, 224, 226 
delete folders, 76 

Index 

desk accessories (DAs), 115-117, 
121-122,125,169, 252, see also DAs 

desktop, 18,66,252 
file, 236 
pattern, 131 
publishing, 156-157 
vs. FAT, 30 

DESQview, 106-107, 110,247 
developer, 172 
device driver, 185 
dialog boxes, 144, 253 

components of, 51-55 
dip, 10 
DIR, 19,225 
direct connect, PC-Mac, 198, 199-200 
directory, 67, 225, 234 

print, 88 
DISKCOMP, 226 
DISKCOPY, 226 
disk{s) 

bad floppy, 25 
changing, 55 
damaged, 231 
drives, 179-181 

add-on, 193-195 
formatting, 78-79 
initializing, 78 
space, 85 
system, 79 

Disk First Aid, 221, 231 
display, 134, 181 
document, 69, 253 

launching, 71-72 
DOS 

commands, 219 
directory, 117 
shell, 110,223,227 
vs. Macintosh interface, 17 

dotmatrix, 185,186,253 
double-clicking, 39, 151 
dpi, 189 
Drag, 38, 151,223,225,231-232,235 
DRAW APPLAUSE, 160-161 
draw programs 160-161 
Drive, Apple PC, 192-194 
drive, button, 55 
drives, 179-181 

selecting other active, 55 
driver, printer, 123, 185 
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Index 

DTP, see desktop publishing 
dump (an image), 228 
Duplicate, 87 
duplicate a file, 104 
Dvorak, 184 

E 
Easy Access, 124 
edit, 89-92, 253 
Edit Menu, 89 
EDLIN, 125, 226 
EGA, 181 
eject, 76-77, 88-89, 225 
ellipsis, 57-58, 148 
E-mail, 168 
Empty Folder, 229 
Empty Trash, 75, 100 
Enable, 164 
environments, 17-19 
Epson, 186 
ERJ\SE, 72, 75,226 
Erase Disk, 100,227 
ETHERNET, 11, 203, 205, 207 
EtherTalk, 12 
Excel, 152 
.exe, 15, 33-34 
Extended Edition, 213 
extended menu, 58 
extension, 15,33-34, 70,225 

F 
Fastpath, 207 
FAT 

table, 30 
vs. Desktop, 30 

fax, 163, 188-189 
FDISK, 227 
FEdit, 231 
file(s) 

accessing,remote, 209 
locating, 169 
lost, 169 
naming, comparisons, 33 
recovery, 231-232 
searching for, 170 
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servers, 208 
services, remote, 209 
sharing, 198, 202 

PC/Mac, 192-198 
squeezing, 169 
transfer, 189 

PC-Mac, 192-198 
types, 69, 95 

File menu, 82-89 
filename, 225 
FIND, 227 
Find File DA, 137, 170, 227 
Finde~ 18,63-64,66,119,221-222,253 

menus, 79-102 
Findswell, 171 
fingerpad, 185 
fkeys, 237 
FlashCard, 208 
flat file databases, 157 
floppy disk, bad, 25 
floppy drive, 180 
folders, 67 

moving, 55 
fonts, 121, 138, 253 
Font/DA Juggler, 125, 171 
Font/DA Mover, 121-122,254 
foreground, 231 
fork (data), 252 
FORMAT, 78-79,227 
formatting disks, 78 
forums, 218 
Foxbase, 157, 172 
Framework, 146,164,244 
Freehand, 160 
Full Impact, 152, 244 
FullPaint, 160 
FullWrite Professional, 154-155,244 
function keys, 183,237 
future 

Apple Computer, Inc.'s, vision of, 
215-216 

computer industry, 212-216 

G 
General 

CDEV, 131 
icon, 121 



GEnie, 247 
Getinfo, 85-86,220,222,225,234 
GIF, 198 
global, 118 
GOfer, 227 
Goodies box, 148 
graphic(s), 254 

color, 162 
converting, 198, 199 
PC, 181 
software, 160-163 
tablet, 181 
video, 181 

graphical interface, 141 
GRAPHICS, 228 
GRAPPLER, 245 
gray-scale, 163 

H 
HAL of 2001, 214 
hard drives, 180-181 

comparison of, 9-12 
H ayes Smartcom, 168 
HD 

Backup, 221 
Setup, 227 

Help (key), 237 
Hierarchical Filing System (HFS), 56, 

67,254 
Highlight, 254 
Hijaak, 198, 236 
history, PC industry, 7-9 
HOT SHOT, 236 
HyperCard, 60, 149,151,160,219,243 

I 
!-beam cursor, 36, 254 
IB~, 6-8, 144,181,205-206,211,214 
Icon(s), 32 

application-specific, 71 
bars, 151 
definition, 254 
dragging, 226 
selecting multiple, 39-41 
system, 116-117 

Illustrator, 160, 162 
image, 181 

retouching, 163 
ImageStudio, 163 
ImageWriter, 105, 186 
Imcap, 236 

Index 

import files, 197-198 
industry-standard architecture, 177 
infrared mouse, 184 
INITs, 69 

vs. Config.sys, 27-30 
disks, 227-228 
floppies, 78 

initializing, 254 
input, 10 
insertion point, 13-14 

rate of blinking, 132 
vs. mouse pointer, 36-37 

integrated software, 164 
Intel CPUs, 174 
interfaces,141-143, 155 

comparisons of, 17 
PC, 151 

internal file handling, 232 
IPC capability, 214 
ISA, 177 

J 
Jazz, 165 
JOIN, 228 
Juggler, 125, 171 
justification, 254 

K 
key(s), 237 
keyboard, 183-184 

CDEV, 132 
driver, 228 
macros, 254 
parameters, 132 
shortcuts, 56 
techniques, 51 
types, 228-229 
utility, 123 

~)13)C(, 133,228 
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Index 

Key Caps DA, 138, 184, 229 
keypad, 183 
Kinectics, 207 
Knowledgeman, 157 
Knowledge Navigator Video, 215-216 

L 
LABEL, 229 
label 

disk, 229 
highlighting, 229 
modify, 229 
retyping, 229 
view, 229 

languages, object-oriented, 215 
LAP-LINK Mac, 199-200,246 
laptop Macintosh, 13, 215 
LaserJet, 186 
laser printers, 186-188 
LaserWriter, 105,186-188 
launch (applications), 15-18,69,219 
LED, 184 
library, 169 
link, 191 
Lisa, 173, 191 
LIST, 125 
list (boxes), 54, 146 
Local Area Network (LAN), 204-208, 

254 
configuration, 205-206 

LocalTalk, 185, 203 
Locked, 220,236 

file, 254 
Lotus, 50, 146,165,168,245 

M 
Mac286, 196,246 
MacBinary, 166 
MacCharlie, 196, 246 
MacDraw, 160-161 
Macintosh 

bulletin boards, 217 
communication facility, 203 
Filing System (MFS), 67 
future of, 215-216 
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laptop, 215 
more information, 243-248 
networking, 206 
/PCs 

differences, 13-15 
linking multiple, 202-209 
networking, 207 
switching between, 196 

philosophy, 13 
Programmer's Workshop, 172, 255 
support, 217-218 
trends, 215-216 
user groups, 218 
/VAX, connecting, 209 

vs. DOS interface, 17 
Macintosh 512K, 239 
Macintosh Plus, 246 
Macintosh SE, 241 
Macintosh II, 242 
MacLink, 197, 199 

Plus, 199, 246 
MacNet, 168,217,247 
MacPaint, 28, 160 
macro, 171 
MacroMaker, 124 
MacTools, 231 
MacZap, 231 
mainframe, 157 
map, 133 
marquee, 40-41, 151 
MatchMaker, 194-195,246 
McSink, 234 
MCIMail, 168, 247 
Mega Screen Displays, 245 
memory 

cache, 29 
conventional, 23-24 
information about, 127 
management, 175-176 
managing allocation of, 113, 121 
mapping, 177 

menu(s), 50-51,57-60 
bar, 50,255 
commands, 148 
definition, 255 
extended, 58 
Lotus, 146 
modal, 145-146 
sticky, 58 



submenus, 149 
tear-off, 60 

menu/keyboard commands 
vs. mouse techniques, 51 

MFS, see Macintosh Filing System 
Microsoft 

Excel, 244 
Word, 154,244 
Works, 164-165 

MIDI, 183, 245 
MKDIR (MD), 67, 229 
MMU, 176 
modal menus, 145-146 
mode, protect, 213 
MODE, 134, 229-230 
modems, 200-201,255 
monitors, 134, 181-183 
MORE, 230 
Motorola, 174, 176, 187 
mouse, 156 

cleaning, 37 
holding, 37 
infrared, 184 
pointer, 13-14,36 

vs. insertion point, 36-37 
techniques, 38, 151 

vs. keyboard menu commands, 
51 

trackball, 185 
tracking, 135, 184 
using the, 34-41 

moving, 68 
MPW, 172 
MultiFinder, 106-113,119,223,227, 

231,255 
MultiMate, 154,244 
multiple selections, making, 151 
multitasking, 106-113 

future of, 212, 214 

N 
Netware, 208, 246 
Network Mail, 208 
networks, 200, 202-209 

configurations, 204-206 
Local Area, 204 
Macintosh-Macintosh, 206 
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Macintosh-PC, 207 
topologies, 204-206 
Wide Area, 204 

New Folder, 82-83, 229 
node, 205-206 
non-relational databases, 157 
Norton, 75 
Notepad, 255 
Novell, 207-208, 246 
NuBus, 12, 178-179, 196,255 

0 
object-selecting, 34 
object-oriented, 13-14, 32 

languages, 215 
programming, 215 

OCR, 189 
on-line services, Macintosh, 217 
OOL, 215 
OOP, 216 
open architecture, 10-11, 173 
Open, 83,255 

Disk Icon, 84 
File, 225 
File Icon, 83,225 
Folder Icon, 84 

open system, 8-9 
operating systems, comparisons, 

20-22 
Mac, 63, 141 
PC, 63 

Optiks, 198 
Option key, 184,255 

combinations 
Option-Command-W, 222 
Option-drag, 223 

OS/2, 107, 212-213 
output, 10 

p 
page layout, 156 
Page Setup, 87, 104 
paint programs, 160 
parameters 

printer, 229 
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screen, 229 
partition, 179 
Paste, 90-9t 255 
PJ\Tli, 19,68-69,230 
PC 

industry history, 7-9 
philosophy, 13 

PC/Macintosh 
differences, 13-15 
linking multiple, 202-209 
switching between, 196 

PC-to-PC, 208 
peripheral sharing, 208 
philosophy, PC vs. Macintosh, 13 
pixels, 181, 256 
plug-in, 194 
point, insertion, 13-14 
pointing devices, 184-185 

see also mouse 
pointer, mouse, 13-14,36,256 
port(s), Macintosh serial, 203 
portable Macintosh, 215 
PostScript, 186 
power off, 76-77 
presentation 

graphics, 160 
software, 153 

Presentation Manager, 151, 212-213 
Print, 230-231 
P~, 84,230-231 
printers, 185-188 

drivers, 123 
printing 

background, 230-231 
monitoring, 172 
on a Mac, 84 
options, 85 
page setup, 87, 104 

Procomm, 166 
productivity software, 151 
program 

launcher, 219 
vs. application,defirUtions, 19 

Programmer's Switch, 236 
programming 

languages, 172 
object-oriented, 215 

ProtectMode, 213 
public domain software, 198 
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pull-down menus, 146-147,256 

Q 
Qmodem, 166-167 
Quark, 156 
Quattro, 152 
queue, monitoring, 172 
QuickDex, 171 
QuickDraw, 10, 182, 186 
QuickKeys, 171 
QuickShare, 200 
Quit, 105 
qwerty, 184 

R 
radio buttons, 53, 146 
Radius Displays, 245 
RJ\M, 175, 256 

available, 81, 175 
cache, 132 
expanded/extended, 9 
video, 181 

RapidFile, 157 
reading further, 218 
reboot, 101, 235-236 
RECOVER, 221, 231 
recovery,files, 231-232 
Red Ryder, 168,201,246 
Reflex, 146, 157 
reformat text, 171 
relational databases, 157 
remote 

bridging, 201 
data access, 201 
file accessing, 209 
file services, 209 

remove 
a directory, 232 
a file, 232 

RENJ\ME (REN), 231 
a file, 104 

reports 
creating, 158 
viewing, 158 

RESET (Warm Boot), 235 



Restart, 101, 245 
RESTORE, 232 
retrieve (files), 231 
ring configuration, 206 
RMDIR (RD), 232 
R()~, 116, 174-175 

comparison, 22 
operating system, 116 

s 
Samna, 154 
save, 103, 110 
Save As, 104 
5-BUS, 177 
scanners, 182, 188-189 
Scrapbook, 90, 120,139,256 
screen, see also monitors 

capture, 236 
print, 236 
size, 182 
startup, customized, 28-29 

scroll, 256 
scroll bars, 46-48, 230 
SCSI, 11-12,181, 194 

emulation, 200 
search 

for data, 230 
for files, 137, 170, 227 
path, 219, 230 

security, 202 
seeding concept, 7-8 
select, 256 
Select All menu, 41 
selecting 

drives, 55 
multiples, 151 

icons, 39-41 
objects, 34 
windows, 49 

serial ports, ~acintosh, 203 
Serial Communications Controller 

(SCC), 203 
SET, 232 

see also HD Setup 
Set Startup, 100-101 
setup, 87, 104 

on PC, 130 

Index 

shareware, 169, 198 
sharing, see file sharing, data sharing, 

peripheral sharing 
files, PC/~ac, 192-198 

Shift-clicking, 41, 151 
shortcuts, keyboard, 56 
Shutdown, 77, 102,235-236 
Sidekick, 31,115,144,246 
SIGN-~TER, 160 
Sinclair, 8 
Single In-line ~emory ~odules, 
(S~s), 12 

size 
box, 48,257 
file, 225 

slot, Apple 030 Direct, 12 
Small Computer System Interface, 11 
Smartcom, 168,201 
SoftPC, 196-197 
software 

conversion, 197-198 
translation, 197-198 

solutions systems, 172 
Sonar, 227 
SC>RT, 223 

comparisons of, 151-165 
productivity, 151 
using the View menu, 92-95 

sound, 169, 183 
CDEV, 136 

SoundMaster, 169, 171 
Source, The, 248 
special keys, 237 
Special menu, 97, 235 
spreadsheets, 152-153 
Standard Applications Architecture 

(SAA), 214-215 
star configuration, 205 
startup, 100 

device, 136 
screen, customized, 28-29 

Sticky menu, 58, 149 
Structure window, 158 
stylus pad, 185 
subdirectory, 225 
submenu, 147, 149 

sticky, 58,149 
tear-off, 149 

SUBST, 233 
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Suitcase, 126, 171 
files, 121-122 

SUN, 247 
SuperCalc, 152 
SuperMac, 183 
SuperPaint, 160 
support, Macintosh, 217-218 
Switcher, see multitasking 
switch launching, 223 
Symantec's Utilities, 231 
syntax, 13, 17 
SYS, 233 
system 

date, 224 
disks, 79 
files, 233 
hidden files, 233 
icons, 116-126 
opener, 8-9 
version, 119,234 
vertical, 172 

System 
Folder, 79, 117, 232-233 
Tools, 115, 125 

T 
tablet, 181 
Tandy, 7 
TangentShare, 207-208 
TeachText, 125, 226 
tear-off menu, 60 
telecommunications, 166-169,200-201, 

250 
PC-Mac, 200-201 

text, 257 
box, 54 
command, 125 
downloading, 171 
editor, 125, 226 
files, 226 

3Com Corporation, 247 
3Plus, 247 
TIFF, 163, 189 
tilde key, 56 
TIME, 120,234 
Timex, 8 
title bar, 45, 257 
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Token Ring, 206 
Toolbox, 116 
Tools 

System, 115 
topologies, 204-208 
TOPS, 207-208, 247 
Topview, 107 
trackball device, 184 
tracking mouse, 184 
translation software, 197-198 
Trapeze, 152 
Trashcan, 75,224,232 

drag to, 224, 232 
TREE, 234 
trends, computer industry, 212-216 
triple-clicking, 39 
TRS-80, 7 
TSR, 30, 115, 125 
TYPE, 234 

u 
Undo, 90, 257 
Universal Print Buffer, 245 
UNIX, 208 

Apple implementation, 213-214 
user groups, Macintosh, 218 
utilities, 168-172 

v 
Vaccine, 169 
V AX-Mac, connecting, 209 
Ventura, 156 
VER, 80-91, 234 
VERIFY, 235 

ON/OFF, 235 
VersaCAD, 160 
version, 234 

most recent, 119 
numbers, 81 

vertical markets, 172 
VGA, 181 
video, 181 
View menu, 225 

by Color, 225 
by Date, 225 
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by Icon, 222, 225 
by Kind, 225 
by Name, 225, 233 
by Size, 225 
by Small leon, 225 

voice, 183 
VOL, 235 
volatile memory, 175 

see also RAM 
volume, 132,134,235 

w 
Warm Boot (RESET), 235 
watch, 36 
Wide Area Network (WAN), 204 
wildcards, 34,91,231 
Windows, 41-49, 143-144,257 

Finder option, 49 
managing, 112 
selecting active, 49 

Word (Microsoft), 154-155 
WordPerfect, 155,245 
word processors, 154-156 
WordStar, 154 
Works (Microsoft), 164-165 
worksheet, 153 
WYSIWYG, 154 

X 
X, meaning of, 25 
XCOPY, 235 
Xerox, 8,11 
Xmodem, 166 

y 
Ymodem, 166 

z 
Zmodem, 166 
zoom box, 46 
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FullWrite Professional: Advanced Techniques 
By Roy Lebau & Robtrl Morrish 

Explore the hidden power of FullWrite Professional 
with two members of the FullWrite development 
team as your guides. Filled with design concepts 
and examples, guidelines and suggestions, this book 
covers individual page elements, newsletter and ad 
layouts, the structure of a complete manual, and 
book publishing. Written for the experienced 
FuiiWrite user, much of the book consists of two­
page spreads that discuss and illustrate a single 
concept and technique. The left page of each spread 
is a sample, illustrating effects produced with 
FullWrite. The right page explains the techniques 
used to create the left page. Instructional chapters 
throughout the book provide invaluable informa­
tion for setting up documents, using outlining as a 
document framework, creating glossary entries to 
facilitate repetitive tasks, achieving the best printed 
results, and merging documents and databases. 

$24.95 • Softcover 
344 pages • 73/s" x 91.4" • ISBN: 0-13-331919-9 

FullWrite Professional: A User's Guide 
By Keith Thompson and Theodore Peterson 

This thorough introduction to using FullWrite 
ProfessionaJT~~ for business applications will have you 
producing persuasive documents with tremendous vi­
sual impact in no time flat. Thompson and Peterson 
provide you with instructions for customizing FullWrite 
Professional; creating and editing documents; chapter, 
page, and paragraph formatting techniques; printing 
techniques; and producing and using graphics with 
FullWrite Professional. At the heart of this book are 
useful applications for creating templates for form docu­
ments, printing form letters and envelopes, desktop 
publishing, preparing Full Write Professional documents 
for electronic transmission, and creating and editing ta­
bles. Let Full Write Professional: A User's Guide help you 
become a FullWrfte Professional power user. 

$24.95 • Softcover 
295 pages • 7 3/8" x 91/4" • ISBN: 0-13-331712-9 
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dBASEIV 

dBASEIV 
FOR THE 
FIRST-TIME USER 

Everyman's Database Primer Featuring 
dBASE IV 
Robert A. Byers and CaryN. Prague 

The best-selling introductory guide for dBASE® soft­
ware is now updated for dBASE IV. Everyman's 
Database Primer Featuring dBASE N is filled with valu­
able information for novice dBASE IV users, as well as 
experienced dBASE users who need to learn about the 
dBASE IV software. The book begins with an introduc­
tion to database management concepts and proceeds to 
an examination of the new dBASE IV user interface, the 
Control Center. From the chapters on the dBASE IV 
Control Center it's a quick transition into planning, 
building, modifying, and sorting a database; working 
with multiple databases; creating reports, labels, and 
custom screens; importing and exporting data and 
more. In addition, there's a discussion on developing 
applications with the dBASE IV Applications Generator. 
Fully illustrated with dBASE IV screens, Everyman's 
Database Primer Featuring dBASE IV is an easy-to-under­
stand, straightforward primer for all dBASE IV users. 

$21.95 • Softcover 
426 pages • 7 3/8" x 91/4" • ISBN: 0..13-198763-1 
Fall '88 

dBASE IV For The First-Time User 
By Howard Dickler, Ph.D. 
Illustrated by Catherine Ledbetter 

For a highly illustrated, hands-on introduction to 
dBASE fVTM reach for dBASE N For The First· Time User. 
Written for the novice dBASE IV user, this book pro· 
vides a systematic approach to learning dBASE IV com­
mands and features through the Control Center, the 
new dBASE IV user interface. Readers are guided 
through the process of developing a small model system 
with dBASE IV, during which they will learn to create 
reports, mailing labels, personalized form letters and 
more. In addition, instruction is given on how to em­
ploy the new dBASE IV Applications Generator. Its 
clear, concise presentation also makes dBASE N For The 
First-Time User the perfect text for an introductory 
dBASE IV class. 

$21.95 • Softcover 
507 pages • 7 3/8" x 9 1/4" • ISBN: 0..13·198748-8 
Winter '88 



Other titles of interest: 

dBASE Mac in Business 
Jim Heid 

Step-by-step guide through both basic and advanced dBASE Mac 
concepts. Also includes a special chapter for users of Ashton-Tate's 
dBASE products,. explaining how they can quickly adapt to the 
Macintosh database environment. 

$19.95 

Full Impact Macros: Programming with Full Talk 
by Dylan B. Ashe 

Learn to go beyond mere keystroke recording. Build intelligent 
(decision-making) macros and macro applications with Full Talk, 
the powerful macro programming language in Full Impact. 

$24.95 Available August '89 
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ASHTON ·TATE. 

Quick & Easy Macintosh Guide 
for MS-DOS Users 

General Reference/Macintosh 

Make your transition from the text-oriented world of MS-DOS to the 
graphics-oriented world of the Macintosh as smooth as possible with The 
Quick and Easy Macintosh Guide far MS-DOS Users. Topics are presented 
in terms, concepts, and operations DOS users have already mastered. 

The book begins with a general discussion of the different operating 
philosophies behind the Mac and PC. Next, you are introduced to the 
Macintosh graphical interface where you'll learn about mouse techniques, 
menus, dialog boxes, the Finder, and the operating system files and tools. 

This book also provides valuable insights into software, hardware and 
peripherals, and data-sharing options for the Mac. 1l1e final chapter offers 
a glimpse at likely future developments for the Mac. 

About the Authors 

Ruse! DeMaria is a freelance writer and MS-DOS Editor for Macazine, U.S. 
Insight column.3t for Nikkei Byte in Japan , and Associate Editor for 
OJmputer Play Magazine. He is the co-author of Working with dBASE Mac 
and Public Domain Software and Shareware. He lives on the island of Maui. 

David Altounian formerly managed the review and acquisition of 
Macintosh and PC products for the Business Development department of 
Ashton-Tate. A contributing author to the book Financial 
Information Systems, Altounian lives in Houston, Texas. 

$21.95 

Ashton· Tate Press books are based o n certified software. O ur 
books go through the same extensive testing as Ashto n-Tate 
software. After meeting Ashton-Tate's high standards, the books 
are certified. Only after certificatio n docs the book go to p ress. 
Remember, only Ashton-Tate Press books arc certified by the 
Ash ton-Tate Test Department. This is your guarantee that 
Ashron.Tare Press books are th~ most technically accur:ue 
books available. 

0 

ISBN 0-13-749698-2 
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